ATLAS.ti 8 Windows
User Manual
### Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About this Manual</td>
<td>8</td>
</tr>
<tr>
<td>How to Use this Manual</td>
<td>8</td>
</tr>
<tr>
<td>Manual Conventions</td>
<td>8</td>
</tr>
<tr>
<td>Useful Resources For Getting Started</td>
<td>9</td>
</tr>
<tr>
<td>Introduction</td>
<td>9</td>
</tr>
<tr>
<td>The VISE Principle</td>
<td>9</td>
</tr>
<tr>
<td>Areas of Application</td>
<td>10</td>
</tr>
<tr>
<td>Teamwork</td>
<td>10</td>
</tr>
<tr>
<td>ATLAS.ti – The Knowledge Workbench</td>
<td>11</td>
</tr>
<tr>
<td>Software for Creative Analysis</td>
<td>11</td>
</tr>
<tr>
<td>Some Basic Terms</td>
<td>11</td>
</tr>
<tr>
<td>General Steps when Working with ATLAS.ti</td>
<td>11</td>
</tr>
<tr>
<td>Main Concepts and Features</td>
<td>12</td>
</tr>
<tr>
<td>Documents</td>
<td>13</td>
</tr>
<tr>
<td>Document Groups (Data Attributes)</td>
<td>13</td>
</tr>
<tr>
<td>Quotations</td>
<td>13</td>
</tr>
<tr>
<td>Coding Objectives</td>
<td>15</td>
</tr>
<tr>
<td>Auto Coding Tool</td>
<td>15</td>
</tr>
<tr>
<td>Memos</td>
<td>15</td>
</tr>
<tr>
<td>Comments</td>
<td>15</td>
</tr>
<tr>
<td>Groups</td>
<td>16</td>
</tr>
<tr>
<td>Networks</td>
<td>16</td>
</tr>
<tr>
<td>Navigation Area</td>
<td>17</td>
</tr>
<tr>
<td>Project Search</td>
<td>17</td>
</tr>
<tr>
<td>Analysis</td>
<td>17</td>
</tr>
<tr>
<td>Team Tools</td>
<td>18</td>
</tr>
<tr>
<td>Export</td>
<td>18</td>
</tr>
<tr>
<td>ATLAS.ti Mobile for iPad and Android</td>
<td>19</td>
</tr>
<tr>
<td>Main Steps in Working with ATLAS.ti</td>
<td>20</td>
</tr>
<tr>
<td>Data And Project Management</td>
<td>21</td>
</tr>
<tr>
<td>The Process</td>
<td>21</td>
</tr>
<tr>
<td>ATLAS.ti – The Knowledge Workbench</td>
<td>21</td>
</tr>
<tr>
<td>Selecting the Display Language</td>
<td>21</td>
</tr>
<tr>
<td>Creating a New Project</td>
<td>22</td>
</tr>
<tr>
<td>Importing an Existing Project</td>
<td>22</td>
</tr>
<tr>
<td>Importing an ATLAS.ti 7 Project</td>
<td>23</td>
</tr>
<tr>
<td>Importing Copy Bundle Files (Versions 5, 6 or 7)</td>
<td>23</td>
</tr>
<tr>
<td>The ATLAS.ti Interface</td>
<td>23</td>
</tr>
<tr>
<td>The ATLAS.ti Ribbon</td>
<td>24</td>
</tr>
<tr>
<td>The Backdrop</td>
<td>25</td>
</tr>
<tr>
<td>The Six Main Entity Types</td>
<td>25</td>
</tr>
<tr>
<td>The Navigation Panel</td>
<td>26</td>
</tr>
<tr>
<td>Context Menus</td>
<td>26</td>
</tr>
<tr>
<td>Browsers</td>
<td>27</td>
</tr>
<tr>
<td>Explorers</td>
<td>27</td>
</tr>
<tr>
<td>Working With Docked And Floated Windows</td>
<td>27</td>
</tr>
<tr>
<td>Working With Tabs And Tab Groups</td>
<td>28</td>
</tr>
<tr>
<td>User Interface Language</td>
<td>30</td>
</tr>
<tr>
<td>Entity Managers</td>
<td>30</td>
</tr>
<tr>
<td>Launching an Entity Manager</td>
<td>30</td>
</tr>
<tr>
<td>The Document Manager</td>
<td>33</td>
</tr>
<tr>
<td>Quotation Manager</td>
<td>35</td>
</tr>
<tr>
<td>Code Manager</td>
<td>37</td>
</tr>
<tr>
<td>Tools tab</td>
<td>38</td>
</tr>
<tr>
<td>Memo Manager</td>
<td>39</td>
</tr>
<tr>
<td>Network Manager</td>
<td>40</td>
</tr>
<tr>
<td>Link Manager</td>
<td>41</td>
</tr>
<tr>
<td>Relation Manager</td>
<td>43</td>
</tr>
</tbody>
</table>
## CONTENTS

### Working With Geo Docs
- Type-Token Ratio ................................................................. 79
- Project Search ........................................................................ 80

### Working With Multimedia Data
- Selecting Text Segments ...................................................... 81
- Creating Free Quotations ...................................................... 81
- Creating Graphical Quotations .............................................. 84
- Creating PDF Quotations ...................................................... 85
- Creating Multimedia Quotations ........................................... 85

### Coding Data
- Working With Codes ............................................................ 92

### The Margin Area
- Margin Display Options ...................................................... 102
- Margin Drag & Drop ............................................................ 103

### Auto Coding
- Opening The Auto Coding Tool ........................................... 104
- The Auto-Coding Dialog ...................................................... 105
- Regular Expressions (GREP) ................................................ 108

### Focus Group Coding
- Guidelines For Preparing Focus Group Data ......................... 109
- Coding Focus Group Data ................................................... 110

### Finding Redundant Codings
- Inter-Coder Agreement (ICA) .............................................. 113

#### Please Read This First!
- Why Call It Inter-Coder Agreement Rather Than Inter-Coder Reliability? ......................................................... 115
- Why Reliability Matters ..................................................... 115
- Reliability And Validity ...................................................... 116
- At What Phase In Your Project Should ICA Analysis Be Performed? ................................................................. 116
- Requirements For Coding ................................................... 116
- Measuring Inter-coder Agreement ....................................... 119
- Methods For Testing ICA .................................................... 120
- Decision Rules .................................................................... 122
- Setting Up A Project For Inter-coder Agreement Analysis .................................................................................. 123
- Mapping Projects For ICA Analysis .................................... 124
- Preparing For ICA analysis ................................................. 125
- Calculating An ICA Coefficient ............................................ 128

### Working With Multimedia Data
- Linking Multimedia Data to A Project .................................. 129
- Display Of Multimedia Documents ...................................... 130
- Multimedia Toolbar ............................................................ 131
- Keyboard Shortcuts For Working With Multimedia Documents ......................................................... 132
- Zooming the Time Line ....................................................... 133
- Multimedia View Options ................................................... 133
- Navigation Using The Arrow Keys ....................................... 134
- Creating Multimedia Quotations In The Margin Area ............ 134
- Creating Multimedia Quotations While Listening / Watching ........................................................................ 134
- Reviewing A Multimedia Quotation ..................................... 135
- Adjusting the Size of Multimedia Quotations ....................... 135
- Display Of Multimedia Quotations ....................................... 135
- Renaming A Multimedia Quotation ...................................... 135
- Activating And Playing Multimedia Quotations .................... 136
- Creating Snapshot Images From Video Frames ..................... 136
- Coding Multimedia Documents .......................................... 136
- Describing Multimedia Quotations To Improve Output ........ 137
- Multimedia Preferences ..................................................... 138

### Working With Geo Docs
- Adding A Geo Document To A Project .................................. 139
- Finding A Location .............................................................. 139
- Creating Geo Quotations .................................................... 140
## CONTENTS

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coding Geo Quotations</td>
<td>140</td>
</tr>
<tr>
<td>Creating A Snapshot</td>
<td>141</td>
</tr>
<tr>
<td>Working With Survey Data</td>
<td>142</td>
</tr>
<tr>
<td>Overview</td>
<td>142</td>
</tr>
<tr>
<td>How Survey Data Is Treated In ATLAS.ti</td>
<td>143</td>
</tr>
<tr>
<td>Preparing An Excel™ Table For Import</td>
<td>143</td>
</tr>
<tr>
<td>How To Import Survey Data</td>
<td>144</td>
</tr>
<tr>
<td>Inspecting Imported Survey Data</td>
<td>144</td>
</tr>
<tr>
<td>Working With Survey Data</td>
<td>146</td>
</tr>
<tr>
<td>Working With Reference Manager Data</td>
<td>146</td>
</tr>
<tr>
<td>Mendeley</td>
<td>146</td>
</tr>
<tr>
<td>Zotero</td>
<td>146</td>
</tr>
<tr>
<td>Importing Documents</td>
<td>147</td>
</tr>
<tr>
<td>Inspecting Imported Documents</td>
<td>148</td>
</tr>
<tr>
<td>Working With Twitter Data</td>
<td>149</td>
</tr>
<tr>
<td>Importing Twitter Data</td>
<td>149</td>
</tr>
<tr>
<td>Inspecting Imported Twitter Data</td>
<td>150</td>
</tr>
<tr>
<td>Working With Hyperlinks</td>
<td>152</td>
</tr>
<tr>
<td>Representing the Rhetoric of Data</td>
<td>152</td>
</tr>
<tr>
<td>Benefits of Hyperlink</td>
<td>152</td>
</tr>
<tr>
<td>Graphical Hyperlink Maps</td>
<td>152</td>
</tr>
<tr>
<td>Creating Hyperlinks</td>
<td>153</td>
</tr>
<tr>
<td>Working With Comments And Memos</td>
<td>160</td>
</tr>
<tr>
<td>Difference Between Memos And Codes</td>
<td>161</td>
</tr>
<tr>
<td>Writing Comments</td>
<td>162</td>
</tr>
<tr>
<td>Creating Memos</td>
<td>163</td>
</tr>
<tr>
<td>The Memo Manager</td>
<td>163</td>
</tr>
<tr>
<td>Querying Data</td>
<td>167</td>
</tr>
<tr>
<td>Overview Of Analysis Tools</td>
<td>167</td>
</tr>
<tr>
<td>Available Operators For Querying Data</td>
<td>168</td>
</tr>
<tr>
<td>Code Document Table</td>
<td>171</td>
</tr>
<tr>
<td>Code Co-Occurrence Tools</td>
<td>176</td>
</tr>
<tr>
<td>The Query Tool</td>
<td>184</td>
</tr>
<tr>
<td>Working With Smart Codes</td>
<td>194</td>
</tr>
<tr>
<td>Working With Smart Groups</td>
<td>196</td>
</tr>
<tr>
<td>Applying Global Filters For Data Analysis</td>
<td>198</td>
</tr>
<tr>
<td>Creating A Global Filter</td>
<td>199</td>
</tr>
<tr>
<td>Setting Global Filters</td>
<td>199</td>
</tr>
<tr>
<td>Display Of Global Filters</td>
<td>199</td>
</tr>
<tr>
<td>Examples</td>
<td>199</td>
</tr>
<tr>
<td>Global Filters In The Code Co-occurrence Table</td>
<td>202</td>
</tr>
<tr>
<td>Global Filters In The Code Document Table</td>
<td>203</td>
</tr>
<tr>
<td>Activating / Deactivating Global Filters</td>
<td>204</td>
</tr>
<tr>
<td>Removing A Global Filter</td>
<td>204</td>
</tr>
<tr>
<td>Working With Networks</td>
<td>204</td>
</tr>
<tr>
<td>Nodes And Links</td>
<td>205</td>
</tr>
<tr>
<td>Relations</td>
<td>206</td>
</tr>
<tr>
<td>The Network Editor</td>
<td>209</td>
</tr>
<tr>
<td>View Options</td>
<td>212</td>
</tr>
<tr>
<td>Basic Network Procedures</td>
<td>214</td>
</tr>
<tr>
<td>Creating New Relations</td>
<td>222</td>
</tr>
<tr>
<td>Layout And Routine</td>
<td>223</td>
</tr>
<tr>
<td>Analytic Functions</td>
<td>225</td>
</tr>
<tr>
<td>Exporting Networks</td>
<td>227</td>
</tr>
<tr>
<td>Creating Reports</td>
<td>227</td>
</tr>
<tr>
<td>Overview</td>
<td>227</td>
</tr>
<tr>
<td>Creating Word / PDF Reports</td>
<td>227</td>
</tr>
<tr>
<td>Creating Excel Reports</td>
<td>229</td>
</tr>
<tr>
<td>Creating A Codebook</td>
<td>230</td>
</tr>
</tbody>
</table>
About this Manual

This manual describes the concepts and functions of ATLAS.ti 8. It is not required that you read the manual sequentially from first page to last. Feel free to skip sections that describe concepts you are already familiar with, jump directly to sections that describe functions you are interested in, or simply use it as a reference guide to look up information on certain key features.

For users with no prior knowledge of ATLAS.ti, we do, however, recommend that you especially read through the first part of this manual in order to become familiar with the concepts used by ATLAS.ti and to gain an overview of the available functions. These are the chapters: "The VISE Principle," "ATLAS.ti – The Knowledge Workbench," and "Main Steps in Working with ATLAS.ti."

Further, to set up a project, we recommended that you read:
• "Main Steps in Working with ATLAS.ti"
• "Starting ATLAS.ti"
• "The ATLAS.ti Interface"
• "Adding Documents," and
• "Project Management"

For all basic-level work like creating quotations, coding, and writing memos, consult the chapters under the main heading: "Entity Managers", "Exploring Data", "Working With Quotations", "Coding Data" "Working With Comments And Memos," and "Working With Groups."

Advanced functions are described under: "Working With Hyperlinks," "Querying Data," and "Working With Networks."

The sequence of the chapters follows the steps that are necessary to start and work on an ATLAS.ti project: First, the main concepts that ATLAS.ti utilizes are explained; next, an overview of all available tools is provided. These introductory and more theoretically-oriented parts are followed by more practically-oriented chapters providing step-by-step instructions. You will learn how to manage your data and how to set up and start a project. Once a project is set up, the basic functions such as coding, text search, auto-coding, writing memos, etc. become relevant. Conceptual-level functions such as the network editor, the Query Tool, and Co-occurrence Explorer build on the data-level work (at least in most cases) and are therefore described last.

The section "Useful Resources" offers some useful advice on how to get support and where to find further information on the software.

How to Use This Manual

This manual is intended for:
• Those who have no prior knowledge of ATLAS.ti
• Those who have worked with a previous version, ATLAS.ti 5, 6 or 7.

Some general familiarity with concepts and procedures relating to the Windows operating system and computing in general (e.g., files, folders, paths) is assumed.

This is largely a technical document. You should not expect any detailed discussion of methodological aspects of qualitative research other than cursory statements from this manual.

To those seeking in-depth instruction on methodological aspects, the ATLAS.ti Training Center offers a full complement of dedicated ATLAS.ti training events worldwide, both through online courses and face-to-face seminars in nearly all parts of the world. Visit the Training Center at: https://training.atlasti.com

Manual Conventions

Notes

This paragraph contains a general note that may be of interest or worth remembering.

Tip/Recommendation

This paragraph contains a tip or recommendation, i.e., something we advise you to make a practice in your work.
Introduction

ATLAS.ti is a powerful workbench for the qualitative analysis of large bodies of textual, graphical, audio, and video data. It offers a variety of tools for accomplishing the tasks associated with any systematic approach to unstructured data, i.e., data that cannot be meaningfully analyzed by formal, statistical approaches. In the course of such a qualitative analysis, ATLAS.ti helps you to explore the complex phenomena hidden in your data. For coping with the inherent complexity of the tasks and the data, ATLAS.ti offers a powerful and intuitive environment that keeps you focused on the analyzed materials. It offers tools to manage, extract, compare, explore, and reassemble meaningful pieces from large amounts of data in creative, flexible, yet systematic ways.

The VISE Principle

The main principles of the ATLAS.ti philosophy are best encapsulated by the acronym VISE, which stands for Visualization, Integration, Serendipity, and Exploration.

Visualization

The visualization component of the program means directly supports the way human beings (this includes researchers!) think, plan, and approach solutions in creative, yet systematic ways. Tools are available to visualize complex properties and relations between the objects accumulated during the process of elicting meaning and structure from the analyzed data.

The object-oriented design of ATLAS.ti seeks to keep the necessary operations close to the data to which they are applied. The visual approach of the interface keeps you focused on the data, and quite often the functions you need are just a few mouse clicks away.

Integration

Another fundamental design aspect of the software is to integrate all pieces that comprise a project, in order not to lose sight of the whole when going into detail.

Therefore, all relevant entities are stored in a container, the so-called "Hermeneutic Unit (HU)." Like the spider in its web, the HU keeps all data within reach. Loading a project with hundreds of files is merely a matter of opening a single HU.
Serendipity

Webster’s Dictionary defines serendipity as “a seeming gift for making fortunate discoveries accidentally.” Other meanings are: Fortunate accidents, lucky discoveries. In the context of information systems, one should add: Finding something without having actually searched for it.

The term “serendipity” can be equated with an intuitive approach to data. A typical operation that relies on the serendipity effect is browsing. This information-seeking method is a genuinely human activity: When you spend a day in the local library (or on the World Wide Web), you often start with searching for particular books (or key words). But after a short while, you typically find yourself increasingly engaged in browsing through books that were not exactly what you originally had in mind.

Examples of tools and procedures ATLAS.ti offers for exploiting the concept of serendipity are the Object Managers, the HU Explorer, the interactive margin area, full text search, and the hypertext functionality.

Exploration

Exploration is closely related to the above principles. Through an exploratory, yet systematic approach to your data (as opposed to a mere “bureaucratic” handling), it is assumed that especially constructive activities like theory building will be of great benefit. The entire program’s concept, including the process of getting acquainted with its particular idiosyncrasies, is particularly conducive to an exploratory, discovery-oriented approach.

Areas of Application

ATLAS.ti serves as a powerful utility for qualitative analysis, particularly of larger bodies of textual, graphical, audio, and video data. The content or subject matter of these materials is in no way limited to any one particular field of scientific or scholarly investigation.

Its emphasis is on qualitative, rather than quantitative, analysis, i.e., determining the elements that comprise the primary data material and interpreting their meaning. A related term would be “knowledge management,” which emphasizes the transformation of data into useful knowledge.

ATLAS.ti can be of great help in any field where this kind of “soft data” analysis is carried out. While ATLAS.ti was originally designed with the social scientist in mind, it is now being put to use in areas that we had not really anticipated. Such areas include psychology, literature, medicine, software engineering, quality control, criminology, administration, text linguistics, stylistics, knowledge elicitation, history, geography, theology, and law, to name just some of the more prominent.

Emerging daily are numerous new fields that can also take full advantage of the program’s facilities for working with graphical, audio, and video data. A few examples:

- Anthropology: Micro-gestures, mimics, maps, geographical locations, observations, field notes
- Architecture: Annotated floor plans
- Art / Art History: Detailed interpretative descriptions of paintings or educational explanations of style
- Business Administration: Analysis of interviews, reports, web pages
- Criminology: Analysis of letters, finger prints, photographs, surveillance data
- Geography and Cultural Geography: Analysis of maps, locations
- Graphology: Micro comments to handwriting features.
- Industrial Quality Assurance: Analyzing video taped user-system interaction
- Medicine and health care practice: Analysis of X-ray images, CAT scans, microscope samples, video data of patient care, training of health personal using video data
- Media Studies: Analysis of films, TV shows, online communities
- Tourism: Maps, locations, visitor reviews

Many more applications from a host of academic and professional fields are the reality. In fact, we encourage all users to let us know about the specific use they are making of ATLAS.ti in their area or work. You can always reach us via the ATLAS.ti Support Center at https://support.atlasti.com.

The fundamental design objective in creating ATLAS.ti was to develop a tool that effectively supports the human interpreter, particularly in handling relatively large amounts of research material, notes, and associated theories.

Although ATLAS.ti facilitates many of the activities involved in qualitative data analysis and interpretation (particularly selecting, indexing/coding, and annotating), its purpose is not to automate these processes. Automatic interpretation of text cannot succeed in grasping the complexity, lack of explicitness, or “contextuality” of everyday or scientific knowledge. In fact, ATLAS.ti was designed to be more than a single tool—think of it as a professional workbench that provides a broad selection of effective tools for a variety of problems and tasks.

Teamwork

ATLAS.ti facilitates co-authoring, i.e., it allows two or more researchers or work groups to work on the same project, albeit asynchronously. This means each person works on his or her own project file. Access to the same data source is possible. The sub-projects are then merged into one comprehensive MASTER project. ATLAS.ti provides the tools that allow for the transfer and conversion of research data while keeping the respective sources of ideas identifiable at all times.
ATLAS.ti – The Knowledge Workbench

The image of our software as a “knowledge workbench” is more than just a lively analogy. Analytical work involves tangible elements: research material requires piecemeal, assembly, reworking, complex layouts, and some special “tooling.” A well-stocked workbench provides you with the necessary instruments to thoroughly analyze and evaluate, search and query your data, to capture, visualize and share your findings.

Software for Creative Analysis

Your typical project deals with sifting through large sets of diverse documents, notes, and multi-media files, and examining and comparing such sources regarding a specific line of inquiry.

While the technical side of selecting, and organizing useful portions of your data might seem manageable when dealing with just a handful of source documents, it can tend to become overwhelming as the number of sources mount.

Enter a specialized software package like ATLAS.ti: It lets you extract, categorize, and interlink data segments from a large variety and volume of source documents. Based on your analysis, the software supports you in discovering patterns and testing hypotheses. With numerous output options and collaboration tools, your analysis is easily accessible to yourself and others.

Some Basic Terms

To understand how ATLAS.ti handles data, visualize your entire project as an intelligent “container” that keeps track of all your data. This container is your ATLAS.ti project.

The project keeps track of the paths to your source data and stores the codes, code groups, networks, etc. that you develop during your work. Your source data files are copied and stored in a repository. The standard option is for ATLAS.ti to manage the documents for you in its internal database. If you work with larger audio or video files, they can be linked “externally” to your project to preserve disk space. All files that you assign to the project (except those externally linked) are copied, i.e., a duplicate is made for ATLAS.ti’s exclusive use. Your original files remain intact and untouched in their original location.

Your source data can consist of text documents (such as interviews, articles, reports), images (photos, screen shots, diagrams), audio recordings (interviews, broadcasts, music), video clips (audiovisual material), PDF files (papers, brochures, reports), and even geo data (locative data using Open Street Map).

Once your various documents are added or linked to an ATLAS.ti project, your real work can begin. Most commonly, early project stages involve coding different data sources.

Coding is the basic activity you engage in when using ATLAS.ti and is the basis of everything else you will do. In practical terms, coding refers to the process of assigning categories, concepts, or “codes” to segments of information that are of interest to your research objectives. We have modeled this function to correspond with the time-honored practice of marking (underlining or highlighting) and annotating text passages in a book or other documents.

In its central conceptual underpinnings, ATLAS.ti has drawn deliberately from what might be called the “paper and pencil paradigm.” The user interface is designed accordingly, and many of its processes are based on—and thus can be better understood by—this analogy.

Because of this highly intuitive design principle, you will quickly come to appreciate the margin area as one of your most central and preferred work space— even though ATLAS.ti almost always offers a variety of ways to accomplish any given task.

General Steps when Working with ATLAS.ti

The following sequence of steps is, of course, not mandatory, but describes a common “script:

1. Create a project, an “idea container,” meant to enclose your data, all your findings, codes, memos, and structures under a single name. See "Creating a New Project."
2. Next, add documents, text, graphic, audio and video files, or geo documents to your ATLAS.ti project. See "Adding Documents".
3. Organize your documents. See "Working With Groups".
4. Read and select text passages or identify areas in an image or select segments on the time line of an audio or video file that are of further interest, assign key words (codes), and write comments and memos (see "Working With Comments And Memos") that contain your thinking about the data. Build a coding system. See "Working With Codes."
Compare data segments based on the codes you have assigned; possibly add more data files to the project. See for example "Retrieving Coded Data."

Query the data based on your research questions utilizing the different tools ATLAS.ti provides. The key words to look for are: simple retrieval, complex code retrievals using the Query Tool, simple or complex retrievals in combination with variables via the scope button, the Code Co-occurrence Tools (tree explorer and table), the Codes-Document Table, data export for further statistical analysis (see "Querying Data" and "Data Export For Further Statistical Analysis."

Build semantic, prepositional or terminological networks from the codes you have created. These networks, together with your codes and memos, form the framework for emerging theory. See "Working With Networks" and "Working With Comments And Memos."

Finally, compile a written report based on the memos you have written throughout the various phases of your project and the networks you have created. See "Exporting Networks" and "Creating Reports."

For additional reading about working with ATLAS.ti, see The ATLAS.ti Research Blog and The ATLAS.ti conference proceedings.

Main Concepts and Features

The concepts of primary documents, quotations, codes, and memos are the overall foundation you need to be familiar with when working with ATLAS.ti, complemented by a variety of special aspects such as groups, networks (=the main visualization tool), and analytical/data querying tools. All of these come together in the overall “project container,” the ATLAS.ti project bundle file. Acquaint yourself with this general “container” concept and its implications. Once you understand the concept, you understand almost everything that is necessary to work with ATLAS.ti.

Everything that is relevant to a particular project (e.g., a research topic) is part of your ATLAS.ti project and resides in the digital domain. For instance, the data you are analyzing, the quotations, the codes, the conceptual linkages (groups, networks), and comments and memos, are all part of it. One obvious advantage of this container concept is that as user you only have to deal with and think of one entity. Activating the ATLAS.ti project is the straightforward selection of a single file; all associated material is then activated automatically.
The most basic level of an ATLAS.ti project consists of the documents you are analyzing, followed closely by the "quotations" (= selections from these documents). On the next level, codes refer to quotations. And comments and memos - you meet them everywhere. Your ATLAS.ti project can become a highly connected entity, a dense web of primary data, associated memos and codes, and interrelations between the codes and the data. To find your way through this web, ATLAS.ti provides powerful browsing, retrieval and editing tools.

In the following all entities of an ATLAS.ti project are explain in more detail.

Documents

Documents represent the data you have added to an ATLAS.ti project. These can be text, image, audio, video or geographic materials that you wish to interpret.

Document Groups (Data Attributes)

Groups in ATLAS.ti are a group of entities (see the entry "Groups" below). Document groups fulfill a special function as they can be regarded as quasi dichotomous variables. You can group all female interviewees into a document group named “female,” all male interviewees into a group named ‘male.’ You can do the same for different professions, marital status, education levels, etc. The classification is a 0/1 classification: "1" meaning the document is part of a particular group; "0" meaning it is not part of the group.

Document groups can later in the analysis be used to restrict code-based searches like: "Show me all data segments coded with ‘attitude towards the environment’ but only for females who live in London as compared to females who live in the country side."

You can also use document groups as a filter, for example to reduce other types of output, like a frequency count for codes across a particular group of documents.

Quotations

A quotation is a segment from a document that is interesting or important to the user. In textual documents, a quotation is an arbitrary sequence of characters ranging in length from a single character, to a word, a sentence, or a paragraph, even up to the entire data file.

Free quotations resemble passages highlighted with a marker.
Usually, quotations are created manually by the researcher. However, if repetitive words or phrases are contained in the text, the Auto-Coding feature can be used to automatically segment these quotations and assign a code to them. When a quotation is created, ATLAS.ti automatically assigns an identifier to it. This identifier is built from the index of the document to which it belongs plus the first 70 characters of the text segment, e.g., “1:7... The identifier is displayed in list windows and reports. For graphic, audio, and video segments, the original file name of the document is chosen as identifier.

Although the creation of quotations is almost always part of a broader task like coding or writing memos, “free” quotations can be created that indicate interesting parts in the data for which a meaningful classification has not yet been found. Each quotation name can be renamed. Thus an approach could also be to rename a quote instead of attaching a code label that only describes a data segment and cannot be applied anywhere else because it is too specific. Attaching code labels at this level of analysis can result in a very long and difficult to manage code list.

**Quotations as Layers**

Quotations can be regarded like a transparent layer on top of a document. Technically speaking, a quotation consists of the identifier (a number) and a pair of coordinates that specify the beginning and end of the quotation. The content of a document file (the data source) is therefore not altered by the creation, deletion, or modification of quotations. Quotations are stored inside the ATLAS.ti project file, independent of the document to which they belong.

**Types of Quotations**

There are six different types of quotations corresponding with the six different types of data file formats ATLAS.ti accepts:

**TEXT QUOTATIONS**

Textual quotations represent (for the computer) a sequence of characters (“strings”) and can be of arbitrary size. Sentences, speech turns, or paragraphs are often the basis for the length of textual quotations. Only text offers enough “syntactical clues” to allow for searches for the occurrence of specific evidence that may support a concept. Text also offers the option for automatic segmentation as used by the Auto-Coding procedure.

See "Auto Coding Tool."

**GRAPHIC QUOTATIONS**

The creation, activation, and display of graphical quotations has similarities with, but also differs from, their textual counterparts.

A graphical quotation is a rectangular region inside a graphical document. From its data structure, it is identical to textual quotations, since their main attributes are also the document identifier and two coordinates that mark the beginning and end, defining a rectangle through its upper left and lower right corner. Handling graphical quotations is largely analogous to marking text passages in a textual document.

See "Creating Graphical Quotations."

**PDF QUOTATIONS**

PDF quotations can be of a textual or of a graphical nature. The quotation references for textual quotations indicate the page number and the start and end position on the basis of character counts. For example: (31:1537–31:1745) means that this quotation is from page 31, starting at character 1537 and ending at character 1745. The reference for coded images indicates the position of the quotation within the PDF file, like (@422–@618).

See "Creating PDF Quotations."

**AUDIO AND VIDEO QUOTATIONS**

Audio and video quotations can be as short as a few milliseconds. The length of a quotation is selected on a time line. Segment starting points and length are displayed in the following formats:

milliseconds / HH:MM:SS:ms / frames (for videos)

See "Working With Multimedia Data."
Geo Quotations

When creating a Geo quotation, you see the ATLAS.ti icon on an Open Street map. It is linked to one location and thus is different from all other types of quotations that present a range. The quotation ID shows the name of the document. In addition, the geographic reference of the marked location is provided.

See "Working With Geo Docs."

More detail on how to work with quotations can be found in the section "Working With Quotations."

Coding Objectives

The term "code" is used in many different ways. First, we would like to define what that term means in qualitative research, and then in ATLAS.ti.

From a methodological standpoint, codes serve a variety of purposes. They capture meaning in the data. They also serve as handles for specific occurrences in the data that cannot be found by simple text-based search techniques.

Codes are used as classification devices at different levels of abstraction in order to create sets of related information units for the purpose of comparison (e.g., a concept like "Coping Strategy").

Keep code names brief and succinct. Use the comment pane for longer elaborations.

From a "low level" tool perspective, codes are typically short pieces of text referencing other pieces of text, graphical, audio, or video data. Their purpose is to classify an often large number of textual or other data units.

In the realm of information retrieval systems, the terms "index," "indexing," or "keyword" are often used for what we call "code" or "coding."

The length of a code should be restricted and should not be too verbose. If textual annotations are what you want, you should use quotation comments instead.

The technical aspects of coding are described in the section "Coding Data" and "Working With Codes."

Auto Coding Tool

If the primary text itself contains important key words, the Auto Coding Tool scans the text and automatically assigns a pre-selected code to matching text passages. From simple string matching to sophisticated pattern match (GREP) and keyword in context searches, all is available in the Auto Coding Tool. If so desired, the process can be controlled by manual confirmation of each action.

The process is described in the section "Auto Coding."

Memos

Memos capture your thoughts regarding the text and are an important device for creating theory. A "memo" is similar to a code, but usually contains longer passages of text.

A memo may "stand alone" or it may refer to quotations, codes, and other memos. They can be sorted by type (method, theoretical, descriptive, etc.), which is helpful in organizing and sorting them, or by creating memo groups. Memos may also be included in the analysis as data to be coded by converting them into a project document.

Comments

You can write comments for all entities in ATLAS.ti. Comments different from memos are always directly connected to the entity you write them for. Writing comments is similar to scribbling notes in the margin of a paper, or attaching sticky notes to things. Comments can be written for documents, quotations, codes, memos, networks, all types of groups, and for relations.

See "Working With Comments And Memos" for further detail.
Groups

Groups are a way to form clusters of documents, codes, memos and networks to be used as filters. Document groups can be regarded as attributes or variables (see Working With Groups). It is possible combine them using logical operators (AND, OR, NOT), e.g. to retrieve and analyze not only female respondents, but female respondents from the Northern region – which is an AND combination of the group: female and the group: Northern Region.

Networks

Networks are a bit more sophisticated than groups. They allow you to conceptualize the structure by connecting sets of related elements together in a visual diagram. With the aid of Networks you can express relationships between codes, quotations, and memos, documents, and groups. Also Networks themselves can be "nodes" in a network.

Figure 3: Example network (see sample project)

Nodes, Links and Relations

A node is any object that is displayed in a Network. You can change their look and move them around in the network editor. Relations are link prototypes used to create a link between two codes or between two quotations. An example is the "is-a" (ISA) relation, which is frequently used to link concepts of different abstraction level (e.g., DOG <isa> MAMMAL).

Network Manager

The Network Manager contains a list of all saved Network previously constructed by the user. It can be used to create new Network, to access or delete existing ones, or to write and edit comments. See "Network Manager."

Network editor

The network editor displays and offers all editing capability to construct and refine semantic networks. In addition, it allows the visual creation and traversal of hypertext structures.

Link Manager

The Link Managers provide an overview of all code-code links and of all hyperlinks you have created. See "Working With Hyperlinks."

Relation Manager

Should the already built-in relations that are used to connect nodes in Networks prove not sufficient, you can edit them or create new ones using the Relation Editor. See "Creating New Relations."

Find more information on the network function under "Working With Networks."
Navigation Area

When you open ATLAS.ti, the navigation area is displayed on the left-hand side of your screen. The Project Explorer displays all the elements of a project in a strictly hierarchical manner, even if the structures are non-hierarchical, or even cyclic. On the first level it displays documents, codes, memos, networks, document groups, code groups, memo groups and network groups. By opening up the various branches, you can see and also access all linked entities. When double-clicking one of the main branches, the associated manager opens. See "Entity Managers."

In addition to the main Project Explorer, you can open a browser for each of the main entities: documents, quotations, codes, memos and networks. They also include a search field. Further options are to display the Code Co-occurrence Explorer and the code tree. See "Code Co-Occurrence Tools."

Project Search

Use the project wide search to search for words, sentences, expressions in your entire project. The search can be restricted to a particular author or to any of the entities like documents, codes, memo, comments, groups, etc. The reports show the search term with surrounding context. In addition it is possible to access each hit within the context of the project. See "Project Search."

Analysis

ATLAS.ti contains multiple powerful, dedicated analytical tool to help to make sense of your data.

Word Clouds and Word Lists

ATLAS.ti can count all words in all or selected documents, all or selected quotations, or quotations coded by one or more selected codes. The result can be displayed in form of a word cloud, an internal report, or as Excel table. Stop and go lists in various languages can be defined and applied. See "Creating Word Clouds And Word Lists."

Cross-Tabulation of Codes (Code Co-occurrence)

The Co-occurrence Explorer and Table show where you have applied codes in an overlapping manner. Rather than determining the codes yourself, you can ask ATLAS.ti which codes overlap. The output can be viewed in form of a tree view or a table. The table provides a frequency count of the number of cooccurrences and a coefficient measuring the strength of the relation. Since a coefficient is only appropriate for some type of data, its display can be activated or deactivated. It is also possible to directly access the data of each cooccurrence. See "Code Co-Occurrence Tools."

Figure 4: Code Co-occurrence Table
**Code Document Table**

The Code Document Table counts the frequency of codes across documents. Aggregated counts based on code and document groups are also available. Optionally, the table cells can also contain the word counts for the quotations per code across documents or document group. The table can be exported to Excel. See "Code Document Table."

**Query Tool**

For more complex search requests, the Query Tool is at your disposal. Here you can formulate search requests that are based on combinations of codes using one or a combination of 14 different operators, Boolean, semantic and proximity operators (see "The Query Tool").

**Smart Codes**

A Smart Code is a stored query, thus provides an answer to a question (in the best case) and typically consists of several combined codes. See "Working With Smart Codes."

**Smart Groups**

Smart groups are a combination of groups. For instance, if you want to compare answers of female respondents from rural areas with female respondents from urban areas, you would create two smart groups that you either use directly in a Code-Document Table, or as filter in a code query. Smart code groups can be used if you frequently need a combination of certain codes. See "Working With Smart Codes."

**Team Tools**

Team work is a normal scenario in data analysis, and ATLAS.ti is uniquely suited for collaborative work. A number of special tools and features support efficient work in a team. For further information see the chapter on "Team Work."

**User Administration**

Manage the ATLAS.ti user database through the user administration tool. This is a prerequisite for collaborative work, but is also useful to individual users through personalizing the log-in. User Management options can be found under the Tools & Support tab ("User Accounts").

**Project Merge**

This tool merges different projects. You find this function under the File menu in the backdrop area. Further information is provided in the section "What You Need To Know When Merging Projects," and "Merging Projects."

**Inter-Coder Agreement and Reliability**

ATLAS.ti allows for a qualitative and quantitative comparison of the codings of various coders. If you are interested in calculating a coefficient, ATLAS.ti offers the following: percent agreement, Holsti, and various Krippendorff’s alpha coefficients. See “Inter-Coder Agreement (ICA).”

Please note that synchronous work is no supported. Each team member work in his or her own project file and these files need to be merged from time to time.

**Export**

**Word / PDF**

There are output options for each of the main entities in ATLAS.ti: Documents, Quotations, Codes and Memos and within the various tools. All reports are user configurable and you can decide which type of content to include. See "Creating Reports."

**Print Document With Margin**

Currently only available in the Mac version.
QDPX Export For Projects

The QDPX format is a QDA-XML standard for exchanging projects between different CAQDAS packages. The project exchange format was launched March 18, 2019. You can see all participating programs on the following website: http://www.qdasoftware.org. To export a project in QDPX format, select File / Export.

SPSS Export

You can export your coded data as SPSS syntax file. When executed in SPSS, your quotations become cases and your codes and code groups variables. In addition, further identifying information in form of variables is provided like the document number for each case, start and end position and creation date. These variables allow you to aggregate your data in SPSS if needed (“SPSS Syntax Export”). If you need a less detailed output, see “Code Document Table.” The table provides an output that is already aggregated by documents or document groups.

Generic Statistic Export for R, SAS, STATA, etc.

You can export your coded data as Excel file for further analysis in any statistical package. Quotations become cases and codes and code groups variables. In addition, further identifying information in form of variables is provided like the document number for each case, start and end position and creation date. See “Generic Export For Further Statistical Analysis.”

Excel Export

You find an Excel Export option in each Manager and quotation list. In addition, the results of the Code Co-occurrence Table and the Code-Document-Table can be exported as Excel file. See “Creating Reports”.

Graphic Files

Networks can be saved in various graphic file formats (jpg, png, tiff, gif, bmp). See “Exporting Networks.” The code-document table can be exported as pgn file.

ATLAS.ti Mobile for iPad and Android

ATLAS.ti, the powerful knowledge workbench, now has two companions—ATLAS.ti Mobile for iPad and Android devices. With the app you can collect and analyze data wherever you are and can take your iPad or Android device along. Perhaps you want a work on a document while on a long train, plane or boat ride. Email it to yourself so it is available on the iPad/Android device. Add it to an ATLAS.ti Mobile project, read it, write comments, and perform coding work. You can later merge the result with your existing ATLAS.ti desktop project. This is explained in section “What You Need To Know When Merging Projects” and “Merging Projects.”

Figure 5: ATLAS.ti iPad app in action
Main Steps in Working with ATLAS.ti

The figure below illustrates the main steps of working with ATLAS.ti, starting with the creation of a project, adding documents, identifying interesting things in the data and coding them. Memos and comments can be written at any stage of the process, whereas there is possibly a shift from writing comments like adding meta information to your documents, first code nodes that later turn in to code definitions, initial thoughts about specific data segments (the ATLAS.ti quotations) to more extensive memo writing during the later stages of the analysis. Once your data is coded, it is ready to be queried using the various analysis tools provided. The insights gained can then be visualized using the ATLAS.ti network function.

Some steps need to be taken in sequence—for instance, logic dictates that you cannot query anything or look for co-occurrences if your data has not yet been coded. But other than that there are no strict rules. Networks, in addition to presenting findings, also have an exploratory component and as such can help you to see your data from a different perspective. This may provide further ideas for coding, querying or even further data collection.
Data And Project Management

A first important but often neglected aspect of a project is data and project management. The first step is data preparation. You find more information on supported file formats in the section "Supported File Formats."

Apart from analyzing your data, you also manage digital content and it is important to know how the software does it. For detailed information, see the section "Project Management."

If you work in a team, please read the following section: "Team Work."

The Process

There are two principal modes of working with ATLAS.ti, the data level and the conceptual level. The data level includes activities like segmentation of data files; coding text, image, audio, and video passages; and writing comments and memos. The conceptual level focuses on querying data and model-building activities such as linking codes to networks, in addition to writing some more comments and memos.

Data-Level Work

Data-level research activities include exploring your data using word clouds and word lists, segmenting the data that you have assigned to a project into quotations, adding comments to respective passages (note-making/annotating), linking data segments to each other called hyperlinking in ATLAS.ti, and coding data segments and memos to facilitate their later retrieval. The act of comparing noteworthy segments leads to a creative conceptualization phase that involves higher-level interpretive work and theory-building.

ATLAS.ti assists you in all of these tasks and provides a comprehensive overview of your work as well as rapid search, retrieval, and browsing functions.

Within ATLAS.ti, initial ideas often find expression through their assignment to a code or memo, to which similar ideas or text selections also become assigned. ATLAS.ti provides the researcher with a highly effective means for quickly retrieving all data selections and notes relevant to one idea.

Conceptual Level Work

Beyond coding and simple data retrieval:

ATLAS.ti allows you to query your data in lots of different ways, combining complex code queries with variables, exploring relationships between codes and to visualize your findings using the network tool.

ATLAS.ti allows you to visually "connect" selected passages, memos, and codes into diagrams that graphically outline complex relations. This feature virtually transforms your text-based work space into a graphical "playground" where you can construct concepts and theories based on relationships between codes, data segments, or memos.

This process sometimes uncovers other relations in the data that were not obvious before and still allows you the ability to instantly revert to your notes or primary data selection. – For more detail, see "Querying Data" and "Working With Networks."
STARTING ATLAS.TI

To change the user interface language, select **FILE / OPTIONS / APPLICATION PREFERENCES / DISPLAY OPTIONS**.

Creating a New Project

If you just started ATLAS.ti click on the button: **CREATE NEW PROJECT** in the opening window. Enter a project name like “My first project” and click on **CREATE**.

If a project is already open, click on **FILE** to open the backdrop. From there select the **CREATE NEW PROJECT** button.

Importing An Existing Project

Open ATLAS.ti and select the **IMPORT PROJECT** button from the opening screen.

If ATLAS.ti is already open, select **FILE / NEW**, and from there the Import Project Bundle option. You have the option to rename the project before importing. This is useful for team project work and if you do not want to overwrite an existing version.

If the project that you are importing already exists in your library, you have the choice to either overwrite the existing project with the version you are importing, or whether you want to rename the project that you are importing.
Importing an ATLAS.ti 7 Project

We recommend that you create a transfer bundle file in version 7 that you import to version 8.

- In version 7, select **PROJECT / EXPORT / TRANSFER BUNDLE (FOR MAC & A8)**.
- Open ATLAS.ti 8 and select the regular **IMPORT PROJECT** option to open your version 7 project. If ATLAS.ti is already open, select **FILE / NEW**, and from there the Import Project Bundle option.
- Video Tutorial: **ATLAS.ti 8 Windows - Transfer from ATLAS.ti 7 to ATLAS.ti 8**

Importing Copy Bundle Files (Versions 5, 6 Or 7)

- To import a copy bundle file, open ATLAS.ti 8 and also select the option **IMPORT PROJECT**.
- If ATLAS.ti is already open, select **FILE / NEW**, and from there the Import Project option.

The ATLAS.ti Interface

When you open a project, you see the ribbon on top, the project navigator on the left-hand side and the ATLAS.ti logo in the middle of the working area. At the top of the screen, you see the title bar where the name of the current project is displayed. It also includes the Save, Undo and Redo functions on the left-hand side. Below the title you see ribbon tabs.

- Video Tutorial: **ATLAS.ti 8 Windows - Interface Overview**
You are probably familiar with ribbons from other contemporary Windows software that you use. A ribbon is a graphical control element in the form of a set of toolbars placed on several tabs. They are grouped by functionality rather than object types, as was the case in older versions of ATLAS.ti. Ribbons, in comparison, use tabs to expose different sets of controls, eliminating the need for numerous parallel toolbars. This highly improves the workflow and makes it easier for users to see which functions are available for a given context.

The ATLAS.ti Ribbon

The five core tabs in ATLAS.ti are:

- Home
- Search Project
- Analyze
- Import / Export
- Tools & Support

Depending on the function you are using, additional contextual tabs will appear. These will be highlighted by a colored line at the top of the ribbon.

The **Home** tab is the starting point for most projects. You can start here to add documents to a project, create new codes, memos and networks (New Entities), open various navigators to be displayed in the navigation area on the left-hand side of the screen, write a comment for your project, open the various managers, and project explorers, or auto code your project.

The **Search Project** tab allows to search through all entities of your project. Later in this tour there will be an exercise where you practice its functionality.

The **Analyze** tab offers a number of advanced functions to analyze your data after coding. See “Querying Data”
Use the **Import & Export** tab to import Twitter data (“Working With Twitter Data”), to add data stored in Evernote, to import data from reference managers like Endnotes, Medeley, etc. to support the analysis of literature (“Working With Reference Manager Data”), to import survey data, especially responses to open-ended questions ("Error: Reference source not found") and already existing code lists. If you are interested in a mixed-method approach, you can generate a SPSS syntax file for further quantitative analysis in SPSS of your qualitative coding, or export a generic version in form of an Excel file for import in R, SAS or STATA (“Data Export For Further Statistical Analysis”). Further you can import and export code books in Excel format, or in the QDPX format for exchange with other CAQDAS software. Another option is to import or export document groups as, or on the basis of an Excel file. See “Importing and Exporting Document Groups”.

If you want to report a problem, send suggestions, create or manage user accounts, want to access the Quick Tour or other resources, click on the **Tools & Support** tab. A further options is to clean up your project by finding and removing redundant codings. See “Finding Redundant Codings”.

### The Backdrop

Under **File** you find all options that concern your project, like creating a new project, open existing projects, saving and deleting projects, exporting and merging projects (see “Project Management”. For more information on merging projects, see "What You Need To Know When Merging Projects”.

### The Six Main Entity Types

The six main entity types in ATLAS.ti are: Documents, Quotations, Codes, Memos, Networks, and Links. All entity types have their own manager (see “Entity Managers”). The **Entity Managers** allow access to the entities and provide several options and functions.

- To open a manager, double-click on the button in the ribbon.

Entity Managers are child or dependent window of the main editor. Child windows have some common properties:
- They are closely related to their parent window and changes in either the child or the parent window are usually “broadcast” between them (like the selections of items).
- They can be resized and positioned independently of their parent window.
- They are minimized when the parent window is minimized and they are restored with their parent window.
- They are closed when the parent window is closed.
- However, child windows do NOT move with the parent window.
The Navigation Panel

On the left-hand side of the main editor you find the navigation panel:

When you open ATLAS.ti, the Project Explorer opens automatically. From the main branches you can access documents, codes, memos, networks and all groups. If you are looking for something in particular, you can enter a search term into the search field. If you open the branches of the various entities, they will only show you items that contain the search term.

To open a branch, click on the triangle in front of each entity, or right-click and select the Expand option from the context menu.

With a double-click on a main branch, the respective manager of the selected entity type is opened (see "Entity Managers.")

Under the main Documents branch, you see all documents. Below each document, you can access all quotations of a document.

Under the main Codes branch, you see the list of all codes. On the next level, you see all linked codes. For further information see "Linking Nodes."

Under the main Memo branch, you see the list of all memos. On the next level, you see all linked entities, which for memos can be other memos, quotations and codes.

Under the main Networks branch, you see the list of all networks. On the next level, you see all entities that are contained in the network. If you open the branches further, you see the entities that are linked to the respective items.

Under the Group branches, you see the list of all groups and below each group, the list of all members of the selected group.

Context Menus

Each item in the navigation panel has a context menu, which means a context sensitive menu opens when you right-click. As each of the options are explained elsewhere, in the following only one example is shown. Depending on the entity that you click, each context-menu will be slightly different.

Common to all context menus is the Expand and Collapse option, and the option to open the Entity Manager.
Browsers

In addition to the Project Explorer that contains all project items, you can also open browsers that only contain one entity type. Browsers are available for documents, quotations, memos and networks.

To open a Browser, click on the drop-down arrow of the Navigator button. The Documents and Quotations Browser can also be launched directly from the Navigator Group.

The single entity Browsers open in tabs next to the Project Explorer. Different from the Explorers, all Browsers have a Search field on top of the list of entities. This facilitates working with long lists. As shown in Figure 20, the list of codes only shows codes that contain the word 'child' as entered in the search field.

Explorers

You can open three types of explorers in the navigation panel: the Project Explorer (see "The Navigation Panel"), the Code Forest, and The Code Co-occurrence Explorer (see "Code Co-Occurrence Tools").

Closing Browsers and Explorers

To close either a browser or explorer, click on the X at the top right of the Navigation Panel.

To close all browsers/explorers, or all but one, right-click on the drop down arrow and select the appropriate option from the context menu.

Open Browser or Explorer in a new tab group, in a split navigation panel or Floated

Right-click on the drop down arrow and select the appropriate option from the context menu (see Figure 21).

Working With Docked And Floated Windows

When you first open a manager or other windows, they will be opened in floating mode. All windows can however also be docked and depending on what you are currently doing, you may prefer a window to be docked or floated. Once you have docked a window, ATLAS.ti will remember this as your preferred setting for the current session. Let's shortly practice how to dock and undock windows.

Open the Code Manager by clicking the Codes button in the Home Tab.
To dock this window, click on the icon shown in Figure 22. To float the window again, click on the drop down arrow as shown in Figure 23 and select **FLOAT**.

**Always On Top**

A floating window disappears in the background if you click outside the window. If you prefer the window to stay on top of other windows, right-click on the button at the top left of the window and select the option **ALWAYS ON TOP** (Figure 24).

**Working With Tabs And Tab Groups**

In the following it is explained how to work with the various entities and features in the main work space. If you want to click along, you may want to open the Children & Happiness sample stage 2 sample project. Download the project bundle file and import it (see "Importing An Existing Project").
To load a document, open the document tree in the navigation area on the left-hand side and double-click document, e.g. D1 and D3:

The documents are loaded into two tabs in the main work space. The tab of the currently loaded document is colored in yellow.

If you want to see the documents side-by-side, you can move one of the documents into a different tab group, click on the down arrow and select New Tab Group / Right.

You have the option to move it into a tab group to the right, left, below or above.
By the way, this can also be done with any other items you open, be it your list of codes, a memo, or a network. You can individualize your work space as it suits your needs. An example is shown in Figure 28.

User Interface Language

Currently the interface is available in English, German, Spanish, Portugese and Simplified Chinese. In the future, a number of further languages will become available. See “Selecting The Display Language”.

Entity Managers

There is a separate manager for each of the six entity types: Documents, Quotations, Codes, Memos, Networks, and Links. The Entity Managers allow access to the entities and provide several options and functions. As there are differences among the various entity types, each manager is described in more detail further below.

Launching An Entity Manager

To open the Document Manager, click on the DOCUMENTS button in the HOME TAB; to open the Quotation Manager, click on the Quotations button; to open the Code Manager click on the Codes button, and so on. See Figure 15.

An alternative way is to double-click on Documents, Codes, Memos, etc. in the Project Explorer in the navigation panel on the left (see “The Navigation Panel”).

The managers open as floating windows, but all windows can be docked as well (see arrow on the top right in Figure 29). Each manager contains a list of the entities it manages and some detailed information about them. At the bottom of the list, you find a comment field in each manager and in some managers, also a preview field. In the Document and Quotation...
Manager you can preview the content of either the selected document or the selected quotation. In the Memo Manager, the memo content is shown next to the comment field.

Another common element is the side panel on the left-hand side, which can be used to quickly access and filter the elements listed in the managers via groups.

You can activate or deactivate the side panel by selecting the first option in the View Tab, which is to show or hide entity groups (see Figure 30).

The Split Bar
The relative size of the side panel, list, preview and comment pane can be modified by dragging the split bar between the panes. The cursor changes when the mouse moves over the split bar. You can re-size the adjacent panes by dragging the split bar to the desired position.

The Status Bar
The status bar shows the number of items listed in the manager. The Document Manager shown in Figure 29 for instance contains 30 documents.

Searching
On top of the side-panel and entity lists, you find a search field. Use the search field to search for either documents, quotations, codes or memos in the respective managers.

If you enter a search term, all objects that include the term somewhere will be shown in the list. For example, if you enter the term “children” in the code manager, all codes that include the word “children” somewhere in the code name will be shown like children: unrelated to personal happiness, or source: children, or SQ: Reasons for having children.

Remember to delete the search term if you want to see all codes again.

Incremental Search
This feature is available in the list pane of all Entity Managers. Select any item in the list and type in an arbitrary sequence of characters to jump to a subsequent list entry matching this sequence.

Context Menus
The list and text panes offer context sensitive pop-up menus. The list pane’s context menu contains a portion of the commands that you also find in the ribbon.
Sorting and Filtering

The Entity Managers permit comfortable sorting and filtering. With a click on a column header all items are sorted in ascending or descending order based on the entries in the selected column.

When creating entity groups, you can also use them to filter the list of items in a manager. When selecting a group, only the members of the selected group are shown in the list (see "Setting A Local Filter"). When selecting multiple entities, you can combine them with AND or OR. See "Simple AND And OR Queries In The Quotation Manager".

In all managers but the Links Manager you find both a View and a Search & Filter tab. In the Document and Code Manager, there is an additional Tools tab.

View Options

In the View tab, you can activate or deactivate the side panel, the preview field (if available) or the comments. In addition you can switch between Detail and Single Column view.

![View Options](image)

Search & Filter Options

The search allows you to search through the entire content of documents, quotations or memos, through entity names and comments, or entities created or written by a selected author. The search term can contain regular expression. See "Regular Expressions (GREP)".

In case you wonder why there is a search option here in addition to the main Search tab, the difference is that the search option in managers is restricted to the respective entity type. Thus, if you are for instance in the Quotation Manager and you want to search quotation content, accessing the search option directly in the manager is more convenient.

![Search & Filter Options](image)

An additional option is to set and remove global filters.

Selecting Items in Entity Managers

Next to thinking, clicking will likely be one of the most frequent activities when working with ATLAS.ti.

Clicking is done in many different ways such as single- and double-clicking and clicking with the left or the right mouse button. The "semantics" of a mouse-click are not perfectly straightforward, and a few variations must be learned.

A single click with the left mouse button selects and highlights an item in each of the Entity Managers.

A double-clicking an item selects the entity and invokes a procedure depending on the type and state of the entity. The effect of a double-clicking is described for each of the Managers below.

For multiple selections, you may use the standard Windows selection techniques using the Ctrl or Shift key.

For example, suppose a number of codes begin with "em" (e.g., "Emotions") and others with "ex" (e.g., "External Reference"): typing "em" will jump to the first of the "EMotion ..." codes, while entering "ex" will jump to "External reference." Every other character typed advances the focus to the next list entry unless a matching name cannot be found.

Avoid long delays between entering characters. After a certain system-defined timeout, the next character starts a new forward search.
The Document Manager

The Document Manager helps you to organize your data, to group them or to filter them. Further you can access the auto coding tool from here, if you only want to auto code selected documents. You can begin to explore your documents using word clouds or word lists, create reports or view geo locations in Google Maps.

Double-click: Double-clicking a document loads the data source and displays its content in the main window. For each document a new tab will be opened.

Multiple Selection: You can select more than one document at a time by holding down the Shift or Ctrl key. This can be useful when running an analysis for multiple documents, when creating groups or reports.

Filter: Click on one or more document groups in the side panel to set a local filter. This means only the items in the manager are filtered. If you set a global filter, all project items are effected (version 8.1 and higher). See “Applying Global Filters For Data Analysis”

Status Bar: The Status Bar shows how many documents there are in the project.

Document Manager Columns

The information provided for each document consists of:

ID: The document ID is a consecutive number given to the document by ATLAS.ti when it is added to a project.

Name: The default name is the file name of the original source file that you added to your ATLAS.ti project. You can rename each document if you prefer a different name.

Location: Here you see whether a document is stored in the ATLAS.ti library or whether ATLAS.ti opens it from the linked location. For further information see “Adding Documents”

Groups: This column lists all groups a document belongs to.

Quotations: The number of quotations a document has.

Created By: The name of the user who added the document.

Modified By: The name of the user modifying a document, either by writing a comment or by editing it (editing will be implemented in version 8.2).

Created / Modified: Date and time when a document was created (=added to the project) and modified (not yet possible until text editing is implemented).
The Document Manager Ribbon

Many of the options available in the ribbon are also available from the context menu of a document. It is a matter of preference which way of selecting a function you are using.

From left to right:

Add Document(s): Add a new document to your project. See "Adding Documents."


New Smart Group: Smart Groups are a combination of existing document groups using Set operators. See "Working With Smart Groups" for further detail.

Auto Coding: See "Auto Coding."

Focus Group Coding: See "Focus Group Coding."

Rename Document: See "Renaming Documents."

Delete Document: Remove selected document(s) from a project. See "Deleting Project Documents."

Browse Geo location: This is an option for snapshot of Geo documents. It opens Google Maps and you can view the location in the various views provided by Google Maps. For more detail see "Working With Geo Docs."

Edit Comment: Open a full-fledged text editor for writing or editing a comment for a selected document. See "Working With Comments And Memos."

Open Group Manager: See "Working With Groups."

Open Network: Open a network on the selected primary document(s). See "Working With Networks", "Opening A Network On One Or More Entities", and "Comparing Cases."


Word List: See "Word Lists."

Report / Excel Export: See "Creating Reports."

Tools Tab

Renumber Documents: When adding documents to a project, they are numbered by ATLAS.ti in consecutive order. If you remove one or more documents, this may result in gaps. To close these gaps and renumber all documents in consecutive order, select the Renumber Documents option. You can also use this option to re-order documents the way you want them to be ordered. To achieve this, rename the document that sorting by name results in the order you want. Sort the document by name and then renumber. The numbers will then follow the alphabetical order.

Renumber Quotations: Selecting this option will close any gap in the numbering of quotations. Each quotation that you create has an ID. The ID consists of the document number and a number indicating the chronological order when it was created. For example, the ID 3:12 means that this is a quotation in document D3 and that it was the twelfth quotation that was created. The ID 9:41 means that this quotation is in document D9 and it was the 41st quotation that was created in the document. If you delete quotations or modify them, the ID does not change. If you delete a quotation with the ID 3:11, this does not mean that quotation 3:12 automatically becomes quotation 3:11. Such an automatism is not always desired. If you for instance have already started the writing process and made reference to some quotations using their ID, you would not want ATLAS.ti change the Ids all the time. If you do want all quotations to be numbered in sequential order, you need to evoke it manually by selecting the Renumber Quotations option.

Import Transcript: This option is available after you have added a multimedia document (audio or video). If you have a transcript with timestamps for this document, you can add it as transcript. The transcript and multimedia document are synched via the timemarks. See "Importing Multimedia Transcripts."
Document Export: This option allows you to export your documents as external data files. Text files are exported as Word docx files, all PDF, image and multimedia files in their original format.

Repair Link: If you have linked an audio or video file to a project and the link is no longer valid, you can repair the link using this option.

Remove Codings: You can use this option if you want to unlink all codes from all quotations. This means all quotations and all codes remain in the document, but none of the quotation is coded. This is useful at times for team projects and inter-coder agreement analysis.

Browse Geo Location: All geo documents are based on Open Street Map. If you want to see a geo location in Google Maps, you can use this option. See “Working With Geo Docs” on page 139.

Duplicate document(s): This allows you to create an exact copy of one or more documents with all quotations, codes, links, etc. This can be useful if for instance you want to code a document based on different aspects. Once text editing becomes available, this option will allow you to split a document, also when it is already coded. You duplicate it first, then (entering edit mode) you delete the second part of one document and the first part in the other.

Quotation Manager

Quotation Manager is very useful for interpretive approaches, discourse analysis, or any other approaches where you do not want to code data immediately. It is also used for retrieving and reviewing data by codes, creating smart codes, writing comments on the quotation level, creating reports, or opening networks. When working with multimedia and geo data, it is useful to rename quotation names to use the as titles for audio- or video segments or for location names in case of geo data.

A single-click selects a quotation. If you have written a comment for the selected quotation, it is displayed in the text pane.

A double-click on a quotation loads its document (unless already loaded) and displays its content in context.

Multiple Selection: You can select more than one quotation at a time, either to delete them, to attach codes, to open a network on them, or to create output.

Drag & Drop: By dragging one or more quotations onto other quotations, you create hyperlinks. See “Working With Hyperlinks” for further information.

Filter: Click on one or more codes in the side panel to view only quotations linked to the selected code(s). See “Activating and Displaying Quotations” for further detail.

Status Bar: The Status Bar shows how many quotations there are in the project.

Quotation Manager Columns

The information provided for each quotation consists of:

Id: The Id combines the document number and the quotation sequence number. The quotation Id 3:10 means that the quotation is part of the third (3:) document, and it is the 10th (10:) quotation that was created in this document. Quotations are numbered in chronological and not in sequential order.
A tilde sign (~) indicates that a comment was written for this quotation; the brackets (< or >) indicate that the quotation is a start anchor or target for a hyperlink.

**Name:** The first 60 characters of a quotation are used as the default list name. This name can be changed if desired. The default name of a graphic, audio, or video quotation is the name of the data file name. The name for geo quotations is the geographic reference.

**Document:** The name of the document it belongs to.

**Density:** Number of links to other quotations.

**Codes:** the codes linked to the quotation

**Created By:** The name of the user who created the quotation.

**Modified By:** The name of the user modifying a quotation, either changing the boundaries, renaming it or writing a comment.

**Created / Modified:** Date and time when a quotation was created and modified.

**Start / End / Extent:** Start and end position of a quotation in the document, and the total length of a quotation. The measure that is used is dependent on the media type. See below:

**Start / End**
- Text quotation: number of characters
- Text PDF: page number in ATLAS.ti plus number of characters on the page
- Graphic quotation: upper left coordinates / lower right coordinates
- Audio quotation: hours:minutes:seconds: milliseconds
- Video quotation: hours:minutes:seconds: milliseconds
- Geo quotation: n/a

**Extent**
- Text quotation: total number of characters
- Text PDF: n/a
- Graphic quotation: height in pixel of the quotation’s rectangle.
- Audio quotation: hour:minutes:seconds:milliseconds
- Video quotation: hour:minutes:seconds:milliseconds
- Geo quotation: n/a

**Quotation Manager Ribbon**

From left to right:

**Smart code:** Based on the codes in the side panel of the Quotation Manager you can build smart codes. For further information see "Working With Smart Codes ."

**List Coding:** Selecting one or more existing code from a list to code a selected data segment. See "Applying Existing Codes ."

**Open Coding:** Coding a selected data segment with a new code. See "Coding With A New Code ."

**Quick Coding:** Coding with the last used code. See "Applying Existing Codes ."

**Rename Quotation:** When creating a quotation, ATLAS.ti creates a default name for each quotation. See "Quotation Manager Columns ." This default name can be changed. See "Renaming Quotations ."

**Delete Quotation(s):** For further information see "Deleting Quotations ."

**Edit Comment:** Open a full-fledged text editor for writing or editing a comment for a selected quotation. See "Working With Comments And Memos ."

**Merge Quotations:** You can merge two or more quotations. The new quotation boundary can either be the boundary of a Selected target quotation, or it can be expanded to include all selected quotations.

**Renumber Quotations:** This eliminates all gaps in quotation numbering due to deletion and renumbers all quotations in sequential order as they occur in the document.

**Link Source:** Click to select the selected quotation as source in the process of creating a hyperlink. See "Working With Hyperlinks" for more detail.

**Link Target:** Click to select the selected quotation as target in the process of creating a hyperlink. See "Working With Hyperlinks" for more detail.
Open Network: Open a network on one or more selected quotations. See “Working With Networks” and “Opening A Network On One Or More Entities”.

Word Cloud: See "Creating Word Clouds And Word Lists.”

Word List: See “Word Lists.”


Code Manager

The Code Manager is frequently used to create and modify codes, to code data segments via drag & drop, to set code colors, to retrieve coded data segments, to organize them in code groups, to merge and to split codes, to filter them, to review them in networks, to review its content using word clouds and word lists, and to create reports.

A double-click on a code opens the list of linked quotations. You can browse through the list of quotations and view them highlighted in the context of its document. If there is only one quotation linked to a code, it will immediately highlighted in the context of its document. See “Activating and Displaying Quotations.”

Single-click: Selects a code. If you have written a definition for the selected code, it is displayed in the comment pane below the list. Once selected, the code can be used for drag & drop coding, or you can add it to a code group via drag & drop.

Multiple Selection: You can select more than one code at a time by holding down the Ctrl or Shift key to delete, code a data segment with all of the selected codes, open a network, create reports, assign them to a code group or remove them, or to create a code group containing the selected codes.

Drag & Drop: You can use the Code Manager as a convenient tool for coding by dragging codes onto a highlighted piece of data. If you drag codes onto another code within the same list pane, code-links will be created. If you drag a code on top of another code in the margin area, it will be replaced.

Colors: If you add code colors, a colored circle is displayed in front of the code icon and name. Code colors also have an effect on the display of code nodes in networks. See “Working With Networks.”

Filter: Click on one or more code groups in the side panel to set a local filter. This means only the items in the manager are filtered. If you set a global filter, all project items are effected (version 8.1 and higher). See “Applying Global Filters For Data Analysis.”

Status Bar: The Status Bar shows how many codes there are in the project.

Code Manager Columns

The information provided for each code consists of:

Name: Code name.
Grounded: Code frequency or "groundedness." It shows how many quotations are linked to a code.
Density: Number of linkages to other codes. See "Linking Nodes."
Groups: This column lists all groups a document belongs to.
Created By: The name of the user who created the code.
Modified By: The name of the user modifying the code, either renaming it or writing a comment.
Created / Modified: Date and time when a code was created and modified (i.e. renaming it, writing a comment, merging or splitting it).

**Code Manager Ribbon**

From left to right:
Free Code(s): Create one or more new codes.
New Group: Create a new code group based on the selection you have made.
Create Smart Group: Smart Groups are a combination of existing code groups using Set operators. For further information see "Working With Smart Groups."
Smart code: If you select two or more codes in the Code Manager, you can created ORed smart codes i.e. a smart code that combines all selected codes with the OR operator. For further information see "Working With Smart Codes ."
Create Snapshot: See "Working With Smart Codes " and "Creating Snapshot Codes."
Duplicate Code(s): Duplicate an existing code, e.g. in order to split it using the network editor. See "Duplicating A Code .
Rename Code: When building a code system it is often necessary to rename a code.
Delete Code(s): Delete selected code(s).
Edit Comment: Open a full-fledged text editor for writing or editing a comment for a selected code. See "Working With Comments And Memos."
Edit Smart Code: See "Working With Smart Codes " for more detail.
Open Group Manager: Open the Group Manager for Codes. See "Working With Groups" for more detail.
Change Color: Select a color for one or more selected codes.
Merge Codes: See "Merging Codes ."
Split Code: See "Splitting A Code ."
Open Network: Open a network on the selected code. See "Opening A Network On One Or More Entities."
Code Tree: See the chapter on "Working With Networks."
Word List: See "Word Lists."
Report / Excel Export: See "Creating Reports."

**Tools tab**

Import Codebook: A codebook can be imported in two formats: Excel and the QDPX exchange format. See "Importing A List Of Codes."
Export Codebook: A codebook can be exported in two formats: Excel and the QDPX exchange format. See "Exporting The Codebook for Use In Another ATLAS.ti Project"
**Merge Codings:** See “Creating Word Clouds And Word Lists.”

**Find Redundant Codings:** See “Finding Redundant Codings.”

---

**Memo Manager**

The Memo Manager is used to keep track of your writing. You can create, read and review, comment, sort and organize, and group your memos. Further options are to view a memo and its connection in a network, or to turn a memo into a document for further analysis.

*Figure 40: Memo Manager*

**Single-click** selects a memo. The content and if available comment of the memo is displayed in the bottom pane of the window.

**Multiple Selection:** You can select more than one memo at a time holding down the Ctrl or Shift-key for bulk deletion, to attach all selected memos to a data segment, to open a network on them, to create a report, to assign them to a memo group or remove them, or to create a memo group containing the selected memos.

**Double-click** opens the memo editor as floating window. This window can be docked into the currently active region.

**Ctri + Double-click** opens the list of linked quotations.

**Drag & Drop:** You can attach a memo to a data selection (“memoing”) by dragging it into the document pane.

**Filter:** Click on one or more memo groups in the side panel to set a local filter. This means only the items in the manager are filtered. If you set a global filter, all project items are effected (version 8.1 and higher). See “Applying Global Filters For Data Analysis.”

**Status Bar:** The Status Bar shows how many memos there are in the project.

**Memo Manager Columns**

The information provided for each memo consists of:

**Name:** Memo title.

**Type:** Memo type selected for this memo.

**Grounded:** Number of quotations to which a memo is connected.

**Density:** Number of codes and other memos to which the memo is connected.

**Groups:** This column lists all groups a memo belongs to.

**Size:** Size of content based on number of characters.

**Created By:** The name of the user who created the memo.

**Modified By:** The name of the user modifying the memo.

**Created / Modified:** Date and time when a memo was created and modified (i.e. editing it, renaming it, or writing a comment).
Memo Manager Ribbon

From left to right:

Create Free Memo: Create a new memo.
New Group: Create a new memo group based on the selection you have made.
Create Smart Group: Smart Groups are a combination of existing groups using Set operators. For further information see "."
Duplicate Memo(s): Duplicate an existing memo. Maybe it became too long and you want to split it into two memos.
Convert to Document: If you want to code a memo, or create quotations to hyperlink selected passages from a memo to other data segments, you can convert a memo into a project document.
Edit Memo: Open text pane for writing the contents of a memo in a full-fledged text editor.
Rename Memo: Change the name of a selected memo.
Delete Memo(s): Delete selected memo(s).
Edit Comment: Open a full-fledged text editor for writing or editing a comment for a selected memo. See "Working With Comments And Memos."
Set Type: The default memo type is "memo". This can be changed to a user defined type. Memos types can be used to sort and organize memos.
Open Group Manager: Open the Memo Group Manager. See "Working With Groups" for more detail.
Open Network: Open a network on the selected memo(s). See "Opening A Network On One Or More Entities."
Report / Excel Export: See "Creating Reports."

Network Manager

The Network Manager is frequently used to create and open networks, to rename, comment and group them.

Single-click selects a network. The comment of the network is displayed in the pane at the bottom of the window.
Multiple Selection: You can select more than one network at a time holding down the Ctrl or Shift-key for bulk deletion, to assign them to a network group, to create a network group containing the selected memos, or to remove them from a group.

Double-click opens the network editor as a floating window. This window can be docked into the currently active region.

Drag & Drop: You can add a network as node to a network editor, or assign selected networks to a group via drag & drop.

Filter: Click on one or more network groups in the side panel to set a local filter. This means only the items in the manager are filtered.

Status Bar: The Status Bar shows how many networks there are in the project.

**Network Manager Columns**

The information provided for each network consists of:

- **Name:** Name of the network.
- **Degree:** Number of nodes in a network.
- **Groups:** This column lists all groups a network belongs to.
- **Created By:** The name of the user who created the network.
- **Modified By:** The name of the user modifying the network.
- **Created / Modified:** Date and time when a network was created and modified.

**Network Manager Ribbon**

![Network Manager ribbon](image)

Figure 43: Network Manager ribbon

From right to left:

- **Create Network:** Create a new network.
- **New Group:** Create a new network group based on the selection you have made.
- **New Smart Group:** Smart Groups are a combination of existing network groups using Set operators. For further information see "Working With Smart Codes."
- **Duplicate:** Duplicates the selected network.
- **Rename Network:** Change the name of an existing network.
- **Delete Network(s):** Delete selected network(s).
- **Edit Comment:** Open a text pane for writing or editing a comment for a network in a full-fledged text editor. See "Working With Comments And Memos."
- **Open Group Manager:** Open the group manager for networks. See "Working With Groups" for more detail.
- **Excel Export:** Exports the information displayed in the Network Manager.
Link Manager

The Links Manager lists all existing code-code links and all existing Hyperlinks (links between two quotations). It is frequently used to review, modify or comment these links. You can switch to view the list of Code Code Links and the list of Hyperlinks.

**Links Manager Columns (Code-Code Links)**

The information provided for each code code link consists of:

- **Source**: The start position of a link. This is relevant for directed (asymmetric and transitive) links.
- **Relation**: Relations can be used to name a link. This is possible for code-code links and for hyperlinks. See the section on "Relations" for more detail.
- **Target**: The end position of a link.
- **Created by**: The name of the user who created the link.
- **Modified by**: The name of the user modifying the link.
- **Created / Modified**: Date and time when a link was created and modified.

In the side panel on the left-hand side you see the list of all available relations and how often they have been used (number in parentheses). Click on one or more relations in the side panel filter the list of links.

**Links Manager Ribbon**

Figure 45 shows the ribbon for Code-Code links. They are the same for Hyperlinks.

From left to right:

- **Cut Link(s)**: Cutting the link between selected codes.
- **Flip Link(s)**: Change source and target code of selected links.
** ENTITY MANAGERS **

**Change Relation:** Change the relation of a selected link.

**Edit Comment:** Open a full-fledged text editor for writing or editing a comment for a selected link. See “Working With Comments And Memos.”

**Open Relation Manager:** You can access the Relation Manager from here, if you want to create or modify a relation. See “Creating New Relations”, and “Editing Existing Relations”.

**Filter:** You can filter links by selecting a relation in the side panel. The Filter button in the ribbon offers some additional options: you can invert the filter, or filter the links created today, created this week, created by yourself, or all links that have a comment.

**Open Network:** Open a network on the selected link(s). See “Working With Networks.”

**Excel Export:** You can export the information you see in the manager as Excel table.

---

**Links Manager Columns (Hyperlinks)**

The information provided for each hyperlink consists of:

**Source:** The start position of a hyperlink. This is relevant for directed (asymmetric and transitive) links.

**Relation:** Relations can be used to name a hyperlink. See the section on “Relations” for more detail.

**Target:** The end position of a hyperlink.

**Created By:** The name of the user who created the hyperlink.

**Modified By:** The name of the user modifying the hyperlink.

**Created / Modified:** Date and time when a hyperlink was created and modified.

In the side panel on the left-hand side you see the list of all available relations for hyperlinks and how often they have been used (number in parentheses). Click on one or more relations in the side panel filter the list of hyperlinks.

---

**Relation Manager**

The Relation Manager is used to review the properties of existing relations, to edit existing relations, or to create new relations. In the Links Manager, you can switch between relations for code-code links and relations for hyperlinks. As the column information and the ribbon options are the same for both, below you find only one description. For further information see “Working With Networks” and “Relations.”

**Single-click:** Selects a relation. Its properties and comment are displayed in the bottom pane of the window.

---

Figure 46: Links Manager for Hyperlinks
Relation Manager Columns

The information provided for each relation consists of:

- **Name:** Full name of the relation.
- **Usage:** Number of times it is used in the project.
- **Style:** Preview of line: direction, color, width and property (directed, non-directed)
- **Width:** Actual width of the line.
- **Layout:** Automatic layout direction if you open a network on an entity.
- **Short:** Short name as an alternative to the full name. You can either display full names, short names or the symbolic name for all relations in a network.
- **Symbol:** Symbolic name as an alternative to the full name. You can either display full names, short names or the symbolic name for all relations in a network.
- **Type:** The formal property of a relation: symmetric, asymmetric, or transitive. See "Relations."
- **Created By:** Name of the user who created the relation.
- **Modified By:** Name of the user who modified the relation.
- **Created / Modified:** Date and time when a relation was created and modified (i.e. editing it, renaming it, or writing a comment).

Relation Manager Ribbon

From left to right:

- **New Relation:** Select to create a new relation.
- **Duplicate Relation(s):** Duplicate a relation, e.g. if you want to create a new relation based on an already existing relation with a few modifications.
Supported File Formats

In principle, most textual, graphical, and multimedia formats are supported by ATLAS.ti. For some formats, their suitability depends on the state of your Windows system, particularly in regard to what other software is already installed. Before deciding to use an exotic data format, you should check if this format is available and if it is sufficiently supported by your Windows system.

**Textual Documents**

The following file formats are supported:

<table>
<thead>
<tr>
<th>Format</th>
<th>File Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>MS Word</td>
<td>.doc; .docx; .rtf</td>
</tr>
<tr>
<td>Open Office</td>
<td>.odt</td>
</tr>
<tr>
<td>HyperText Markup Language</td>
<td>.htm; .html</td>
</tr>
<tr>
<td>Plain text</td>
<td>.txt</td>
</tr>
<tr>
<td>other</td>
<td>.ooxml</td>
</tr>
</tbody>
</table>

**Synchronized documents**

If you have a transcript with time marks linked to an audio or a video file, you can add the two documents to your ATLAS.ti project and view the transcript in sync with the associated audio or video file. You can then also add new time marks and edit existing ones. Once full text editing for primary documents is implemented you will also be able also prepare your own transcripts directly in ATLAS.ti. - Imported transcripts can be text, rtf or doc(x) files. The format for the time stamps must be [00:00:00].

**PDF files (Text And Graphic)**

PDF files are perfect if you need the original layout. When PDF was invented, its goal was to preserve the same layout for onscreen display and in print.

If the PDF file has annotations, they are displayed in ATLAS.ti. However, they cannot be edited.

When preparing PDFs, you need to pay attention that you prepare a text PDF file and not a graphic PDF. If you do the latter, then ATLAS.ti treats it as a graphic file and you cannot search it or retrieve text.

When scanning a text from paper, you need to use character recognition software (OCR, frequently provided with your scanner) in order to create a text PDF file. Another option is to apply character recognition in your PDF reader/writer software.

When you retrieve text from a coded PDF segment the output will be in rich text. Thus, you may lose the original layout. This is due to the nature of PDF as mentioned above. It is a layout format and not really meant for text processing.

Rename Relation: Select a relation and rename it.
Delete Relation(s): Select on or more relations that you want to delete.
Line Color: Select the line color.
Line Width: Select the line width.
Line Style: Select a the line style.
Layout Direction: Select the layout direction. If you open an ad-hoc network, the layout directions are used to position the nodes in the network.
Formal Property: Select the “Formal Properties” (transitive, symmetric or assymetric).
Filter: You can filter relations based on the following options: created today, created this week, created by yourself, or all relations that have a comment. An additional option is to invert the filter.
Excel Export: You can export the information you see in the manager as Excel table.
Graphical Documents

Supported graphic file formats are: bmp, gif, jpeg, jpg, png, tif and tiff.

Size recommendations

Digital cameras and scanners often create images with a resolution that significantly exceeds the screen’s resolution. When preparing a graphic file for use with ATLAS.ti, use image-processing software to reduce the size so that the graphics are comfortably displayed on your computer’s screen. If an image does not fit into the primary pane, you can use the zoom function available via the mouse wheel or the zoom button when displaying the image using ATLAS.ti.

Audio- and Video Documents

Supported audio file formats are: aac, m4a, mp3, mp4, wav.

Supported video file formats are: 3g2, 3gp, 3gp2, 3gpp, asf, avi, m4v, mov, mp4, wmv

For audio files, our recommendation is to use *.mp3 files with AAC audio, and for video files *, mp4 file with AAC audio and H.264 video. These can be played both in the Windows and in the Mac version. More information available here.

As video files can be quite sizable, we recommend to link video files to an ATLAS.ti project rather than to import the via the Add Documents option (see “Adding Documents”).

Geo Documents

When you want to work with Geo data, you only need to add a new Geo Document to your ATLAS.ti project. This opens an Open Street world map. When you click on the option: Query Address, you can navigate to a specific region or location on the map. For more information, see “Working With Geo Docs”.

Survey Data

The survey import option allows you to import data via an Excel spreadsheet (.xls or .xlsx files). Its main purpose is to support the analysis of open-ended questions. In addition to the answers to open-ended questions, data attributes can also be imported. These will be turned into document groups in ATLAS.ti. The survey import option can also be used for other case-based data that can easily be prepared as Excel table. For further detail on how to prepare survey data, see “Error: Reference source not found.”

Reference Manager Data

In order to support a literature review, you can import collected articles from reference managers. The requirement is that you can export the data as Endnote XML file. Most reference manages offer this option in addition to RIS or RDF. For more information see “Working With Reference Manager Data.”

Evernote

If you collect and store you data using Evernote, You can directly import files and folders from Evernote. See “Bring out the best in Evernote with ATLAS.ti 8 Windows”.

Supported formats are:

<table>
<thead>
<tr>
<th>Evernote 2.x database</th>
<th>.enb</th>
</tr>
</thead>
<tbody>
<tr>
<td>Evernote exported XML data</td>
<td>.enex</td>
</tr>
<tr>
<td>Evernote database</td>
<td>.exb</td>
</tr>
<tr>
<td>Evernote data</td>
<td>.reco</td>
</tr>
<tr>
<td>Evernote handwritten notes and sketches</td>
<td>.top</td>
</tr>
<tr>
<td>Evernote for Google Androide note file</td>
<td>.enml</td>
</tr>
</tbody>
</table>

Twitter

You can collect data from Twitter searching for keywords, hashtags, users, etc. ATLAS.ti can collect tweets that are not older than one week. In order to use this option, you need to sign in with your own twitter account. See “Working With Twitter Data.”
Size Restrictions

Theoretically, size restrictions do not play a major role due to the way ATLAS.ti handles documents. However, you should bear in mind that your computer’s processing speed and storage capacity affect the performance. Excessively large documents can be uncomfortable to work with, even when you have an excellently equipped computer. The crucial issue is not always the file size, but rather, in the case of multimedia files, the length of playing time. For textual documents, the number and size of embedded objects may cause extraordinarily long load times. There is a high likelihood that if a textual document loads slowly in ATLAS.ti, it would also load slowly in WORD or WordPad.

For very long texts or multimedia files, navigation can be severely handicapped, e.g., scrolling to exact positions. We recommend making data sources as small as possible but as large as necessary without breaking passages that belong together. Even with many smaller documents, ATLAS.ti supports unified processing and fast navigation.

Adding Documents

When you add documents to a project, they are stamped with a unique ID. This ID allows ATLAS.ti to detect if documents are the same when merging different projects.

When you work in a team and want to work on the same documents, it is important that one person is setting up the project and adds all documents that should be shared. The consequence of not doing is that documents of the same content are duplicated or multiplied during the process of merging projects, and you cannot bring them together. If this happens, please contact the help desk. One of our developers may be able to rescue the situation.

All documents that you add to a project are copied, and the copies become internal ATLAS.ti files. This means, strictly speaking, that ATLAS.ti no longer needs the original files. However, we strongly recommend that you keep a backup copy of your original source files.

As audio and video files can be quite sizable, you have the option to link them to a project instead of adding them. This means they remain at their original location and are accessed from there. Preferably, these files should not be moved to a different location. If the files need to be moved, you need to re-link the files to your project. ATLAS.ti will alert you, if there is an issue and a file can no longer be accessed. You find a Repair Link option in the Document Manager under the *Tools Tab.*

How To Add Documents

To add documents to a project, click on the Add Documents button in the Home tab, or click on the dialog box launcher (drop-down arrow), or drag-and-drop them from the File Manager either onto the document display area or the ribbon.

Video Tutorial: ATLAS.ti 8 Windows-Adding Documents to the Project

If you click on “Add Documents” you can select individual files. If you want to add entire folders or link larger multimedia files (audio / video) to your project, click on the dialog box launcher and select the appropriate option.

All added or linked documents are numbered consecutively starting with D1, D2, D3 and so on.
Sort Order Of Documents

The number of a document is determined by its position in the list of documents. The default sort order is by name. Currently it is not possible to manually move the position of a document.

Renumbering All Documents

This option becomes useful after you removed one or more documents from a project. This results in gaps in the sequence of document numbers. You may remove these gaps by renumbering all documents using the Renumber Documents option.

- Open the Document Manager.
- Select the UTILITIES tab and from there: RENUMBER DOCUMENTS

Another use case is if the documents are not listed in the order you want them to be listed as by default they are sorted in alphabetical order. You can impose your own sort order by renaming the documents, then click on the NAME column in the Document Manager and as described above select the Renumber Documents option.

It is not necessary to renumber documents for ATLAS.ti. But doing so can give reports a cleaner appearance.

Loading And Navigating Documents

Loading Documents

Whenever the content of a document needs to be displayed, printed, or searched, it accesses its data source and loads the content. This request is often triggered indirectly, e.g., by displaying (or printing) a quotation. The following lists a few procedures that directly or indirectly load the content of a document:

- Activating it in the Project Explorer or the Document Manager.
- Activating a quotation in a navigator or the Quotation Manager.
- Selecting a quotation for an activated code or memo.
- Activating a hyperlink in the margin area.
- Using the Show in Document option when double-clicking on a quotation node in a network editor.

TO LOAD A DOCUMENT FROM THE PROJECT EXPLORER

- Select a document and double-click (or press Enter). It will be loaded in the next available tab of the currently active tab group.

TO LOAD A DOCUMENT FROM THE DOCUMENT MANAGER

- Open the Document Manager by either double-clicking on the main document branch in the Project Explorer. Or click on the Documents button in the Home tab.
- Double-click an entry in the Document Manager to load and display it.

Importing Multimedia Transcripts

For those users who are familiar with version 6 or 7, this option is similar to the previous A-Docs function but implemented in a different way. Currently it only has limited functionality to be extended in later versions. Basically, what you can do is to import a transcript with time stamps for an already imported audio or video file. The two documents can be opened side-by-side and when you play the audio or video file and the synchronized text in the transcript is highlighted.

Different to the previous implementation, you do not have to prepare the transcript in a specific software. Currently you can use the following format for the timestamps: $00:00:00-0$ or $00:00:00$.

- The first step is to add a multimedia file to your project (audio or video).
- Load the multimedia document and select from the Tools tab of the contextual Documents ribbon, the option IMPORT TRANSCRIPT.
Select the transcript. It will be imported into the project. You will see a new entry in the Project Explorer under the Multimedia Transcripts tree (see left).

If you double-click on either the transcript or the multimedia file in the Project Explorer, the documents will be opened side-by-side.

To play the document and view the transcript at the same time, activate **Synchronized Scrolling** in the Tools tab and play the multimedia file.

You can also move the playhead to a different position and start to play the document from there.

Currently time stamps are not visible. This will change as soon as text editing becomes available. The Mac version offers some more advanced functionality like being able to see the time stamps, using them to navigate through the document and being able to edit existing time stamps or create new ones.

To remove a document from a project that is linked to either a multimedia file or a transcript, delete the association first. You can delete an association in the Multimedia Transcript section of the Project Explorer. Right-click and select **DELETE**. This will only remove the association, not the document from your project.
Renaming Documents

Select a document and either select the Rename button in the ribbon, or right-click and select the Rename option from the context menu, or press F2. In-place rename is not yet implemented.

Renaming a document in ATLAS.ti does not change the name of the original source file. As described above under “Adding Documents” documents are copied into the ATLAS.ti library when adding them to an ATLAS.ti project, and ATLAS.ti no longer needs the original source files.

Deleting Project Documents

If you accidentally have added documents or want to remove them from your project for other reasons, you can remove them.

Deleting A Single Document

Select a document in the Project Explorer or the Document Manager, right click and select the Delete or the Delete Document(s) option from the context menu.

Deleting Multiple Documents

Select multiple documents in the Project Explorer or the Document Manager and select the Delete Document(s) option from the context menu, or the ribbon in the Document Manager.

If you delete a document by mistake, you can always use the Undo option in the Quick Access tool bar.

After deleting documents, the consecutive numbering may be off. To renumber documents in consecutive order again, select the Utilities tab in the Document Manager and the Renumber Documents option (see “Renumbering All Documents”).

Duplicating Documents

If you need a document for different purposes, e.g. you want to view it from different angels and want to code different aspects; or if you want to associate it with different transcripts, you can duplicate a document. All work that you have done so far in the document, like the document comment you have written, all quotations and their comments, all hyperlinks, all linked codes and memos will be duplicated as well.

Open the Document Manager and select one or more documents that you want to duplicate.

Click on the Tools tab and select Duplicate Document(s)
The duplicated document(s) will be added at the end of the list of documents. They have the same name as the original document(s) plus a consecutive number in parentheses.

In terms of project size, the file(s) in the library are not duplicated. The duplicated document uses the same source file as the original document.

### Saving A Project

- To save a project, click on the Save icon in the Quick Access tool bar (see left), or select **FILE / SAVE**.

The project is saved as internal ATLAS.ti file in the Windows application folder called AppData roaming on your computer. For further information, see “Where Does ATLAS.ti Store Project Data?”.

### Password Protection

- To set a password for your project, you need to load it first.

- Select **FILE / INFO**.

- Click on on the **SET PASSWORD** button and follow the instruction on the screen.

Please note that ATLAS.ti Scientific Software GmbH does not save your passwords. We cannot access, read or recover your password. If you cannot remember your password, you can no longer access your project!

### Creating Project Backups

- To create a backup of your project, select **FILE / EXPORT**.

This creates a project bundle file which contains all documents that you have added or linked to a project and the project file that contains all of your coding, the codes, all memos, comments, networks and links. Therefore, a project bundle file serves as external backup of your project independent of the ATLAS.ti installation on your computer.

In addition, project bundle files are used to transfer projects between computers. They can be read by both ATLAS.ti 8.1 and higher for Mac and Windows.
Please export your projects on a regular basis and store the bundle files in a safe location. In case something happens to your computer, you still have a copy of your project to fall back on!

Click on the **PROJECT BUNDLE** button. This opens the Windows File Manager. Select a location for storing the project bundle file. The default name for the bundle will be the project name plus the name of the currently logged in user and the date: "project name (user name YYYY-MM-DD).

The default name of the bundle is the project name. You can rename the bundle file at this stage. However, please note – renaming the bundle does not automatically change the name of your project. Think of the project bundle file like a box that contains your project. Putting a different label on the outside of the box does not change anything that is inside, which is your project with all your coded segments, comments, memos, networks, etc. and all of the documents that have been added to it.

The project bundle file can be used as project backup and to transfer your project to a different computer. It can be read by both ATLAS.ti 8 Windows and ATLAS.ti Mac.

Please note: ATLAS.ti 8 and ATLAS.ti for Mac projects cannot be used in ATLAS.ti 7.

**Video Tutorials:**
- ATLAS.ti 8 Windows - Exporting the Project
- ATLAS.ti 8 Windows - Transfer from ATLAS.ti 7 to ATLAS.ti 8

**Creating A Snapshot**

You may want to create a snapshot:
- to preserve certain stages of your project to review them later.
- as backup of your project file.
- as fall-back version before a merge, in case something turns out differently than you expected and you have already saved the merged project.
- as a copy of your project that you want to use as template for another project.

When creating a snapshot, ATLAS.ti automatically adds the following to the project name: (Snapshot YYYY-MM-DD hh:mm:sec). You can, however, also enter any other name.

To create a snapshot, select **FILE > SNAPSHOT**.
Accept the default name or enter another unique name, and click Create Snapshot.

Just like ATLAS.ti project files, snapshots are saved internally in the ATLAS.ti environment. A snapshot has the same ID as the project from which it is created.

**Pin To Favorites**

We recommend that you pin all projects on which you are currently working to the Favorites list:

- Right-click on a project in the opening screen and select Pin to Favorites (see Figure 67).
- Or move with the mouse over a project name in the side panel on the left and click on the pin icon (see Figure 65).

**Hide/ Show Projects**

If you accumulate many projects over time and if it becomes difficult to find the projects you are currently working on, you can hide all projects that you do not need at the moment.

- Right-click on a project in the opening screen and select Hide Project.

All hidden projects display an icon on the top left of the project button.

In the top left of the project button, all projects again, activate the option Show All Projects that you find above your list of project status “hidden” back to “show”.

**Deleting A Project**

You can delete projects from the opening screen, either when you start ATLAS.ti or when closing all projects.

- To delete a project, select it in the opening screen, right click and select the option Delete Project.

You will be asked to confirm the deletion as this is a permanent action that cannot be undone.

**User Accounts**

ATLAS.ti automatically creates a user account based on the name that you use on your computer.

- If you want to check under which name you are working, select the Tools & Support tab.

To create a new user account, select Manage Users. Next, click on the button New User at the left-hand side in the ribbon.

After creating a new account, select Switch User to log in using a different user name.
A reason for creating a new user account is for instance if two persons on a team have the same name. When merging projects that come from different computers and that use the same user name, the user name will be duplicated (e.g. Tom and Tom (2)). This means you can still distinguish the two users. However, it may be a bit cumbersome to always remember who is who.

Where Does ATLAS.ti Store Project Data?

ATLAS.ti projects and all documents that you add to a project are stored in the application folder on your computer. The Windows application folder is called: AppData and can be found under your user account’s home folder. Within the sub folder Roaming, you find folders from a number of different applications, also for ATLAS.ti. The AppData\Roaming folder is a hidden folder and can either be accessed by entering the full path name or by typing %appdata% into the Windows 10 search field. If the user name is “Mary,” the full path would be: c:\Users\Mary\Appdata\Roaming\Scientific Software\ATLASti.8

This default location for storing ATLAS.ti data can be changed. See below.

Working With ATLAS.ti Libraries

As explained above, the default location for ATLAS.ti project files is on the C drive. As it is not possible for all users to work on the C drive, either because there are institutional restrictions, or the C drive is already full and there is not sufficient space, there is the possibility to create a user-defined location where all of your ATLAS.ti data is stored.

For all users familiar with ATLAS.ti 7: This is NOT the same as in version 7 where you could create project-specific libraries that could be shared.

In ATLAS.ti 8, each user works within her or his own ATLAS.ti environment. Users can define where this ATLAS.ti environment is located (version 8.1 and higher). This location can be within another folder on the C drive, any other drive on your computer, a server, or an external drive. It is not possible, however, to use a cloud sharing service like Dropbox because the specific way in which such systems work can jeopardize the integrity of your ATLAS.ti library.

It is possible to work with multiple libraries. Theoretically, you could create a new empty library every time you start a new project. This, however, requires careful data management on your part as you need to keep track on your own where all of these different libraries are located.

We strongly recommend that you create project backups on a regular basis by exporting your projects (see “Creating Project Backups”).

When you start ATLAS.ti, select OPTIONS at the bottom left of your screen. If a project is already open, you need to close it. You cannot change the location of the library, if a project is currently open.
WHERE DOES ATLAS.TI STORE PROJECT DATA?

The last option under Application Preferences lets you change the library location or select a different library (Switch Library).

Open an existing library: Chose this option if you work with multiple libraries and you want to gain access to an already existing library at a different location.

Moving the library to a different location
Move the library to a different location: Chose this option if you want or need to move your current library to a different location, e.g. because you do no longer want to work on the C drive. It is possible to keep a copy of the library at the old location.

Note that the ATLAS.ti 8 library contains all of your documents plus your "project file." This is different from version 7, where only the project documents were stored in the library and the user saved the project file (HU) independently of it. In version 8, ATLAS.ti handles and manages ALL of your project-related data in the library.

Creating a new library
Create a new empty library: This option allows you to create a new library at a location of your choice. If you already have projects, none of these will be moved over into the new library. To fill this library, you either create new projects from scratch, or you import project bundle files that you previously exported from other libraries.

After you made your choice, click Next.
If you selected to open an existing library, select the location for this library.
WHERE DOES ATLAS.TI STORE PROJECT DATA?

If you selected to **move the library**, select the location where you want this library to be. You can keep a copy of the actual state of the library at the current location. Just keep in mind that this copy is not updated if you continue your work using the library at the new location.

If you selected to **create a new empty library**, select where this new library shall be created. After confirming the new location, your opening screen will be empty and you can begin to fill it with new projects.

---

**A note from the HelpDesk:** We know that your project data is very valuable to you and that you do not want to lose it. Therefore, please select a sensible location for the ATLAS.ti library. For instance: Do not store it on the desktop. You probably have a folder within your document system for the project you are currently working on where you store all project related data. If you cannot or do not want to use the ATLAS.ti default location, we recommend that you create a sub-folder for your ATLAS.ti related work within your project folder, and within this sub-folder, a dedicated folder for your library. Make sure that your project folder is included in any automated back-up routine of your computer!

---

**Working With Groups**

**Overview**

Often data come from different sources, locations, respondents with various demographic backgrounds etc. To facilitate the handling of the different types of data, they can be organized into document groups. Document groups allow quick access to subsets of your data. They can be used for analytic comparisons in later stages of the analysis, or for administrative purposes in team projects by for instance creating a group that contains all documents for coder 1, another group that contains the documents for coder 2 and so on.

Depending on your data, you may want to include a comparison of different groups based on categories such as gender, profession, age, income, location, as well as data types and sources. In ATLAS.ti a single document can be a member of multiple groups. For instance: "Gender:: female" / "Profession:: teacher" / "Age group:: 31 - 40," and so on. When querying data, you can combine the various groups as needed.

Groups can be created in two ways – you can create them in the side panel of the Document Manager, or in the Document Group Manager. Both options are explained below.

---

**Video Tutorial:** [ATLAS.ti 8 Windows: Grouping the Project Documents](#)
This allows a much more effective integration into the work flow and saves a lot of mouse movements and clicks. It is also possible to run simple AND and OR queries.

You can activate or deactivate the side panel by selecting the **View Tab** in a Manager. Click on the first button for groups to activate or deactivate the side panel.

As the mouse-clicks are the same for all actions related to the various types of groups (documents, codes, memos and networks), the description below applies to all groups.

### Creating Groups In A Manager

1. Open the Document Manager with a click on the **Documents** button in the **Home** tab.
2. Select several documents and drag-and-drop them into the side panel on the left. Use the common Windows selection technique (hold down the Ctrl- or Shift key).
3. Enter a name for the group and click **Create**.

The document groups can be used to easily access sub sets of your data. If you click on a group, only the entities that are contained in the selected group are shown in the list on the right.

![Creating document groups in the Document Manager](image)

Figure 70: Creating document groups in the Document Manager

Once a group has been set as filter, a yellow bar appears above the entity list, here: the documents. To reset the filter to see all entities again, click the **X** on the top right-hand side of the yellow bar.

![Filtering by document group](image)

Figure 71: Filtering by document group
You can also select a number of entities in a Manager, right-click and select the option **New Group** from the context menu.

![Image](image.png)

**Figure 72: Creating groups using the context menu option**

**Creating Groups In The Project Explorer**

- Select a number of entities in a branch of the Project Explorer, right-click and select the option **New Group** from the context menu.

**Creating Groups In A Group Manager**

- To open a Group Manager, select the **Home** tab. Click on the drop-down for documents, codes, memos or networks and select respective **Group Manager**.
- In the Group Manager, select the button **New Group** and enter a name.
- Next select one or more items (here: documents) on the right-hand side in the pane: 'Documents / Codes / Memos / Networks not in group' and move them to the left-hand side 'Documents / Codes / Memos / Networks in group' by clicking on the button with the left arrow (\(<\)). You can also double-click each item that you want to move.
Creating Groups in Networks

See “Creating Groups in Networks”.

Creating Document Groups in the Query Tool

You can create groups based on queries – thus based on information that you first need to code. How this works is explained in the section “Creating Document Groups From Results”.

Removing Group Members

Removing members works the opposite way as shown above:

- Select a group. In the pane 'Documents / Codes / Memos / Networks in group' select those items that you want to remove from the group and click on the button with the right arrow (\(\rightarrow\)), or double-click on each item to remove it.

Removing Items From A Group In A Manager.

- Select the group where the item should be removed from in the side panel.
- Right-click on one or more items that you want to remove and select **Remove From Group** in the context menu.
Removing Items From A Group Using The Side Panel

If you want to remove items using the side panel context menu, proceed as follows:

- Select a group in the side panel.
- Select the items that you want to remove from this group in the list of items on the right. Use the Ctrl- or Shift-key to select multiple items (see Figure 73).
- Right-click on the group in the side-panel and select the option \textbf{Remove Documents / Code / Memo / Network(s) from Group}. 

Deleting A Group

- Select a group in the group manager and click on the \textbf{Delete} button in the ribbon. In the side panel of manager, right-click and select the \textbf{Delete Group(s)} option.

Deleting Multiple Groups

Deleting multiple groups needs to be done in the side panel of a manager. Select multiple groups by holding down either the \textbf{SHIFT} or the Ctrl-key, right-click and select the \textbf{Delete Group(s)} option.
Renaming A Group

Select an entry in the side panel or the group manager, right-click and select the Rename option. Or select the Rename button in the ribbon.

Association Between List Items And Groups

If you select an item that is part of a group, the group name is highlighted. For example, we can see for example see that the document ‘case 4’ is a survey respondent. The respondent has a high-school education, has children, is male, and so on.

Setting A Local Filter

Click on a group in the side panel, to activate a local filter. The list to the right only shows the items of the selected group. A yellow bar appears on the top of the list, displaying the name of the selected group that is set as filter.

Filtering The List Based On Multiple Groups

You can make a selection combining the members of multiple groups via AND or OR.
To change the operator, you can either open the drop down menu as shown in Figure 70, or right click inside the side panel and select the option CHANGE OPERATOR from the context menu.

If you select multiple groups in the side panel and ANY is selected, any item of all selected groups are shown (think 'plus'). If ALL is selected, only the common items of the selected groups are shown (all criteria must apply).

Importing and Exporting Document Groups

You can export and import document groups based to and from Excel. Exporting the data gives you an overview of all your document groups and their members. It can also be used as a starting point to prepare an Excel file for import.

The Excel table below shows a result of exporting already existing document groups.

**Content Of A Document Group Table**

**First column:** document name. If you want to prepare a table for import, the easiest way is to export a table first. If you have not created document groups yet, the table will only show the first column with the document names.

**Second and subsequent columns:** document attributes

- **Prefix #:** attributes with two or more values
  - document groups are created based on the header name plus the cell value as in education::highschool, or gender::male.
  - if there is no entry in a cell, the document is not assigned to the group.
  - If there are multiple entries, separated by a comma, the document is assigned to two groups of the same attribute.
**No prefix:** a document group is created for all documents with a cell value of 1. See ‘survey question: bring fulfillment & purpose’ as an example.

After importing this table, the groups and assignments to document groups are as follows:

![Figure 80: Document Manager after importing document groups from Excel](image)

**Exporting Document Groups To Excel**

- Select the **Import & Export** tab and from there the button for exporting **Document Groups**.

![Figure 81: Options for importing and exporting document groups](image)

**Importing Document Groups From Excel**

In order to generate the first column with the document names, the recommendation is to export a Document Group table first, even if it does not yet contain documents. If it contains documents, you can leave them in the table. ATLAS.ti will recognize existing groups.

- After exporting the table, add document attributes in the required format. See "Content Of A Document Group Table" and Figure 79.
- Save the Excel file and close it.
- Go to ATLAS.ti, select **Import & Export** and the **Document Groups** import option.

---

**Team Work**

In the following we describe how you set up a team project when using ATLAS.ti 8 Windows exclusively. On our website, you find a document that only describes **team work**. It includes everything that is important to know in relation to teamwork.
If your team uses the Mac version, or you work in a mixed Windows-Mac team, please check our [website](#) for the instructions that fit your situation.

Each team member needs to works on his or her copy of the project. The location where the project data for each user is stored can be selected. However, this is always a personal, not a shared space (see "Where Does ATLAS.ti Store Project Data?").

The kind of team work supported is shared coding and analyzing. This means if you have a lot of data you can spread the coding work across different team members. Each team member codes parts of the data and the work of all coders is put together via merging the various sub projects.

When you first opened ATLAS.ti, you were asked to add a user name. This name will be used to "stamp" all project entries. If you want to check your user name or want to change it, see "User Accounts".

Overview Of Main Steps

1. The project administrator sets up the projects. Let’s call the project administrator "Mary," and the project "Master Project."
2. Mary adds documents to the project and possibly a list of codes.

PLEASE NOTE: When you work in a team with shared document and codes, you need to start with a MASTER project that contains all documents and codes that you want to share with the team. If all team members start independently, you end up with duplicate documents and codes after merging the projects.

Figure 82: Steps 1 and 2: Creating and distributing the Master project

3. She saves the project and exports it. This means creating a project bundle file (see Figure 82).
4. All team members import the project bundle file and begin their work.
5. To combine the work of all team members, each team member creates a project bundle file and sends it to Mary.
6. Mary merges all sub projects and creates a new Master file.
7. Mary exports the new Master file and distributes it to all team members (see Figure 83).
8. The team members continue their work.
This cycle continues. If new documents need to be added to the project, this needs to be done by Mary. A good time for doing this is after merging and before creating the new Master file.

Important To Know

- If all team members should work on the same documents, it is essential that only one person (the project administrator) is setting up the project adding all documents. Otherwise the documents are duplicated or multiplied during the process of merging. See “Adding Documents”.
- The location of where ATLAS.ti stores project related data can be determined by each user. See “Working With ATLAS.ti Libraries.”
- Document libraries CANNOT be shared. Each person always works with her/his own copy of the data set within her/his own environment of ATLAS.ti.

Our support team will reject any repair requests that are caused by attempts to share libraries.

The kind of team work supported is shared coding and analyzing. This means if you have a lot of data you can spread the coding work across different team members. Each team member codes parts of the data and the work of all coders is put together via merging the various sub-projects.

Each team member works within her or his own library folder. Each team member can set the library independently of any other team member. The library location is not set or determined by the project administrator.

Setting Up A Team Project

The instructions are organized by the various tasks involved when working as a team. Below you find operating instructions for team members as well as for the project administrator.

1. Project Administrator

Creating A Project

- If you open ATLAS.ti, select CREATE NEW PROJECT from the start window.

If a project is already open, select FILE and then PROJECT / NEW. Next, click on the option: CREATE NEW PROJECT. Enter a project name and click CREATE.
Adding Documents

The standard procedure is that documents are imported. This means a copy of the document is created, converted into an ATLAS.ti compatible format and stored in an internal library.

For audio and video files you have the option to link them to your project. This avoids file duplication and saves hard disk space, as especially video files can be quite sizable. When you link a file to a project, it is not copied and imported into the project. It remains at its source location and ATLAS.ti opens it from there when needed.

This means that the file should remain at this location. You should not rename or move it to a different folder. If this happens, the file can no longer be displayed in the project and you need to redirect ATLAS.ti to its new location. You will be prompted to do so if this happens.

To add documents, click on the Add Documents button in the Home tab, or click on the dialog box launcher (drop-down arrow).

If you click on "Add Documents" you can select individual files. If you want to add entire folders, click on the dialog box launcher. All documents that you add to a project are copied and become internal ATLAS.ti files.

If you want to analyze larger-size audio or video files, use the Add Linked Video/Audio option.

Linked files are currently automatically added to the project bundle file when exporting a project. This could mean that your exported projects are quite sizable. With future updates you will have the option to exclude video files when creating a project bundle file.

Adding Document Groups

You may also want to consider to group documents at this stage. The groups might reflect sample characteristics like demographic variables, locations, or time of data collection. They can also be used to support team work. In the latter case, you may want to create a document group for each team member and assign the documents they are supposed to code.

To add document groups, open the Document Manager with a click on the Documents button, or via the main document menu.

Select the items you want to group by holding down the Ctrl or Shift key. Drag and drop the selected items into the side panel to the left, or right-click and select New Group. See "Creating Groups In A Manager".

Adding Codes And Code Groups

If a common set of codes and code groups is to be used, they also must be added to the project at this stage. If each team member were to add codes and code groups individually to each sub-project, all codes and groups would be multiplied during the merge process because they would have different IDs. See "Merging Projects".

Importing A List Of Codes

You can prepare a list of codes including code descriptions, code groups and colors in Excel and import the Excel file. This is how you need to prepare the Excel file:

You can enter headings like Code, Code Definition, Code Group 1, Code Group 2, but you do not have to. If you do not enter headings, the columns are interpreted in the following order:

- column 1: code name
- column 2: code description (comment)
- column 3: code group
- column 4: code group
- all subsequent columns: further code groups

See also “Importing A List Of Codes.”
SETTING UP A TEAM PROJECT

If you color the code names, this color is used in ATLAS.ti as code color.

To import the Excel file, select the IMPORT & EXPORT tab and next the Import Codes button (the one with the down arrow).

**ADDING CODES MANUALLY**

To add codes, click on the NEW ENTITIES button in the HOME tab and select NEW CODES from the drop-down menu.

To add code definitions or coding rules, open the Code Manager with a click on the Codes button in the Home tab.

Select a code and write a description or coding rule in the comment field below.

See also “Coding Data”.

**CREATING CODE GROUPS MANUALLY**

To add groups, open the Code Manager with a click on the CODES button in the HOME tab.

Select the items you want to group by holding down the Shift or Ctrl-key. Drag and drop the selected items into the side panel to the left.

Enter a name for the group.

**Adding code descriptions or coding rules**

**Creating a group in a manager**
### Saving The Project

To save a project, click on the Save icon in the Quick Access tool bar (see left), or select **File / Save**. The project is saved as internal ATLAS.ti file in the application folder on your computer. See "Where Does ATLAS.ti Store Project Data?".

It is possible to change the default location where ATLAS.ti stores project data. For more information see "Working With ATLAS.ti Libraries?".

### Exporting The Project For Distribution

To export the project for distribution to all team member, select **File / Export**.

Click on the **Project Bundle** button. This opens the Windows File Manager. Select a location for storing the project bundle. The default project bundle name consists of the project name plus the author and date in parentheses behind it, e.g., "Project X (Mary 2017-09-27)".

Distribute the project bundle file to all team members, e.g. via email, a folder on a server that everyone can access, or also via a cloud link or cloud folder.

The project bundle file has the file extension ".atlproj" and can be read by both ATLAS.ti 8.1 and higher for Windows and Mac.

Project bundle files can be shared via a cloud services like Dropbox, OneDrive, GoogleDrive, etc. Another option is to upload the project bundle file to a server of your choice and send a link to all team members so that they can download the file.

The default name of the bundle is the project name + author and date. Renaming the bundle does not change the name of the project contained within the bundle. Think of the project bundle file as a box that contains your ATLAS.ti project plus all documents that you want to analyze. Putting a different label on the outside of the box will not change the name of the project file, which is contained inside the box.

### 2. All Team Members

It is recommend that all team members save a copy of the project bundle file on their computer, or their personal space on a server.
Importing The Master Project And Renaming It

> Open ATLAS.ti and select the **Import Project** button. If another project is currently open, select **File/New** and then the Import Project Bundle option.

During the process of importing the project, the name of the project can be changed:

- Rename the project by adding your name or initials to the project name. This is important for the project administrator later when he or she merges the projects of all team members (see Figure 84).
- Click **Import**.

### Renaming Projects On The Opening Screen

If you want to rename a project after it is imported, you can either do it on the opening screen when starting ATLAS.ti. If the project is already open, you need to close it to return to the opening screen.

- On the opening screen, right click on the project that you want to rename and select **Rename Project**.

![Figure 93: Renaming a project file during the process of importing a project bundle](image)

**Figure 93:** Renaming a project file during the process of importing a project bundle

- Rename the project by adding your name or initials to the project name. This is important for the project administrator later when he or she merges the projects of all team members (see Figure 84).
- Click **Import**.

### Exporting Sub-Projects For The Project Administrator

After an agreed period of time, i.e., when everyone has done some work on the project, team members create their own project bundle file and send it to the project administrator.

- To export the project, select **File/Export**, See "Exporting The Project For Distribution." The name of the exported bundle file will include the name of the currently logged in user and the date, e.g. **Project X_coder 2 (Tom 2017-09-30)**.
3. Project Administrator

Merging Projects

The Merge Tool reunites projects that were originally divided for analytical or economical reasons. It brings together the contributions of different members of a research team. Please read the section on "What You Need To Know When Merging Projects" before following the step-by-step instructions below.

Before you merge, the recommendation is that you import all project bundle files first and take a look at the projects. If a conflict arises during the process of merging, you need to decide whether to keep all changes in the Master project or whether to override them. If you do not know what is contained in the projects to be imported, you cannot make an informed decision. Principally, it is possible to merge project bundle files without importing them prior to merging.

To begin the merge process, open the Master project.

Select FILE / MERGE.

You have the option to select either a project or a project bundle file. If you have previously imported the bundle files of all team members, select MERGE PROJECT; otherwise MERGE PROJECT BUNDLE.

Select a project from the list offered by ATLAS.ti, or load a project bundle file.

If you have a long list of projects, just enter the first few letters of the project name into the Search field.

In both cases, you have the option to create a snapshot of the current project before merging. There may be times, when you want or need to go back to an older version of your project. The default name for snapshot project is: project name (Snapshot-date-time).

After selecting a project or project bundle, click on the MERGE button.

ATLAS.ti checks the two projects for identical and different items. All identical items will be merged, all different items will be added. See "Merge Strategy" on page 72 for further detail. After this process is completed, you see a Pre-Merge Summary:
If there are no conflicts, you can proceed with merging the two projects by clicking Merge.

If there are conflicts between the Master project and the project that you import, you can solve the conflict in two ways (see "Examples" on page 73).

**Keep** means, the Master project "wins" and the changes made in the project that you import will be ignored.

**Override** means, that all changes made in the project to be imported "win" and the entries in the Master project are overridden.

You currently cannot chose for each conflict how to solve it. All conflicts need to be solved by either selecting the strategy 'keep' or the strategy 'override'.

After merging, check the final merge report and the merged project for plausibility. If you are satisfied with the results, save the project. If not, you can always select Undo.

If applicable, continue with merging the next sub-project or project bundle file.

If all team members have been coding different documents, merge conflicts are unlikely to occur. A conflict could arise, for instance, if someone has modified a document or code group, or modified a comment. As project administrator, you will have to decide whether to accept this change or not.

**Housekeeping**

After merging all projects, the project administrator may need to perform some housekeeping work, such cleaning up the code list, adding or modifying code groups, adding a memo with information for the team, or adding new documents and document groups.

**MERGING DUPLICATE CODES**

You need to do some housekeeping if you find duplicate codes in the merged project. This can happen, for instance, if team members independently have added codes that have the same name. As these codes have been created in different projects, they have different IDs and therefore they are added, not merged. The naming convention for duplicate codes is as follows:

- code A
- code A (2)

Duplicate codes can be merged as follows:

Open the Code Manager. Highlight the codes that you want to merge, right click and select the Merge Codes option from the context menu, or click on the "Merge Codes" button in the ribbon.

**Distributing The New Master File To Team Members**

After all housekeeping work is done, save the Master project and export it for distribution to team members (File / Export). As before, the name of the project administrator and the current date is added to the bundle file. See "Exporting The Project For Distribution" on page 68.
4. All Team Members

Importing The Updated Master Project

Team members import the updated Master project and as before rename the project file adding their name or initials. As this is the second time round, the project name with the added coder name or initials already exists. ATLAS.ti will recognize this and will offer the following two choices:

- Keep current project as a snapshot
- Overwrite existing project

As you previously exported your project to send it to the project administrator, you already have a backup of your project. Therefore it will be OK in most cases to overwrite the existing project.

Make the appropriate choice and click **IMPORT**.

Continue the cycle of project exchange and merging between project administrator and team members as needed.

What You Need To Know When Merging Projects

The Master project is the project into which another project, called the "Import project" is merged. The Master project has to be loaded first before invoking the **Merge Project** option.

Merge Strategy

The default option is to unify all objects that are **identical** and to add all objects that do not yet exist in the Master project.

Identical Entities Explained

When an entity is created in ATLAS.ti—regardless if it is a document, a code, a quotation, a memo, a network, a group or a comment—this entity receives a unique ID, comparable to a fingerprint. When merging projects, ATLAS.ti compares the IDs of the various entities. If they have the same ID, they are unified. If the ID is not the same, they are added. Thus, the name of an entity is not the decisive factor. If Tom has created a code with the name "sunshine" and Anne also has created a code with the same name in her project, these two codes are not identical as they have different IDs. If you merge Tom's and Anne's project, the merged project will contain two codes: **sunshine** and **sunshine (2)**. If the meaning of both codes is the same and you want to keep one sunshine code only, you can merge the two codes manually (see "Merging Duplicate Codes").
WHAT YOU NEED TO KNOW WHEN MERGING PROJECTS

Identical entities are unified, all others are added.

**Examples**

**Groups are additive:** Group B with documents \{1, 2, 3\} in the Master project merged with Group B' with documents \{3, 4\} in the Import project will result in Group B = \{1, 2, 3, 4\} in the merged project.

![Figure 99: Merge example 1: Added elements to groups](image)

**Entities with and without comments:** If there is a code C in the Master project that has no comment, and a code C in the Import project that has a comment, the merged procedure will add this comment to the merged project.

![Figure 100: Merge example 2: Entities with comments, no conflict](image)

In the case of an unsolvable conflict—code C in the Master project has a comment, and code C in the Import project also has a comment—the user can define which of the two conflicting entities will win. If the comment of the Master project should be kept, you need to select the option "Keep." If the comment of the Import project should be kept, you need to select the option "Override," as shown in Figure 99.
WHAT YOU NEED TO KNOW WHEN MERGING PROJECTS

The decision which changes to keep can currently be taken only for all entities.

How deleted entities are handled: It is not possible to "subtract" entities. If one team member has deleted a code or some codings, and these entities still exist in another project, the merged project will contain those codes or codings again.

If you want to clean up a project, this is best done in a “fresh” Master project after merging and before distributing the new Master file to all team members.

Exploring Data

Creating Word Clouds And Word Lists

In the following the focus is on exploring document content using the word cloud and word list tools. However, these tools can also be applied to quotations and codes. See “Exploring Coded Data.”

A quick way to get a feeling for the content of a text document is by creating a word cloud or list.
To create a word cloud or list for documents, select one or more documents e.g. in the Project Explorer or Document Manager, right-click and select the option **Word Cloud** or **Word List**. Another option is to load the document and select the **Word Cloud** or **Word List** button in the ribbon.

The word cloud or list opens in the main editor and shows the scope in the side panel:
**Setting The Scope**

If you created a word cloud for a document, the scope will list the documents and the selected document(s) will be checked. You can check more documents or change the scope to document groups, codes or code groups.

![Figure 106: Changing the scope for word clouds or word lists](image)

**World Cloud Ribbon**

The Word Cloud ribbon provides several options:

- **Show Scope:** You can activate or deactivate the side panel that allows you to select the scope.
- **Spiral:** Display of the words in a spiral as shown in Figure 103.
- **Typewriter:** Display of words from left to right. You can select whether to list the words in alphabetic order, by frequency of occurrence of by word length in either ascending or descending order.
- **Sorting:** The word cloud can be sorted in alphabetical order, by frequency or word length.
- **Threshold:** My moving the slider from left to right, you can determine that for instance only words with a frequency of at least 10 should be displayed. The number of the left-hand side shows the lowest, the number on the right-hand side the highest occurring frequency.
- **Exclude:** You can exclude single character words, numbers, hyphens and underscores. These options are activated by default.
- **Stop / Go Lists:** To exclude particular words, you can select stop lists. If only certain words should be displayed, you can create a Go List. See Stop And Go Lists.
- **Export:** You can save a word cloud as graphic file (.jpg).

**Stemming** is the process of reducing inflected (or sometimes derived) words to their word stem, base or root form—generally a written word form. The stem need not be identical to the morphological root of the word; it is usually sufficient that related words map to the same stem, even if this stem is not in itself a valid root. *(Source)*

**Filter Tab:** In this section you can enter special characters that you do not want to be counted and displayed in the word cloud. Another option is to reduce the words to their stem. For this to work, it is necessary to select a language. Currently, German, English and Italian are supported.

![Figure 108: Word cloud filter tab](image)
Stop And Go Lists

Stop words are words which are filtered out when processing natural language data (text). You can find commonly used stop lists for various languages here: https://www.ranks.nl/stopwords. ATLAS.ti includes the stop word list for English, German, French, Portugese, Spanish and Chinese.

In contrast, if you set a word list as Go List, then only the words that are included in the list are counted.

In addition to importing already existing lists, you can also create and build your own stop and go word lists.

Creating Word Lists

- Click on the Edit button next to the ‘Exclude’ or ‘Only’ field.
- Click on the button New Word List.
- Enter a name for the list and select as list type: Stop or Go List. You can always change it later. In the comment field, you can write a description for the list. Click on the button Create.

To add words to the newly created list, click on the New Word button a few times. Every time you click a new field is added where you can enter a word.

Enter words or expressions that you do not want to be included in the word cloud. If you enter a regular expression, you need to tick the Regex box. Optionally you can write a comment that explains the regular expression.

Importing And Exporting Existing Word List

Importing a user defined list is currently not directly supported. A work around is to export an existing list and to open it in Excel. In Excel, change the name of the list, leave all the header information and replace the words. Save the list under a new name and import it.

Exporting a word list also allows you to share it with other users, or you can import it into another of your own projects.

Other options are to duplicate and delete word lists.

You can also turn a stop list into a go list by changing the Word List Type:

![New Word List](image)

Word Cloud / Word List Options

You can remove words from the current view, or exclude them permanently by adding them to a stop list. In order to do the latter, you first need to select a stop list:

- Select a stop word list in the ribbon (Figure 110).
- Right-click on a word in either the cloud or the word list and select Add To Stop List.
The Copy to Clipboard option is useful, if you want to run the auto coding tool based on some words in the word cloud. See “Auto Coding.”

Search in Context opens the Project Search and shows the selected word in its context:

Word Lists

This feature offers word “crunching” capabilities for a simple quantitative content analysis. It creates a list of word frequency counts for the selected or all or selected textual documents, codes or quotations. A stop and go word list and a list of ‘ignorable’ characters can be used to control the analysis.

To create a word list for one or more entities:

- Select one or more documents / codes / quotations in the Project Explorer or the managers and click the Word List button in the ribbon, or select the option from the context menu.
As in word clouds, you can set the scope on the left-hand side of the window. The context menu for word lists is the same as for word clouds (see Figure 112).

You can sort the table by any of the column headers by double-clicking on it. The above table is sorted by word frequency count.

**WORD LIST RIBBON**

**Show Scope:** You can activate or deactivate the side panel that allows you to select the scope.

**Show Details:** Display of the word counts of each document if you have selected multiple documents.

**Show Percent:** Display the relative frequency of each word (word count relative to the total number of words in the document / all selected documents)

**Threshold:** My moving the slider from left to right, you can determine that for instance only words with a frequency of at least 10 should be displayed. The number of the left-hand side shows the lowest, the number on the right-hand side the highest occurring frequency.

**Exclude:** You can exclude single character words, numbers, hyphens and underscores. These options are activated by default.

**Stop / Go Lists:** To exclude particular words, you can select stop lists. If only certain words should be displayed, you can create a Go List. See Stop And Go Lists.

**Excel:** You can export the results of the word list as Excel table.

There are limits in terms of how much data can be meaningfully processed, or moreover handled by and displayed in Excel. Assuming there are 2000 unique words in a document and you process 100 documents, this results in an Excel table consisting of 200,000 cells.

**Filter Tab:** In this section you can enter special characters that you do not want to be counted, or reduce the words to their stem. Another option is to reduce the words to their stem. For this to work, it is necessary to select a language. Currently, German, English and Italian are supported. See Figure 108.

**Type-Token Ratio**

The type-token ratio (TTR) is the relationship between the number of words that occur in a text and their frequencies. The number of words in a text is often referred to as the number of tokens. Several of these tokens are repeated. As we can for instance see in Figure 114, the word kids occurs 19 times.

The type-token ratio can vary between 0 and 1. The more types there are in comparison to the number of tokens (the higher the value), the more varied is the vocabulary. This means there is greater lexical variety in the text.

The type-token ratio is calculated as follows:
Type-Token Ratio = \(\frac{\text{number of types}}{\text{number of tokens}} \times 100\)

In word lists and word clouds, you find the type-token ratio in the blue status bar:

![Figure 115: Type-token ratio](image)

**Project Search**

Use the Project Search tool to search for text and patterns in all elements of your project, not only in the documents that you added. The search can be restricted to certain fields, like name, author, date, comments, and content. Search terms can contain regular expressions (GREP). See “Regular Expressions (GREP)”.

The results of the search are listed in an interactive list, where you can click on a specific hit and you will be able to see the term within its larger context. See Figure 11b.

All entities that do not include the search term are grayed out.

If you only want to search for instance the comments for codes, click on Show None and then activate the entity type and elements you are interested in, e.g. code and comment.

Another option is to only display the first hit per entity in the result window.

**Refining A Search**

If you want to refine an existing search, click on the **Search** tab in the **Text Search Result** window and enter a modified search and press Enter, or the Search icon.
Working With Quotations

The quotation level in ATLAS.ti is a unique feature, which not only facilitates interpretive approaches much better than other programs, but also adds functionality that is interesting for a broad range of analytical approaches like working with hyperlinks.

In the majority of cases, creating quotations is part of a higher-level procedure like coding or writing memos. However, you can also create and work with quotations without having to apply codes.

Before a quotation can be created, an appropriate selection must exist.

Selecting Text Segments

In addition to the usual selection techniques known from text editors and word processors, ATLAS.ti offers an extended “semi-automatic” double-click selection technique for textual primary documents. Here is how it works:

Double-click selection sequence:

1. Double-click to select the word (assuming it is not yet selected).
2. Double-click on the selection to expand it to the sentence embedding the current selection.
3. Double-click on the selection to expand it to the full paragraph surrounding the selection.
4. Double-click again to select the complete text.
5. Double-click once more to deselect the selected area.

Creating Free Quotations

Highlight a passage that you find interesting—just like marking something with a highlighter when you read a journal article.

After highlighting something in the document, several buttons in the ribbon have become active. Select the first option: CREATE FREE QUOTATION. Or right-click and select this option from the context menu, or use the short-cut Ctrl+H.

If you accidentally select a section for which a quotation already exists, the Create Free Quotation command will be grayed out in the ribbon, and it is not included in the context menu.

If you open the Quotation Manager, you will now see a first entry. In the Project Explorer in the navigation panel, you can see the quotation if you open the branch of the document you are currently working on.
If you click on the quotation in the Quotation Manager, you can preview the content in the Preview area. Next to this area, you see a comment field. Write some text into the comment field.

Please note on your screen, as soon as you work inside the Quotation Manager, the active tab in the ribbon changes to QUOTATIONS. See also “Quotation Manager Ribbon.”

**Quotation ID:** Each quotation has an ID which consists of the document number and a number that indicates the chronological order when a quotation was created. For example, quotation 1:4 in Figure 121 was created after quotation 1:3, and quotation 1:3 after quotation 1:2 and so on. Further towards the right, you find two columns with the start and stop position for each quotation indicating the sequential order of the quotation in the document.

If you want to close gaps or reorder all of your quotations in sequential order, click **RENUMBER QUOTATIONS**.

**Quotation Name:** By default, the quotation name consists of the first 60 characters of textual quotations (document name for all other document types).

**Density:** The density is still 0 for all quotations as “Density” indicates the number of codes linked to a quotation.
Search: When the list of quotation gets longer and longer and you are looking for a particular quotation—a fully coded project may have hundreds, if not thousands of quotations—you can use the search field on top of the quotation list.

Search & Filter Tab

If you want to create a more elaborated search term or want to specify where you want to search (quotation name, content or comment), you find further options under the Search & Filter tab. Here is it possible to use regular expressions in your search term (Grep), or set it to case-sensitive. Further you can filter by author (created by), or other criteria like “today”, “this week”, “only mine”, “commented”, or “hyperlinked” quotations.

If a global filter was set, you can remove it: or – if you select one or more codes in the side panel of the Quotation Manager, you can set these codes as global filter.

View Tab

Several view options are available: If for instance you want to save screen space and you are not yet coding your data, you can hide the ‘Codes’ column in the Quotation Manager: Select View and deactivate Codes.

Activating and Displaying Quotations

Quotations can be activated and displayed in context by double-clicking on an entry in the Quotation Manager, by clicking on the quotation bar in the margin area, or by double-clicking on the quotation in the sub branch of Documents in the Project Explorer:

If you select a quotation in the Quotation Manager, you see a preview of the quotation in the panel below the quotation list as shown in Figure 121. Previews are currently available for text, PDF and image quotations. Audio and video previews will follow.

Once you have coded data, quotations can also be retrieved via their codes (see “Retrieving Coded Data”). Quotations can also be activated when included in networks (see “Working With Networks”), or from the result list of a project search (see “Project Search”).

Video Tutorial: [ATLAS.ti 8 Windows-Creating Quotations]
Modifying Quotation Boundaries

Modifying the length of a quotation is easy. Select the quotation by clicking on the quotation bar or code in the margin area and move the "handle" in form of a little orange circles to the right, to the left, or up or down, depending on whether you want to shorten or lengthen the quotation. This applies to all media types.

Renaming Quotations

You can rename quotations, either by clicking on the Rename Quotation option in the ribbon of the Quotation Manager, or by right-clicking and selecting the Rename option from the context menu.

Deleting Quotations

To delete a single quotation, right-click on a quotation and select the Delete option from the context menu.

Creating Graphical Quotations

Selecting graphical segments differs from the operations required for selecting segments within textual documents. However, the overall look and feel is sufficiently similar.

Move the mouse pointer to the upper left corner of the rectangular section that you are going to create.

Drag (holding down the left mouse button) the mouse to the lower right corner of the rectangle. Release the mouse button. You have now created a selection and the rectangle will be highlighted.
WORKING WITH QUOTATIONS

You can preview graphical quotations in the Quotation Manager; they can be inserted into networks, and they are included as graphical snippets in reports.

To modify an image quotation, just re-size the rectangle.

Creating PDF Quotations

A text PDF file can contain images as well, like picture, graphs or tables. In ATLAS.ti you can select and code both text and images within the same document without having to change the coding mode.

**Text selection:** Select the text just like you do in a Word file. The double-click selection sequence as was explained for text files (“Selecting Text Segments”) can only be used for a word (first double-click) and the line (second double-click). In technical terms, there are no computer-recognizable paragraphs in PDF documents. This also has an effect on the auto coding function. A match cannot be extended to a paragraph or chapter because of this limitation. See “Auto Coding.”

**Selecting a graphical element:** Like selecting an area in a graphic file, draw a rectangular area with your mouse (“Creating Graphical Quotations”).

PDF files can be text or image files. Sometimes users accidentally add an image PDF and wonder why they cannot select or retrieve text. If this happens, you need to re-create the PDF file, e.g., by letting an OCR scanner running over your PDF image file. In a lot of PDF creators these days this is an option in the software, no additional physical scan is needed.

Creating Multimedia Quotations

See “Working With Multimedia Data.”

Coding Data

**Coding With A New Code**

Open a document and highlight a selected piece of text, a rectangular area in a graphic document, a section on the audio wave of a video or audio document, or a location in a geo document.

See “Working With Multimedia Data” and “Working With Geo Docs” for more information on working with these formats.
Next, click on the **Open Coding** button in the Document ribbon. Enter a name and click **Create Codes**. It is also possible to code a selection with multiple codes. You can enter as many codes as apply (see Figure 128). An alternative is to right-click on the highlighted section and to choose **Open Coding** from the context menu (see Figure 129), or to use the short-cut Ctrl+J. Please note that the name of the ATLAS.ti coding option for creating a new code is unrelated to the open coding process in Grounded Theory. For a translation of ATLAS.ti functions and features for use in a Grounded Theory approach, see Friese, Susanne (2016): CAQDAS and Grounded Theory Analysis.

**Code In Vivo**

Use in-vivo coding when the text itself contains a useful and meaningful name for a code. In-vivo coding creates a quotation from the selected text AND uses the selected text - trimmed to 40 characters - as the code name. If the selected text’s boundaries are not exactly what you want for the quotation, modifying the quotation’s “spread” is often the next step after creating the in-vivo code. See “Modifying The Length Of A Coded Segment.”

Select a segment in a text document. Click on the button **Code In Vivo** in the ribbons, or right-click and select the Code In Vivo option from the context menu.

In-Vivo coding can only be applied to textual primary documents.

**Display Of Coded Data Segments In The Margin Area**

The coded segment is displayed in the margin area. A bar marks the size of the coded segment (= quotation) and the code name appears next to it. When coding data in this way, a new quotation is created automatically and the code is linked to this quotation.
Display Of Coded Data Segments In The Project Explorer

Figure 131 below shows the Project Explorer in the navigation panel. The branches for Documents and Codes are expanded. Under the main Documents branch, quotations are displayed on the first level and if coded, the codes are displayed underneath. The number in parentheses behind the quotations 3:1 and 3:2 indicate their start and stop position in the document by number of characters, e.g. (46:92) or (94:362).

Under the main Codes branch, all codes are listed.

The number behind the codes (1-0) means that the code has been applied 1 time (grounded = 1) and that it has not yet been linked to other codes (density = 0). The density remains 0 until the researcher manually links codes to other codes, mostly in later stages of the analysis if relationships between codes become apparent. The density is not a value that is calculated by the software. It goes up, when the researcher begins to link codes to each other. See "Working With Networks."

Video Tutorial: Coding text documents

Applying Existing Codes

Existing codes can be applied in a number of different ways. As shown in Figure 132 you can either drag & drop a code from the Project Explorer or the Code Browser onto a highlighted data segment, or from the Code Manager. Both the Code Browser and the Code Manager allow drag & drop multiple codes. Other options are quick coding or code by list.

DRAG-AND-DROP CODING

If you want to code from the navigation panel, the recommended option is to use the Code Browser as it has a search field. If your list of codes gets longer, it is easier to enter the first letters of a code into the search field rather than to scroll the list up and down.

The advantage of using the Code Manager for drag-and-drop coding is that a) you also see the code comments (=code definitions), and b) you can quickly access codes using code groups or the search field. When using smaller screens, it is recommended to dock the Code Manager and to move it into a separate tab group. See "Working With Docked And Floated Windows" and "Working With Tabs And Tab Groups."
MORE DRAG-AND-DROP OPTIONS

• You can link one or more selected quotations from the list of quotations in the Quotation Manager to a code in the side-panel in the Quotation Manager.
• You can link one or more selected quotations from the list of quotations in the Quotation Manager to a code in Code Manager.
• You can link one or more selected quotations from the list of quotations in the Quotation Manager to a code in Code Manager.
• You can link one or more codes to a quotation in the Quotation Manager.
• You can link one or more codes to a quotation in the Quotation Browser.
• You can link one or more selected quotations from the Quotation Browser to a code in Code Manager.
• You can link one or more selected quotations from the Quotation Browser to a code in side panel of the Quotation Manager.

CODE-BY-LIST

Click the List coding button. A window opens that shows all existing codes. Enter a word or a few letters that occur somewhere in an already existing code. The list will be shortened and only shows the codes that contain the search term. Select one or more codes from the list and click the OK button.
Quick Coding assigns the last used code to the current data segment. This is an efficient method for the consecutive coding of segments using the most recently used code.

- Select a data segment.
- Right click and select **Quick Coding** from the context menu, or use the short-cut: Ctrl+L. Another option is to click on the Quick Coding button in the toolbar, but this is (admittedly) less quick.

**Creating New Codes Without Coding**

You can create codes that have not (yet) been used for coding. Such codes are called “free” codes. This can for example be useful when ideas for codes come to mind during normal coding work and that cannot be applied to the current segment but will be useful later. Sometimes you also need free codes for expression conceptual connections in networks. This is how you do it:

- In the Home tab, open the drop down menu for NEW ENTITIES and select the option New Code(s).

If the Code Manager is open, you can also create new codes there. Click on the Free Code(s) button in the ribbon of the Code Manager.
If you already have a list of codes, possibly including code descriptions and groupings elsewhere, you can use the option "Importing A List Of Codes".

**Keyboard Shortcuts For Coding**

<table>
<thead>
<tr>
<th>Coding</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Free Code</td>
<td>Ctrl+K</td>
</tr>
<tr>
<td>Open Coding</td>
<td>Ctrl+J</td>
</tr>
<tr>
<td>Quick Coding</td>
<td>Ctrl+L</td>
</tr>
</tbody>
</table>

**Importing A List Of Codes**

Importing an already existing codebook can be useful for a number of reasons:

- To prepare a stock of predefined codes in the framework of a given theory. This is especially useful in the context of team work when creating a base project.
- To code in a “top-down” (or deductive) way with all necessary concepts already at hand. This complements the “bottom-up” (or inductive) open coding stage in which concepts emerge from the data.

You can prepare a codebook including code descriptions, code groups and colors in Excel and import the Excel file. This is how you need to prepare the Excel file:

You can enter headings like Code, Code Definition, Code Group 1, Code Group 2, but you do not have to. If you do not enter headings, the columns are interpreted in the following order:

- column 1: code name
- column 2: code description (comment)
- column 3: code group
- column 4: code group
- all subsequent columns: further code groups

If you color the code names, this color is used in ATLAS.ti as code color.

To import the Excel file, select the **IMPORT & EXPORT** tab and next the import Codebook button (the one with the down arrow). Select **IMPORT FROM EXCEL**.

Select a file and activate / deactivate the option "My data contains headers".

If your project already has codes, you need to decide what ATLAS.ti should do if the list of codes in the Excel table contains codes that are already in your project. You can overwrite the existing codes, or ignore the duplicate codes, so that they are not imported again.
You also find the export / import code list options in the Tools tab of the Code Manager.

Exporting The Codebook for Use In Another ATLAS.ti Project

To export all codes with comments and groups, select the Import & Export tab and then the Export Codebook button (the one with the up arrow). Select the option Export to Excel.

Decide whether the Excel file should contain headers for codes, comments and groups, and whether to open the list in Excel immediately.
You need to use this export option if you want to use the code list with comments and groups into another ATLAS.ti project.

**For purposes of creating a codebook for a report or appendix, we recommend to use the Export option offered in the Code Manager. This export is already formatted. See “Creating A Codebook”**.

### Working With Codes

#### Modifying The Length of A Coded Segment

Modifying the length of a quotation is easy. Select the quotation by clicking on the quotation bar or code in the margin area and move the “handle” in form of a little orange circles to the right, to the left, or up or down, depending on whether you want to shorten or lengthen the quotation:

> If anything, I think what this maybe shows is that happiness isn’t everything. I have a 4-year-old daughter, and having a child has probably made me less “happy” — there are more opportunities for conflict with my wife, more financial stress, more activities that would fun but have to deferred to the future. On the other hand, I love my daughter and wouldn’t change things for anything, even if having her sometimes means less days to day: “fun” or enjoyment. Sometimes, things worth doing and having involve a lot of difficulty and effort. They don’t make us “happy” necessarily, but that doesn’t mean that we shouldn’t undertake them.

Figure 139: Modifying the length of a coded segment

#### Replacing A Code

If you want to replace a code that is linked to a data segment, you can simply drag and drop another code from either the Project Explorer, Code Browser, or the Code Manager on top of it.
**Adding, Changing And Removing Code Color**

To change the code color, select one or multiple codes in the Code Manager and click on the **CHANGE COLOR** button in the Code tab. Select one of the offered colors.

Similar, when removing code color, select one or multiple codes in the Code Manager, click on the **CHANGE COLOR** button in the Code tab and click on **REMOVE COLOR**.

Code color can also be modified in a network. See “Setting Code Node Colors”

---

**Merging Codes**

You may begin your coding very close to the data generating lots of codes. In order not to drown in a long list of codes, you need to aggregate those codes from time to time, which means merging and renaming them to reflect the higher abstract level. Another reason for merging is that you realize that two codes have the same meaning but you have used two different labels.

Currently code comments cannot be merged. The workaround is to copy all comments of the codes that you want to merge to the comment field of the code you merge all other codes into.

---

Select two or more codes in the Code Manager and click on the **MERGE** button (or right-click and select the Merge option from the context menu).

Next, select which code should be kept, in other words the target into which all other codes should be merged, and click on the **Merge Codes** button.

It is also possible to use the network editor for merging codes. This provides a visual space where you can arrange your codes, review, sort and order them and decide which ones to merge. See “Merging Codes In Networks.”
Splitting A Code

Splitting a code is necessary if you have been lumping together many quotations under a broad theme. This is a suitable approach for a first run through to get an idea about your data. At some point, however, those codes must be split up into smaller sub codes. Think of a basket full of fruit. At first it is OK to collect all kinds of fruits, but then the basket gets very full and you realize that it might be a good idea to use separate baskets for citrus fruits, apples and bananas.

Select a code that you want to split in the Code Manager and click on the **Split Code** button in the ribbon, or select the option from the context menu.

In the Split Code tool, you see the list of the quotations coded with the code.

- Click on the button **New Codes**.
- Enter as many sub codes as you need. Then click **Create**.

ATLAS.ti automatically creates a prefix that consists of the name of the code you split followed by a colon (:). See Figure 144.

After you created the subcodes, you can assign the quotations to one or more subcodes. When you select a quotation, its content is shown below the list of quotation.

Assign the quotations by clicking on the checkbox of any of the subcodes that apply. The quotation is automatically unlinked from the main code that you are splitting.

If you do not want to allow that a quotation is coded with two of the subcodes, activate the option **Mutually Exclusive**. This is a requirement for some content analysis approaches and for calculating inter-coder agreement (see "Requirements For Coding").

![Figure 143: Split Code tool](image)

![Figure 144: Enter sub codes](image)
It is recommended not to double-code with the main and the subcode as it unnecessarily takes up space in the margin. Instead, create a code group of all codes that share the same prefix. This way, you can access all data of this category on the aggregate level if required.

After you have distributed some or all of the quotations into subcodes, click on the button **Split Code**. Now the subcodes are created and the quotations assigned accordingly. It is not required that you assign all quotations to subcodes. If you are not sure what to do with a quotation, you can leave it coded with the main code and split it later. In case you are familiar with the first version of the Split Code tool, multiple rounds of splitting are now supported. You can also split quotations in already existing codes.

**Options**
- **Copy Comments**: Select if you want all sub codes to have the same comment as the code you split.
- **Copy links**: Select if you want all sub codes to inherit existing links to other codes or memos.
- **Mutually exclusive**: If activated, you can assign a quotation to only one subcode. This is a requirement for some content analysis approaches and for calculating inter-coder agreement (see "Requirements For Coding").

**Duplicating A Code**

It is also possible to duplicate a codes with all its linkages. The duplicated code is a perfect clone of the original code including color, comment, code-quotation links, code memo links and code-code links. Instead of using the splitting tool, you can duplicate a code, open it in a network ("Opening A Network On One Or More Entities"), import all neighbors or only the quotation neighbors ("Add Node Neighbors"), and cut quotations from each code, the original and the duplicate ("Cutting Links").

To duplicate a code, open the Code Manager, select one or more codes, right-click and select the **Duplicate Code(s)** option from the context menu, or select the Duplicate Code(s) button in the ribbon.

**Renaming and Deleting a Code**

Renaming and deleting codes are procedures that seem trivial, but understanding the "scope" of these operations can be a problem for new users. For both operations you must understand, that there is only ONE code object, e. g., "Happiness" in a given project, even if you applied this code many times. With the margin area switched on, you may see the code appear many times while scrolling through your document. In fact you are seeing "links" between a quotation represented by a bar and the code, represented by its name and icon.
Renaming or removing a code in the margin besides a text on real paper using an eraser and a pencil affects only one specific occurrence of a code; all other occurrences of the same code are untouched. The effect of the operation is local.

With ATLAS.ti you can do the same by cutting the link between the code and the quotation. However, you can do additional things that are not possible using traditional paper and pencil techniques.

By renaming or removing a code from an project, you are affecting every occurrence of the code throughout the entire project. The effect is global. Renaming the code will instantly change all the code "links" in the margin to reflect the new name. Deleting it will remove all occurrences in the margin (and from all other contexts in which it was engaged, like network, groups, etc.).

**Renaming a Code**

In the Project Explorer, the Code Browser, or Code Manager, right-click on a code and select the **Rename** option. In the Code Manager, you can also click the Rename button in the ribbon. In-place rename is currently not available.

**Deleting One Or Multiple Code(s)**

In the Project Explorer, the Code Browser, or Code Manager, right-click on a code and select the **Delete** option. In the Code Manager, you can also click on the Delete button in the ribbon.

To delete multiple codes, you need to make your selection in either the Code Browser or the Code Manager.

**Unlinking a Code**

This option is the reverse function of coding. It removes the links between codes and quotations. Unlike the delete function, neither codes nor quotations are removed; only the association between the code and the quotation is removed. This is done in the margin area.

To cut the link between a code and a quotation, select it in the margin area, right-click and select the **Unlink** option from the context menu.

**Writing Code Comments**

Code comments can be used for various types of purposes. The most common usage is to use them for a code definition. If you work in teams, you may also want to add a coding rule or an example quote. If you work inductively, you can use them to write down first ideas of how you want to apply this code. You can also use it to write up summaries of all segments coded with this code and your interpretation about it. There are several ways to write a code comment.

If the Code Manager is open, you can use the comment field at the bottom of the window.

In the margin area or the navigator, you can right-click on a code and select the **Edit Comment** option (Figure 149). Another option is to click on the Edit Comment button in the ribbon of the contextual Code tab.
In the margin area, you can double-click on a code to write or edit a comment. In addition you can access all quotations that you have coded with the code from there.
All codes that have a comment display a tilde (~) at the end of the code name and the code icon shows a little yellow flag.

Working With Code Groups

Code groups help in organizing codes, they make it easy to access specific codes from a long list of codes, and they allow you to create any kind of filter you need to query your data.

Code groups can be created in two ways – you can create them in the Code Group Manage, or in the side panel of the Code Manager.

To create a group in the Code Manager, click on the Home tab and open the Code Manager by clicking on the Codes button. Select a few codes and drag them into the side panel on the left-hand side.

After dropping the codes, enter a name for the code group and click on the button CREATE.

When you click on the newly created code group, only the codes from this group will show up in the list on the right-hand side. This allows you to quickly access codes in your list without having to scroll the list all the time.

To show all codes again, close the yellow pane that shows up on top of the code list when selecting a group.

For more information on how to work with groups, see "Working With Groups."

If you are interested in learning about the differences between codes, code groups and smart codes, please view this video.
Retrieving Coded Data

There are several options to retrieve quotations. In the following you will learn how to retrieve quotations of a single code. More complex retrievals are explained in the section "Querying Data." You can retrieve quotations of a single code in the Code Manager and in the Quotation Manager. First let's explore the Code Manager option:

**Simple Retrieval Using the Code Manager or Navigator**

1. Open the Code Manager.
2. Next double-click a code. A list of quotations coded with the selected code opens. If you click on the "Eye" button, you get a preview for all quotations.
3. If you want a report, click on the Export button. See Figure 151.

![Figure 151: Retrieved quotation in preview mode](image)

If you dock the quotation list, it is comfortably stored away on the right or left-hand side of your screen and you can view or read through them there:

![Figure 152: Docked quotation list with view in context](image)

If you double-click on a code in the margin area, the comment field opens. From there you can access the quotations coded with the code:

**Simple Retrieval in the Margin Area**

If you double-click on a code in the margin area, the comment field opens. From there you can access the quotations coded with the code:
Open the Quotation Manager.

Select a code in the side panel. The list of quotations only shows the quotations of the selected code. If you click on a quotation, it will be shown in the preview area. If you double-click, the quotation will be shown in the context of the document.

The yellow bar on top shows the code you have selected. In technical terms, it functions as a filter. When selecting two or more codes, this filter can be extended and you can formulate simple **AND** (**all** codes must apply) and **OR** (**any** of the codes apply) queries:

**AND:** Show quotations where **ALL** the selected codes apply.
**OR:** Show all quotations linked to **ANY** of the selected codes.
Figure 155: Simple OR query in the Quotation Manager

Figure 155 shows an OR query for two selected codes. With a click on the down arrow next to any, you can change the operator to 'all.'

Figure 156: Changing operators from ANY to ALL.

**ALL** means that two or more codes have been applied to the exact same quotation. It is a very restrictive operator. For other query option see "Querying Data".

It is of course also possible to create a report of the retrieved quotations.

You find the report options in the contextual Quotations ribbon. You can create a Text or an Excel report. For creating a text report you have the following options:

Figure 157: Creating a report for quotations

Find more detail in the section "Creating Reports".
Exploring Coded Data

To explore the words that have been used in the quotations linked to one or more codes, you can create a word list or word cloud. Word lists and word clouds have been described in detail in the section “Exploring Data.”

Creating a Word Cloud or Word List for Selected Code

Open the Code Manager and select one or more codes. If you select a code group in the side panel, you can easily select the codes that belong to one group. Click the Word Cloud or Word List button in the Code Manager ribbon.

Creating a Word Cloud or Word List for Selected Quotations

Open the Quotation Manager and select one or more quotations. If you select one or more codes in the side panel, you can easily select all quotations coded with these codes. Click the Word Cloud or Word List button in the Quotation Manager ribbon.

Creating a Codebook

To create a Code Book, open the Code Manager and click on the Report button.

Select to export all items.

Depending on how you have set up your code system, you may want to group the output by code groups. If you have written comments for your code groups, include those as well.

Select to include code comments.

The Margin Area

The margin area in ATLAS.ti is an important working space. It is not only used to display entities linked to your data like codes, memos, hyperlinks, groups or networks; it is also a space where you can interact with your data, write and review comments, link and un-link codes, move codes around, replace codes, traverse hyperlinks, and the like.
Depending on the current activity, you can set various display options.

**Margin Display Options**

To set the display options, right-click on a white space in the margin area and make your selection:

Figure 159 shows the default settings. If you only want to see an aggregated view of your coding, you may want to activate code groups rather than codes.

If you select networks, the name of the network is displayed next to quotations that are either contained in the network or if the networks contain codes or memos that are linked to the quotation.

**Margin Drag & Drop**

All objects populating the margin area (i.e., “margin entities”) support drag & drop. The bar visualize quotations segmenting the document, and - depending on the context - the objects attached to the bars represent themselves or the link with the quotation.

The effect of a drag & drop operation depends on the entities that are involved as drag sources (those that are dragged) and targets (those onto which entities are dropped).

A large variety of entities from the margin area can be dropped into the margin area. Furthermore, entities can also be dragged from other entity managers and browsers. Entities can be dragged from the margin into other windows, browsers or even other applications like Word. In the latter case, the ATLAS.ti entity lose their ATLAS.ti specific “objectiveness” but at least they render into something useful, e.g., a formatted title and rich text comment.

**Move Linked Objects**

When an entity (e.g., a code, memo, or hyperlink) is dropped on a quotation bar, a new link is created between the entity and the quotation represented by the bar. In the figure below, the code ‘historic context’ is cut from its original quotation and linked to the quotation of the target bar, coded with ‘class system’.

Figure 159: Margin display options

Figure 160: Interactive margin area

Figure 161: Moving linked entities
Replace Linked Entities

When a margin entity is dropped onto another margin entity it is replaced. It combines the operation described above with the replacement of the dropped-on entity. Three operations are accomplished at the same time: the entity is removed from its original quotation, it is linked to the target quotation, and it replaces the entity it was dropped on (the latter is cut from its quotation).

Copy Linked Objects

To keep the entity from being cut from its original place, hold down the Ctrl key when dropping. This resembles dragging entities from managers and browsers into the margin area, which does not change existing links.

Linking Quotations

Dragging a quotation bar onto another quotation bar creates a new hyperlink between the two (see "Creating Hyperlinks In The Margin Area").

Auto Coding

The Auto-Coding tool finds text passages, selects a specified amount of text (e.g., the exact match, or spread to the surrounding word, sentence, or paragraph), and codes the passages with a previously selected code.

Auto-coding allows you to quickly collect ideas that belong to a certain concept on the basis of words or patterns found in the text. It is also useful when coding structural information like speaker turns in group interviews, or other sections that can easily be identified by a text search.

The Auto-Coding tool combines the Text Search tool with an automatic segmentation and code assignment mechanism.
Opening The Auto Coding Tool

The Auto Coding Tool can be opened from the Document Manager ribbon, or via the context menu of selected documents in the Document Manager or the Project Explorer. Depending on from where you open it, you set the scope of what should be auto coded.

Auto-Coding One Selected Document

Load the document into the editor and select the Auto Coding button from the Documents ribbon.

Auto-Coding One OR Multiple Selected Document

Select two or more documents in the Project Explorer or the Document Manager, right-click and select Auto Coding from the context menu.

The Auto-Coding Dialog

In the first section, enter a word or term that you want to search for. In the second section, select how you want to code each hit.
Section 1

Search for: Enter a search term, consisting of either a string of characters, a word or multiple words, or a search term including regular expressions (GREP).

Ignore case: Deactivate this option, if you do characters to match the searched text exactly. When deactivated, you will not find ‘Love’ when you search for ‘love.’

Strategy:
Select Text if you want to find a word that contains the characters you have entered in the ‘Search for’ field, e.g. child. In addition to these five letters, ATLAS.ti will also find children, childhood, childless, childish, etc.
Select Word, if you are want to find the word exactly as entered.
Select Expression, if you want to find a sentence or paragraph that contains two words that are however not adjacent to each other, like family and love, select the option Expression. As search term you need to enter ‘family love’.

The last used search terms (up to 10) are stored. If you need a search term again, you can select it from a drop-down list.

Selecting Regular Expression allows you to build search terms using regular expressions. An example would be to search for the words ‘kid/children/youngster/minor’. The pipe | as regular expression means OR. Given the above search time, ATLAS.ti will search for any occurrences of the words in the term.

You can use all common regular expressions as supported by the Microsoft .net framework. You find an overview here in the section Regular Expressions (GREP) a few examples are provided.

Context: Here you can define the context in which an expression should occur. For example, if you only want to code a paragraph if it contains the two words ‘family’ and ‘love’, select paragraph.

Note that this option only applies if you have selected ‘Expression’ or ‘Regular Expression.’

- Word: This is useful if you look for occurrences of numbers or single letters within a word.
- Sentence: Select if the two words entered as search expression, e.g. ‘family’ and ‘love’, should occur within the same sentence. Sentence is defined as a section until the next period (.).
- Paragraph: Select if the two words entered as search expression, e.g. ‘family’ and ‘love’, should occur within the same paragraph. A paragraph is defined as a section ending with a paragraph mark.
- Chapter: Select if the two words entered as search expression, e.g. ‘family’ and ‘love’, should occur within the same chapter. A chapter is defined as lines of text until the next empty line (at least 2 paragraph marks).
- Document: Select if the two words entered as search expression, e.g. ‘family’ and ‘love’, should occur within the same document.
Section 2: Code

Select Code: Select an existing code, or create a new one by clicking on the button 'New Code'.

Expand to: When a matched string is found, the size of the segment to be coded can be specified as follows:

- The **Exact Match** only
- The **Word** surrounding the matched string
- The **Sentence** surrounding the matched string
- The **Paragraph** surrounding the matched string
- The **Chapter** (lines of text until the next empty line) surrounding the matched string
- The **Document**

Please note that ATLAS.ti cannot detect chapters in PDF documents due to the non-tagged internal structure of PDF documents. If you select to expand the match 'chapter', the entire page is coded.

Confirm matches: As it is not always desirable to let the program decide whether or not to code a given text passage, you can control the process by checking "Confirm matches." You will then be asked to confirm each match before it is coded.

Example

An example for the usage of semi-automatic coding would be to code for the concept "distress." Indications that a person might be distressed could be words like nervousness, tension, unease, edginess, etc. In order to capture this, you would do the following:

1. Open the Auto Coding tool.
2. Enter a search expression, like: nervousness|tension|unease|edginess. The pipe symbol | means that ATLAS.ti will look for nervousness OR tension OR unease OR edginess.
3. As strategy select: **REGULAR EXPRESSION**.
4. Select **DOCUMENTS** as context.
5. Create a new code with the name ‘distress’.
6. Expand each match to: **SENTENCE**.
7. Check **CONFIRM MATCHES** and click on the **START** button.

Every time the program finds a piece of text that matches your search expression, it stops the search and highlights the text it has found. You can then read the surrounding context and decide whether the text passage really has something to do with distress. If it does, click **CODE IT**, otherwise click **SKIP IT**. The program continues to search for the next match.

You can deactivate the **CONFIRM MATCHES** box at any time and let ATLAS.ti scan through the rest of your texts without prompting for further confirmation.

Brushing-Up Results after Auto-Coding

Since no automatic search can guarantee 100% meaningful results, the quotations created and assigned to the selected code during auto-coding should be screened and modified if needed. The recommendation is to always use a new code for auto-coding. If you realize that the auto coding process did not result in anything useful, you can either undo the auto coding or delete the code.
Regular Expressions (GREP)

GREP is a well-known search tool in the UNIX world. The original GREP tool printed each line containing the search pattern, hence the acronym GREP ("Globally look for Regular Expression and Print").

In ATLAS.ti, the results of a GREP search are not printed line-by-line; rather, the text matching the search pattern is highlighted on the screen, or you can automatically code the results including some surrounding context.

The core of a GREP search is the inclusion of special characters in the search string that control the matching process. GREP finds instances in your data that match certain patterns.

<table>
<thead>
<tr>
<th>GREP Expression</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>^</td>
<td>Matches an empty string at the beginning of a line.</td>
</tr>
<tr>
<td>$</td>
<td>Matches an empty string at the end of a line.</td>
</tr>
<tr>
<td>.</td>
<td>Matches any character except a new line.</td>
</tr>
<tr>
<td>*</td>
<td>Matches the preceding element zero or more times. For example, ab*c matches &quot;ac,&quot; &quot;abc,&quot; &quot;abbc,&quot; etc.</td>
</tr>
<tr>
<td>?</td>
<td>Matches the preceding element zero or one time. For example, ba? matches &quot;b&quot; or &quot;ba.&quot;</td>
</tr>
<tr>
<td>^</td>
<td>Matches a range or set of characters: [a-z] or [0-9] or [aeiou]. For example: [0-9] finds all numeric characters, while [0-9] finds all non-numeric character</td>
</tr>
<tr>
<td>(</td>
<td>Matches an empty string at a word boundary</td>
</tr>
<tr>
<td>)</td>
<td>Matches an empty string not a word boundary</td>
</tr>
<tr>
<td>&lt;</td>
<td>Matches an empty string at the beginning of a word</td>
</tr>
<tr>
<td>&gt;</td>
<td>Matches an empty string at the end of a word</td>
</tr>
<tr>
<td>\</td>
<td>The escape character disables the special GREP functionality of the following character. For example: \ matches an opening bracket.</td>
</tr>
<tr>
<td>OR, Enclose ORed expressions with parentheses if OR should be restricted to certain sequences of characters or expressions</td>
<td></td>
</tr>
</tbody>
</table>

The expression man|woman matches "man" and "woman."
You could also use (wo)man to the same effect. H(a|e)llo matches "Hello" and "Hallo." H(a|e)+llo matches "HHaaliao" as well as "HHeeeaaaaaaaaloo."
And how about the (angry|lazy|stupid) (man|woman) (walk|runn|play|fight)ing with the gr(a|e)y dog – get the idea?

<table>
<thead>
<tr>
<th>GREP Expression</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>d</td>
<td>Matches any digit (equivalent to [0-9])</td>
</tr>
<tr>
<td>D</td>
<td>Matches anything but a digit</td>
</tr>
<tr>
<td>S</td>
<td>Matches a white-space character</td>
</tr>
<tr>
<td>s</td>
<td>Matches anything but a white-space character</td>
</tr>
<tr>
<td>w</td>
<td>Matches any word constituent character</td>
</tr>
<tr>
<td>W</td>
<td>any character but a word constituent</td>
</tr>
</tbody>
</table>

These escapes are also allowed in character classes: \w\+ means "any character that is either a word constituent, or a plus, or a minus."
\w matches any whole word
\w matches whole words containing only alphanumeric characters.

Character classes can also include the following elements:

- [alnum] any alphanumeric, i.e., a word constituent, character
- [alpha] any alphabetic character
- [cntrl] any control character. In this version, it means any character whose ASCII code is < 32.
- [digit] any decimal digit
- [graph] any graphical character. In this version, this mean any character with the code >= 32.
- [lower] any lowercase character
- [punct] any punctuation character
- [space] any white-space character
- [upper] any uppercase character
- [xdigit] any hexadecimal character

Note that these elements are components of the character classes, i.e., they have to be enclosed in an extra set of square brackets to form a valid regular expression. A non-empty string of digits or arbitrary length would be represented as [\d]+.
Examples of GREP Searches

In the following, a few search examples are presented showing the matching GREP expression in the column on the right.

<table>
<thead>
<tr>
<th>Examples</th>
<th>GREP expression</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find text (of arbitrary length) enclosed within brackets. Note that the</td>
<td>[.*]</td>
</tr>
<tr>
<td>brackets have to be escaped with &quot;&quot; as they are themselves control</td>
<td></td>
</tr>
<tr>
<td>characters.</td>
<td></td>
</tr>
<tr>
<td>Find all years between 2001 and 2004:</td>
<td>200[1-4]</td>
</tr>
<tr>
<td>Find all numbers with 2 digits at the end of a line or paragraph:</td>
<td>\d\d$</td>
</tr>
<tr>
<td>Find all &quot;Meyer&quot;'s - spelled in four different ways:</td>
<td>M[a-e][i-y]er</td>
</tr>
<tr>
<td>Find all lines (paragraphs) starting with one arbitrary letter followed</td>
<td>^.[a-z]:</td>
</tr>
<tr>
<td>by a colon. If you search for a &quot;d&quot; following the colon you will have</td>
<td></td>
</tr>
<tr>
<td>to use the Escape character: ^\d. Otherwise, the letter &quot;d&quot; would be</td>
<td></td>
</tr>
<tr>
<td>interpreted as a digit.</td>
<td></td>
</tr>
</tbody>
</table>

You can test and debug any regular expression you formulate on this web site:  
https://regex101.com/

Focus Group Coding

If you work with focus group data, you cannot work with document groups when it comes to the individual speakers in each focus group. Often a focus group has a mix of male and female participants, the participants might be in different age groups and have different educational levels. Thus, often it is not possible to add an entire focus group file to a document group gender: male, or gender: female. Focus Group data need to be treated differently. Each speaker unit needs to be identified and coded. If you prepare your focus groups transcripts in a way that each speaker can easily be identified, speaker units and speaker attributes can be coded automatically by ATLAS.ti. See “Guidelines For Preparing Focus Group Data”.

This will allow for later comparisons of statements by the different speakers or speaker attributes like gender or educational level. The analysis tool that you need for such comparison is the "Code Co-Occurrence Table".

Guidelines For Preparing Focus Group Data

Requirements

There is only one requirement when preparing focus group data: Each speaker or other identifying information needs to have a unique identifier and if possible should be applied consistently throughout the entire transcript. ATLAS.ti offers two default identifiers:

Pattern 1: <speaker name:>
It could also be any other identifier. It does not have to be a name.

Pattern 2: <@speaker name:>
It could also be any other identifier. It does not have to be a name.

An example transcript following pattern 1 might look like this:

Alex: I don't know, I'm the sort, I don't really struggle making friends cos everyone tells me I've got a big mouth and I don't stop talking (laughs) …

Tom: So is that how, is that how you met just, just through you striking up a conversation?

Deb: I'm trying to think exactly (laughs) I think that's what it was, we were both in the same research methods class ...

or like this:

Alex:
I don't know, I'm the sort, I don't really struggle making friends cos everyone tells me I've got a big mouth and I don't stop talking [laughs] …

Tom:
So is that how, is that how you met just, just through you striking up a conversation?

Deb:
I'm trying to think exactly [laughs] I think that's what it was, we were both in the same research methods class

It is also possible to add further information to each speaker like their gender, age group, educational level etc. This way, also this information will be automatically coded. An Example might look like this:

Alex: gender male: age group 1: education level high school: 
I don't know, I'm the sort, I don't really struggle making friends cos everyone tells me I've got a big mouth and I don't stop talking [laughs] …

Tom: gender male: age group 1: education level some college:
So is that how, is that how you met just, just through you striking up a conversation?

Deb: gender female: age group 1: education level high school:
I'm trying to think exactly [laughs] I think that's what it was, we were both in the same research methods class …
The speaker unit of Alex will then be coded with Alex, gender male, age group 1 and education level high school. Before the data is coded, you can modify the code labels or add further codes.

An example transcript following pattern 2 might look like this:

@Alex: I don't know, I'm the sort, I don't really struggle making friends cos everyone tells me I've got a big mouth and I don't stop talking [laughs] …

@Tom: So is that how, is that how you met just, just through you striking up a conversation?

@Deb: I'm trying to think exactly [laughs] I think that's what it was, we were both in the same research methods class …

If your data is not transcribed yet, we recommend using pattern 2 as it is unlikely that this pattern will find sections that are not speaker units.

Custom Pattern
You can also define your own pattern, or use GREP expressions in case there are typos or an inconsistent use of speaker or other identifiers. For instance, the regular expression To.{m,n} matches "Toom," "Ton," or "Toon" to find different spellings of the name 'Tom'. For more information on GREP, see "Regular Expressions (GREP)".

Recommendation
For readability you may want to consider to start each speaker unit on a new line. Additionally, you may want to enter an empty line between speaker units. Both is not required. When a pattern is recognized the chosen code(s) are applied from the first letter of the pattern to the start of the next recognized pattern. Therefore it does not matter whether a new unit starts on a new line or whether there is an empty line in between.

Coding Focus Group Data

Select a focus group transcript in the Document Manager and select Focus Group Coding from the Documents ribbon. Another option is to right-click on a document in the Project Explorer and to select this option from the context menu.

Select a pattern for recognizing speaker units:
If your transcript looks as follows, select Pattern 1:

Alex: I don’t know, I’m the sort, I don’t really struggle making friends cos everyone tells me I’ve got a big mouth and I don’t stop talking [laughs]…

Tom: So is that how, is that how you met just, just through you striking up a conversation?

Deb: I’m trying to think exactly [laughs] I think that’s what it was, we were both in the same research methods class…

If your transcript looks as follows, select Pattern 2:

@Alex: I don’t know, I’m the sort, I don’t really struggle making friends cos everyone tells me I’ve got a big mouth and I don’t stop talking [laughs] …

@Tom: So is that how, is that how you met just, just through you striking up a conversation?

@Deb: I’m trying to think exactly [laughs] I think that’s what it was, we were both in the same research methods class …

Custom Pattern

If you have used a different way to indicate a speaker, enter your own pattern. You can also use this function to auto code any data that has a specific structure. So it does not necessarily have to be a speaker. It could be a date, a number, or any other type of identifier. As mentioned above, regular expressions can also be used as custom pattern. For instance:

(A-Z): only recognizes identifiers consisting of letters from A to Z.

(A-Z)+(0-9)+: recognizes identifiers that consist of a combination of letters and numbers

See "Regular Expressions (GREP)" for further information.

After selecting a pattern, click Next.

ATLAS.ti lists all speakers or identifiers that fit the selected pattern and adds the name(s) as code. These might also include items that you would not classify as speakers or identifiers but fit the pattern. If so, you can deselect them.
Select all speakers or identifiers that you want to code.

Check the suggested codes and add additional ones, if you want to code the speaker unit or section with multiple codes. If you enter multiple codes, they need to be separated by a semicolon.

As described in the section “Guidelines For Preparing Focus Group Data,” you could also add information that describe the speakers like age, gender, educational level, etc. into the transcript. Those would be picked up as identifiers and codes, and there would be no need to add attribute codes to each speaker. The Choose Coding window might then look like this:

If you enter codes that already exist in your code list, they will not be duplicated. In a future update, you will be able to select existing codes from a list.

Click on the button **Code**.

ATLAS.ti codes all speaker unit or identified sections. Once it is done, you see the summary screen:
Double-check the results in context and take a look at the Code Manager. ATLAS.ti creates a code group from all codes that have been entered in the previous step in the Coding window called "Focus Group Coding".

Finding Redundant Codings

Redundant codings are overlapping or embedded quotations that are associated with the same code. Such codings can result from normal coding but may occur unnoticed during a merge procedure when working in teams. The Codings Analyzer finds all redundant codings and offers appropriate procedures to correct it. An example of a redundant coding is shown below.

To find all redundant codings, select **Find Redundant Codings** under the **Tools & Support** tab, or open the Code Manager and select the options from the Tools tab there.
The upper pane lists all codes for which redundant codings were found. The *Redundancy* column displays the number of pairs of redundant quotations found for the codes. If you select one of the codes, the redundant quotations are listed in pairs in the middle pane. If you select a pair, you see a preview of the quotation in the bottom pane. Double-clicking on a listed quotation displays it in context.

You can correct the redundancy in the following ways:

**Unlink from Left Quotation** removes the selected code from the quotation shown on the left-hand side.

**Merge Quotations** melts the two quotations shown on the right- and left-hand side. All references to and from the merged quotation are “inherited” by the other. If the two quotations overlap, the resulting quotation includes all data from both quotations.

**Unlink from Right Quotation** removes the selected code from the quotation shown on the right-hand side.

If you hover over a quotation you see some information about the “Connectivity” of the quotation: number of connections to codes (=codings), number of connections to other quotations (=hyperlinks), and number of connections to memos (=memo links). The connectivity information provides an additional clue about the best action how to resolve the redundancy.

If you see a quotation listed more than once, it means that three or more quotations are involved in a redundant coding. You will notice, that merging one pair of quotations may have the effect that other pairs are removed from the list as well, as the redundancy assertion does not hold any longer for the remaining pairs of quotations for this code.
Inter-Coder Agreement (ICA)

Please Read This First!

Previous versions of ATLAS.ti allowed to calculate inter-coder agreement (ICA) in combination with the online tool CAT. This required a special way of merging projects and the creation of a specific text-only output. Both are no longer available in ATLAS.ti 8. Therefore, CAT can no longer be used in combination with ATLAS.ti.

Instead, we decided to develop our own inter-coder agreement tool that would be both easy to use and produce results of outstanding accuracy. To this end, we worked closely with Prof. Klaus Krippendorff, one of the leading experts in this field and the namesake of important "measurement units" in this area. ATLAS.ti's Inter-coder Agreement tool lets you assess the accuracy of how multiple coders analyze a given body of data, and thus permits you to underscore the validity of your analysis.

The need for such a tool as an integrated element in ATLAS.ti has long been evident and has been frequently requested by users. When we set out to tackle the task of designing it, it was also clear that it would have to be more than the one-dimensional and sometimes crassly simplifying attempts we found elsewhere. Rather, the ATLAS.ti inter-coder Agreement tool was supposed to be equally flexible, accurate, and able to handle the inherent complexity of the subject matter.

This also means that by necessity it requires at least a minimal willingness for the user to delve into some of the basic theoretical foundations of what inter-coder agreement is, what it does and can do, and also what it cannot do. We tried to make the tool as easy to use as possible and require only a small degree of preparation, but by its nature, it could not and cannot be a magic "just click a button and hope for the best" solution.

That said, you are probably aware of the expression, "garbage in, garbage out." If you randomly click on any of the choices that ATLAS.ti offers to calculate an inter-coder agreement coefficient, ATLAS.ti will calculate something. Whether the number you receive will be meaningful and useful depends on how you have set up your project and your coding. ATLAS.ti can only provide the technical functionality. You as the user are responsible for applying it in a meaningful and sensible way, especially if you intend to report an inter-coder agreement coefficient in a publication. Hence, we would like to lay out a few of the underlying assumptions and requirements.

If you want to develop a code system as a team, yes, you can start coding independently and then see what you get. But this approach can only be an initial brainstorming at best: a first step towards developing a code system based on which you can test inter-coder agreement. But this will be much later in the process. You first need a structured code system in which each code is clearly defined. The testing also needs to be done by two or more additional coders that are independent of the person who developed the codes. Thus, if you want to measure inter-coder agreement, you need at least three persons: One person developing and defining the codes, and two persons to apply the codes.

Please keep in mind that the inter-coder agreement tool crosses the qualitative-quantitative divide. Establishing inter-coder agreement has its origin in quantitative content analysis (see for instance Krippendorff, 2018; Schreier, 2012). If you want to apply it and want to adhere to scientific standards, you must follow some rules that are much stricter than those for qualitative coding.

Why Call It Inter-Coder Agreement Rather Than Inter-Coder Reliability?

The coefficients that are available measure the extent of agreement or disagreement of different coders. Based on this measure one can infer reliability, but the coefficients do not measure reliability directly. Therefore, what is measured is inter-coder agreement and not inter-coder reliability.

Agreement is what we measure; reliability is what we wish to infer from it.

Why Reliability Matters

The purpose of collecting and analyzing data is that researchers find answers to the research questions that motivated the study in the first place. Thus, the data are the trusted ground for any reasoning and discussion of the results. Therefore, the researchers should be confident that their data has been generated taking precaution against distortions and biases, intentional or accidental, and that the mean the same thing to anyone who uses them. Reliability grounds this confidence empirically (Krippendorff, 2004).

There are two ways to operationalize reliability, one routed in measurement theory, which is less relevant for the type of data that ATLAS.ti users have. The second one is an interpretivist conception of reliability. When collecting any type of interview data or observations the phenomena of interest usually disappears right after it has been recorded or observed. Therefore, the analyst's ability to examine the phenomena relies heavily on a consensual reading and use of the data that represent the phenomena of interest. Researchers need to presume that their data can be trusted to mean the same to all of their users. This means "that the reading of textual data as well as of the research results is replicable elsewhere, that
researchers demonstrably agree on what they are talking about. Here, then, reliability is the degree in which members of a designated community agree on the readings, interpretations, responses to, or uses of given texts or data. [...] Researchers need to demonstrate the trustworthiness of their data by measuring their reliability” (Krippendorff, 2004, p. 212).

Testing the reliability of the data is a first step. Only after establishing that the reliability is sufficiently high, it makes sense to proceed with the analysis of the data. If there is considerable doubt what the data mean, it will be difficult to justify the further analysis and also the results of this analysis.

Reliability And Validity

Whereas reliability offers the certainty that research findings can be reproduced and that no or only limited external “noise” has contaminated the data or the results, validity assures that the assertions made by the research reflect the reality it claims to represent. Validity concerns truth(s).

Reliability relates to validity in the following ways:

The more unreliable the data, the less likely it is that researchers can draw valid conclusions from the data. In terms of coding data, this means that researchers need to identify valid accounts in the data to a degree better than by chance. If the agreement of two or more coders is not better than the agreement by chance, then reliability is low and you cannot infer that a common understanding of the data exists. Thus: Unreliability limits the chance of validity.

On the other hand, reliability does not necessarily guarantee validity. Two coders may share the same world view and have the same prejudices may well agree on what they see, but could objectively be wrong. Also, if two researchers may have a unique perspective based on their academic discipline but their reading is not shared by many people outside their own scholarly community, the reliability might be high but the outcome of the research has little chance of being substantiated by evidence of the reality that is inferred. As Krippendorff (2004) states: “Even perfectly dependable mechanical instruments, such as computers, can be wrong – reliably.” (p. 213).

A third aspect is the dilemma between high reliability and validity. Interesting interpretations might not be reproducible, or interesting data may not occur often enough to establish reliability. Highly reliable data might be boring and oversimplified in order to establish a high reliability in the first place.

At What Phase In Your Project Should ICA Analysis Be Performed?

A good time to have your coding checked by other coders is when you have built a stable code system and all codes are defined. This means, this is somewhere in the middle of the coding process. Once a satisfactory ICA coefficient is achieved, the principal investigator has the assurance that his or her codes can be understood and applied by others and can continue to work with the code system.

Requirements For Coding

Sources for unreliable data are intra-coder inconsistencies and inter-coder disagreements. To detect these, we need to replicate the coding process. Replicability can be assured when several independently working coders agree on the use of the written coding instruction, by highlighting the same textual segments to which the coding instructions apply, identifying the same semantic domains that would describe them, and code them using the same codes for each semantic domain.

Development Of Semantic Domains

In developing the ICA function, it was decided to use a special name to make it clear that this type of coding is related to an ICA analysis.

A semantic domain is defined as a space of distinct concepts that share common meanings. Examples of semantic domains are emotional states, a set of strategies mentioned to deal with something, motivations for achieving something, gender biases, memberships in different, values, or genres. Each semantic domain embraces mutually exclusive concepts indicated by a code.

At the development stage of a coding instruction a semantic domain is open ended. For example, one may start with the semantic domain “benefits of friendship” by distinguishing “caring for each other” and “supporting each other” but soon discovers that there are also other aspects like “improve health and longevity” and “learning from each other”. So a code for these aspects needs to be added to the semantic domain of “benefits of friendship”. Once a coding instruction is written and used in testing its reliability, one can no longer expand a semantic domain.

All semantic domains are context dependent. The colour of a ball pen has little to do with the state of a drunk, or a political party. Semantic domains may use abstract names, but without acknowledgements of their context coding becomes unreliable.

Semantic domains are logically or conceptually independent of each other, hence freely combinable as appropriate. In a section of your data, you may find someone describing the characteristics of friendship and changes over time. As these codes come from different semantic domains, they can both be applied.
There are two requirements for developing and working with semantic domains: exhaustiveness and mutual exclusiveness.

**Exhaustiveness** means that the codes of the code system cover the variability in the data and that no aspect that is relevant for the research question is left out. On the domain level this means that all main topics are covered. On the sub code level, this means that the codes of a semantic domain cover all aspects of the domain and the data can be sorted in the available codes without forcing them. An easy way out is to include a catch all 'miscellaneous' code for each domain into which coders can add all data that they think does not fit anywhere else. However, keep in mind that such catch all codes will contribute little to answering the research questions.

**Mutual exclusiveness** affects two areas. One is the meaning of the sub codes: Each of the sub codes within each domain needs to be different and this needs to be clearly specified in the code definitions and coding rules. There should be no doubt when to apply sub code 1, 2 or 3. The second is the application of the sub code: You can only apply one of the sub codes of a semantic domain to a quotation or to overlapping quotations. Using the same code colour for all codes of a semantic domain will help you to detect possible errors. See Figure 177.

If you find that you have coded a quotation with two codes from the same semantic domain, you can fix it by splitting the quotation. This means, you change the length of the original quotation and create one new quotation, so you can apply the two codes to two distinct quotations.

If codes within a semantic domain are not applied in a mutually exclusive manner, the ICA coefficient is inflated – and in the current implementation of the tool cannot be calculated!

In version 2 of the ICA tool released with version 9, ATLAS.ti will calculate the coefficient but will indicate that there is a problem. There will also be a link to the segments in your data that are problematic.

**Multi-valued Coding**

As also shown in Figure 178, you can apply multiple codes of different semantic domains to the same quotation. This is referred to as multi-valued coding. For instance, a respondent expresses an opinion about a recent event. The semantic domain in this example is the RECENT EVENT and the various 'opinions' about the recent event are the codes of his domain. Within the same section or in an overlapping section, the respondent also talks about the people involved in the event and the consequences it had for them. The PEOPLE INVOLVED, and the CONSEQUENCES are two further semantic domains. If your coding should cover all these different aspects that are mentioned in the sentence or paragraph, you need and can apply codes from all three domains.
Coding with codes from multiple semantic domains will allow you to see how the various semantic domains are related. For example, what kind of people are involved in what kinds of events and how they experience the event. For this you can use the code co-occurrence tools at a later stage in the analysis. See "Code Co-Occurrence Tools".

Common Mistakes

A common belief is that consensus is better than individual judgment. Rather than to work independently, coders are encouraged to discuss what they code and to reach their decision by compromise. However, data generated in this way does not ensure reproducibility, nor does it reveal the extent of it. The results often reflect the social structure of the group, the most prestigious member of the group dominating the outcome. Reproducibility requires at least two independent coders.

Another common procedure is to allow coders to consult each other if problems arise, e.g. they do not understand a coding instruction, or they have problems applying some of the codes to the data given to them. This also compromises reliability. Ideally, the coding instructions should be clear and easy to understand. If this is not the case, the coders involved in the discussion create their own interpretation of what the codes mean. This is difficult to communicate to others and therefore jeopardizes reproducibility. In addition, the process loses stability as the data coded in the early phases were coded based on a different understanding of the codes. If coders do not work independently and discuss problems during the process of coding, the reliability coefficient might be higher in the end, but this is partly illusory. If the data were to be given to different coders not having the same insights, reliability is likely to be lower again. As it is common that code systems evolve, and code definitions and coding rules need to be refined, you can ask coders to write down all the issues they see with the current instructions and definitions. Based on their notes, the coding system can be refined and tested again, but with different coders.

Another common mistake is to assume that it is best to ask other experts, colleagues with a long history of involvement in the subject of the research, or close friends and associates to serve as coders. Those coders are likely to agree, but not because they carefully follow the coding instructions, but because they know each other and the purpose of the research. This also results in higher measures of reliability, but also does not serve reproducibility.

Measuring Inter-coder Agreement

Suppose two coders are given a text of a certain length and do what the coding instructions tell them to do. The simplest agreement coefficient $k_{\alpha}$ assesses the degree of agreement among these coders to decide what is relevant to a present research project. The may create so-called reliability data – complying with all the earlier mentioned condition under which they work – so that replicability can be inferred from the observed inter-coder agreement. They may give you the following record of their coding – here only which segments of text are relevant:

Evidently. The first pair of segments agree in length and location on the continuum.

The second pair agree in length but not in location. They have an intersection in common. In the third case, coder A finds a segment relevant, not recognized by coder B. the largest disagreement is observed in the last pair of segments. Coder A takes a narrower view than coder B.
In terms of your ATLAS.ti coding, you need to think of your document as a textual continuum. Each character of your text is a unit of analysis for ICA, starting at character 1 and ending for instance at character 17500. For audio and video documents, the unit of analysis is a second. Images can currently not be used in an ICA analysis. The quotation itself does not go into the analysis, only the characters or seconds that have been coded. If you add multiple documents to the analysis, the continuum is extended like pearls strung on a chain. Thus every character or second where coders agree go into the calculation of the ICA coefficient.

According to Krippendorff (2019), the simplest inter-coder agreement coefficient is:

\[
\alpha = 1 - \frac{D_o}{D_e}
\]

It is a measure of the extent to which data can be trusted to represent the phenomena of analytical interest that one hopes to analyze in place of the raw phenomena.

When coders pay no attention to the text, which means they just apply the codes in an arbitrary manner, their coding has no relationship to what the text is about, then the observed disagreement \(D_o\) equals the expected disagreement \(D_e\), then \(\alpha = 1-1 = 0.000\). On the other hand, if agreement is perfect, which means disagreement \(D_o = 0\), then \(\alpha = 1-0 = 1.000\). For further information on how alpha is calculated, see the appendix.

To better understand the relationship between actual, observed and expected agreement, let’s look a the following contingency table:

The matrices with perfect and expected agreement/disagreement serve only as a benchmark. In this simple example you could have worked it out in your head, but in a real example in ATLAS.ti this is no longer possible. The numbers are much higher, and often also odd since the calculation is based on the number of coded / non-coded characters / seconds. Therefore, it is good to see the perfect and expected agreements as a point of reference.

In the example above, the tables represent a semantic domain with five codes. If all coders agreed, they would have applied the semantic domain codes to 10 units each. If they had been applied randomly, they would have been evenly distributed amongst 10 units each (10/5 = 2). In the observed contingency table, we can see that the coders agree in applying code 4. There is some confusion about the application of code 2 and even more for code 5. The coders have applied the latter to three different codes: 1, 3, and 5. For all codes, where there is confusion the code definition needs to be revisited. For code 5 for instance you need to ask why it was confused with code 1 and 3? Are there any overlaps in the definition? Why was it understood in different ways?

### Methods For Testing ICA

ATLAS.ti currently offers three methods to test inter-coder agreement: Simple percent agreement, Holsti Index, and two of the Krippendorff’s alpha coefficients. For scientific reporting, we recommend the later two. In version 2 of the ICA tool, planned to be released with version 9 of ATLAS.ti, all four of the family of alpha coefficients will be calculated (see “Krippendorff’s family of alpha coefficients – from the general to the specific”. You will also be able to inspect and print the coincidence matrices.

All methods can be used for two or more coders.

### Percent Agreement

Percentage Agreement is the simplest measure of inter-coder agreement. It is calculated as the number of times a set of ratings agree, divided by the total number of units of observation that are rated, multiplied by 100.
The benefits of percentage agreement are that it is simple to calculate and it can be used with any type of measurement scale. Let’s take a look at the following example: There are ten segments of text and two coders only needed to decide whether a code applies or does not apply:

<table>
<thead>
<tr>
<th>Segments</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coder 1</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Coder 2</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

Table 1: Coding of two coders

Percent Agreement (PA) = number of agreements / total number of segments

PA = 6 / 10
PA = 0.6 = 60%

Coder 1 and 2 agree 6 out of 10 times, so percent agreement is 60%. One could argue this is quite good. This calculation, however, does not account for chance agreement between ratings. If the two coders were not to read the data and would just randomly code the 10 segments, we would expect them to agree a certain percentage of the time by chance alone. The question is: How much higher is the 60% agreement over the agreement that would occur by chance? Below only the results are presented if chance agreement is taken into account. If you are interested in the calculation, take a look at Krippendorff (2004, p. 224-226). The agreement that is expected by mere chance is (9.6 +1.6)/20 = 56%. The 60% agreement thus is not impressive at all. Statistically speaking, the performance of the two coders is equivalent to having reliably coded only 1 of the 10 segments, and have arbitrarily assigned 0s and 1s to the other 9 segments.

Holsti Index

Holsti’s method (1969) is a variation of percentage agreement, as percent agreement cannot be used if the coders have not all coded the same data segments. When coders were allowed to create their own quotations and did not code pre-defined quotations, the Holsti index needs to be used. Please note, that also the Holsti index does not take into account chance agreement.

The formula for the Holsti Index is:

\[
PA_{\text{Holsti}} = \frac{2A}{N_1+N_2}
\]

PA\text{ (Holsti)} represents percentage of agreement between two coders,
A is the number of the two coders’ consensus decisions, and N1 and N2 are numbers of decisions the coders have made respectively.


Cohens kappa

Cohen’s Kappa (Cohen, 1960) is another coefficient used in the calculation of ICA and offered by other CAQDAS programs. We have been asked by users why ATLAS.ti does not offer it. Kappa is a modification of Scott’s pi and according to Krippendorff (2019) and Zwick (1988) a rather unfortunate modification. There is a conceptual flaw in his calculation, as Kappa counts disagreements between observer preferences for available categories as agreements. In addition, both Cohen’s kappa and Scott’s P assume an infinite sample size. Krippendorff’s alpha coefficient is sensitive to different sample sizes and can also be used on small samples.


Krippendorff’s family of alpha coefficients – from the general to the specific

Inter-coder agreements can be measured at different levels. At the most general level, you get a value for relevance. That is, have the coders identified the areas relevant to the research question in a consensus manner? With reference to ATLAS.ti, this means agreement or disagreement at the level of the quotation, regardless of what was coded there.

At the next level, you get a coefficient for all semantic domains that are included in the analysis. This value takes into account the multiple-valued coding of codes from different semantic domains and is not just the average of the coefficients for all the semantic domains used in the analysis.

Next, you can see if encoders could identify the same semantic domain and how well they could distinguish between codes within the semantic domain.
INTER-CODER AGREEMENT (ICA)

<table>
<thead>
<tr>
<th>Relations among agreements:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>On relevant/irrelevant matter:</td>
<td>All reliability data</td>
</tr>
<tr>
<td>Uncoded matter</td>
<td>Coded matter</td>
</tr>
<tr>
<td>On all semantic domains:</td>
<td>All semantic domains</td>
</tr>
<tr>
<td>On one semantic domains:</td>
<td></td>
</tr>
<tr>
<td>On coding within that domain:</td>
<td></td>
</tr>
</tbody>
</table>

$k_{n\alpha}$ indicates the extent to which coders agree on the relevance of texts for the research project (currently alpha binary)

$s_{n\alpha}$ indicates the extent to which coders agree on the presence or absence of semantic domains, (currently Cu-alpha)

$(n_{n\alpha})$ indicates the degree to which coders identify a particular semantic domain (currently cu-alpha)

$cs_{n\alpha}$ indicates the agreement on coding within a semantic domain (currently not yet implemented)


Currently implemented are the $c$-alpha binary and the $cu$ & $Cu$-Alpha coefficients:

**Krippendorff’s $c$-Alpha Binary**

The $C$-Alpha Binary coefficient is a measure for the reliability of distinguishing relevant from irrelevant matter. It is applicable if the coders have created quotations themselves. The coefficient will tell you for each code whether the different coders have identified similar or the same areas in relation to a given meaning (code).

**Krippendorff’s $cu$-Alpha / Cu-Alpha**

The $cu_{n\alpha}$ coefficient omits all references to the gaps between valued units and assesses the reliability of coding relevant matter only. It can be used to infer the reliability of each semantic domain.

The $Cu_{n\alpha}$ coefficient with a capital C calculates the reliability for all selected semantic domains considered together.

The calculations require that codes of semantic domains have been applied mutually exclusively. This means only one of the sub codes per domain is applied to a given quotation. If this rule is violated $cu$ or Cu-Alpha cannot be calculated.

**Decision Rules**

A number of decisions have to be made when testing for inter-coder agreement. For instance, how much data material needs to be used, how many instances need to be coded with any given code for the calculation to be possible, and how to evaluate the obtained coefficient.

**Sample size**

The data you use for the ICA analysis needs to be representative of the total amount of data you have collected, thus of those data whose reliability is in question. Furthermore, the number of codings per code needs to be sufficiently high. As a rule of thumb, the codings per code should at least yield five agreements by chance. Krippendorff (2019) uses Bloch and Kraemer’s formula 3.7 (1989:276) to obtain the required sample size. The table below lists the sample size for the three smallest acceptable reliabilities $\alpha_{min}$: 0.667 / 0.800 / 0.900; for four levels of statistical significance: 0.100 / 0.050 / 0.010 / 0.005, and for semantic domains up to 10 codes (probability $p_c$).
Example: If you have a semantic domain with 4 codes and each of the codes are equally distributed, you need a minimum of 139 codings for this semantic domain if the minimum alpha should be 0.800 at a 0.05 level of statistical significance. For a lower alpha of 0.667, you need a minimum of 81 codings at the same level of statistical significance. If the frequencies across the sub categories per domain are not equally distributed, you need to increase the sample size. By 4 codes in a semantic domain, the estimated proportion $p_c$ of all values $c$ in the population is $0.250 (\frac{1}{4})$.

If the distribution of your codes in a semantic domain is unequal, you need to make a new estimate for the sample size by using $p_c$ in the formula shown in Figure 182 that is correspondingly less than $\frac{1}{4}$.

If your semantic domain has more than 10 codes, you can calculate the needed sample size using the following equation. It applies if you work with two independent coders.

You can see the corresponding z value from a standard normal distribution table. For a p-value of 0.05, $z = 1.65$.

$N_c = 2 \times Z_\alpha^2 \left( \frac{1 + \alpha_{min}}{3 - \alpha_{min}} \right) \left( 4 \left( 1 - \alpha_{min} \right) P_c \left( 1 - P_c \right) - \alpha_{min} \right)$

Figure 182: Calculating sample size if your semantic domains have more than 10 codes

### Acceptable level of reliability

The last question to consider is when to accept or reject coded data based on the ICA coefficient. Krippendorff’s (2019) recommendations are:

- Strive to reach $\alpha = 1.000$, even if this is just an ideal.
- Do not accept data with reliability values below $\alpha = 0.667$.
- In most cases, you can consider a semantic domain to be reliable if $\alpha > 0.800$.
- Select at least 0.05 as the statistical level of significance to minimize the risk of a Type 1 error, which is to accept data as reliable if this is not the case.

Which cut-off point you choose always depends on the validity requirements that are placed on the research results. If the result of your analysis affects or even jeopardizes someone’s life, you should use more stringent criteria. A cut-off point of $\alpha = 0.800$ means that 80% of the data is coded to a degree better than chance. If you are satisfied with $\alpha = 0.500$, this means 50% of your data is coded to a degree better than chance. This sounds a bit like tossing a coin and playing heads or tails.

### Setting Up A Project For Inter-coder Agreement Analysis

Before you take just any data set and run the inter-coder agreement analysis, we strongly recommend that you read the sections “Team Work” and “Please Read This First!”

You need to start from a Master project set up by the main analyst or principal investigator. The principal investigator adds all documents and codes that will be subjected to the ICA analysis to the Master project and creates sub projects based on the Master project for each coder.

To summarize the steps:

- The principal investigator develops the code system providing clear definitions for each code.
- The principal investigator creates a project bundle file for each coder that either contains only the documents to be coded and the code system, or the documents, the quotations, and the code system.
INTER-CODER AGREEMENT (ICA)

The coders import the project bundle file, rename the project file during the process of import, double-check under which user name they are logged in.

The coders code the data independently. If they have questions or difficulties applying the codes, they write notes into a memo.

Once the coders are done, they prepare a project bundle file for the principal investigator.

The principal investigator imports the project bundle files from each coder and briefly checks the work of each coder and reads the memo they have written (if any).

The principal investigator starts the inter-coder agreement mode and merges the projects of the coders.

The principal investigator runs the ICA analysis.

Merging Projects For ICA Analysis

The step-by-step instructions below start with entering the ICA mode. All other steps are covered by the instructions for team work. See “Team Work”. The following instructions assume 2 independent coders.

1. Import the project bundle files of code 1 and 2.
2. Open the project of coder 1 and create a snapshot. Do not accept the default name, enter a name that indicates that this is the project for the ICA test for coder 1 and 2.
3. Close the project of coder 1 and continue to work with the renamed snapshot.
4. Select **ANALYZE / ENABLE INTERCODE MODE**.
5. Next, merge the project of coder 2 and save the merged project.

In ICA mode, the ‘codings’ of all coders will become visible.

A coding is the link between a code an a quotation. In ICA mode, you can see which coder has applied which code to a quotation.

To see the authors of the various codings, change the view settings from icons to user in the View tab of the contextual Document ribbon:

**Figure 183: Project set-up for ICA analysis**

**Figure 184: First step in staring an ICA analysis: Enable the Intercoder Mode**

**Figure 185: View settings suitable for ICA testing**
Each coder is indicated by a different color. Hover over the user icon to see the name of the user. In Figure 186, all quotations where created by the blue user Susanne. The brown user was asked to apply the codes of the code system to these predefined quotations.

Preparing For ICA analysis

- Click on the Inter-Coder Agreement button in the Analyze tab.
- Click on the Add Coder button and select two or more coders.
- Click on the Add Documents button and select the documents that should be included in the analysis. The default option is for all selected documents to be regarded as one continuum and all coded quotations of these documents will go into the calculation. You can, however, also view agreements / disagreements per document and get a coefficient for each document.

Only the documents are shown that have been coded by the selected coders.

- Click on the Add Semantic Domain button and add one or more codes to the domain. Alternatively, you can drag and drop codes from the Project Explorer or the code list into the semantic domain field.
Repeat this process for each semantic domain.

As there currently is no function to define a semantic domain formerly, all codes that you are adding from the list will be considered to belong to a semantic domain. As you can see in Figure 187, semantic domains were already built indirectly in the process of developing the code system by adding the same prefix to all codes that belong to the same semantic domain like ACTIVITIES or BENEFITS. Please remember that all sub codes of a semantic domain (i.e., all codes with prefixes) must be applied to quotations in a mutual exclusive manner. See “Requirements For Coding”.

A semantic domain can also consist of only one code.

After you have added coders, documents and codes, your screen looks similar to what is shown in Figure 188.

The quotations of the semantic domain are displayed on the right-hand side. When you select a quotation, the full content is shown in the preview and you can write comments. You also see where the quotation is located in the document continuum. When you scroll to the right in the quotation view window, you see the codes that have been applied by the selected coders. If you click on one of the lines, only the quotations of the selected code and coder are shown in the quotation window (Figure 189).
You can remove coders, codes or documents from the analysis by clicking on the red x.

To the right of each coder line you see some descriptive statistics:

The blue coder (Susanne) has applied the code "activities clubbing / going for a drink" 11 times. The number of characters that are coded with this code are 1331 out of a total of 172,414 characters in all three selected documents, which is 0.8%.

The brown coder (Sabine) has applied the code "activities clubbing / going for a drink" 8 times. The number of characters that are coded with this code are 1057 out of a total of 172,414 characters in all three selected documents, which is 0.6%.

Calculating An ICA Coefficient

To calculate ICA, select one of the four methods from the ribbon. See "Methods For Testing ICA" for more detail

In Figure 192, the c-alpha binary for the semantic domain 'activities' is 0.983 and for the semantic domain 'benefits' is 0.937. For both domains, it is 0.949. This means that the reliability for identifying relevant from irrelevant matter related to the codes of these domain is high.

The results for cu-alpha and Cu-alpha for the two selected domains are shown in Figure 193.
The difference between the two measures is that the lower case cu-alpha applies to one semantic domain only, the capital Cu-alpha applies to all selected semantic domains. It is not simply an average of all lower case cu-alphas, as sub codes from different domains can potentially be applied to one quotation. This is referred to as multi-valued coding (see also Krippendorff et al., 2016) and “Multi-valued Coding” above.

Working With Multimedia Data

When we refer to multimedia data, we mean audio and video files. As the mouse clicks are the same for audio and video files, the difference being that there is no picture when working with audio files, below we describe all steps for both file formats together. For illustration purposes, most figures show video data.

Linking Multimedia Data to A Project

As multimedia files, especially video files can be quite sizable, it is recommend to link multimedia files to a project rather than to import them.

To link audio or video files to the project, in the Home tab click on the drop down arrow of the Add Documents button and select **Add Linked Video/Audio**.

Linked documents remain at their original location and ATLAS.ti accesses them from there. Preferably, these files should not be moved to a different location. If the files need to be moved, you need to re-link the files to your project. ATLAS.ti will alert you, if there is an issue and a file can no longer be accessed. You find a **Repair Link** option in the Document Manager under the “Tools Tab.”
Display Of Multimedia Documents

Audio wave: On the right-hand side the audio wave is displayed. You can make it smaller or wider by positioning your mouse on the left-hand side of the audio wave and dragging it either to the right-hand side or the left-hand side.

Preview images: For video files, preview images are displayed in the full preview and the margin area. When you add a new video to a project, you do not immediately see the preview images as they first need to be generated. Depending on the length of the video this may take a few seconds or up to a few minutes.

Preview images are generated from key frames. A key frame is defined as one of the frames in a video that provide the best summary of the video content. The key frame rate is a variable that you can set using most good encoding software. A fast key frame rate (with a lower number on the scale, as this refers to the interval between key frames) means that the video has more frames designated as key frames. A slower key frame rate means that fewer frames are designated as key frames.

If you've got a typical talking head video or something else with little motion, you can get away with a slow key frame rate. If you are shooting something with a lot of motion like a sporting event or a dance recital, a faster key frame rate is necessary. The standard rate is to include a key frame every 5 seconds.

Playhead: The playhead shows the current position in the video or audio file.

Full preview: Below the display area you see a preview of the entire file. You can use it to select the segment that should be displayed in the margin area.

Zoom: As the space from top to bottom of your computer screen will be too small in most cases to meaningfully display your audio or video file, especially if it is coded, you can zoom the file in the full preview section. For this you use the two orange lines that you see to the right and left of the full preview. See “Zooming the Time Line.”
**Media Controls**

If you move the cursor inside the audio or video pane, the media controls appear and you can start, stop and pause the video, skip forward and backwards. You can also start and stop the multimedia file by pressing the space bar.

From left to right:
- **Stop**: Stops the multimedia file and set the play head to the beginning.
- **Skip to previous mark**: Moves backward to the last mark, which could be the end or beginning of a selection or a section, or the beginning of the file.
- **Skip backward**: Seek backward in the multimedia file.
- **Play / Pause**
- **Skip to previous mark**: Moves forward to the next mark, which could be the end or beginning of a selection or a section, or the end of the file.
- **Skip forward**: Seek forward in the multimedia file.
- **VOLUME**: On or Off

Click the space bar to stop and start an audio or video file.

**Multimedia Toolbar**

As soon as an audio or video file is loaded, the multimedia options will be displayed in the Document tab. If you hover over each button with the mouse, a screen tip is displayed explaining each option. The options in the first sections are described above (“Media Controls”).
Capture Snapshot: If you want to analyze a particular frame in more detail, you can take a snapshot. If you click on it, the frame will be added as new document to your project as image file.

Media Controls: See "Media Controls."

Volume: Set the volume on slider between 0% (mute) and 100%

Playback Rate: If you want the video to play faster or slower, you can select a playback rate between 0.25 times the original speed to 4 times the original speed. The current play back rate is shown in the blue status bar at the bottom of the screen.

Mark Position: Sets the start position for a quotation. The short-cut key is < or ,

Create Quotation: Sets the end position for a quotation and creates a quotation at the same time. The short-cut key is > or .

You can also access the media controls with a right-click on the audio or video area (see Figure 211).

Keyboard Shortcuts For Working With Multimedia Documents

<table>
<thead>
<tr>
<th>Multimedia Documents</th>
<th>Space</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pause Play</td>
<td>Media Play Pause</td>
</tr>
<tr>
<td>Pause Play</td>
<td>F4</td>
</tr>
<tr>
<td>Play</td>
<td>P</td>
</tr>
<tr>
<td>Play</td>
<td>Shift+P</td>
</tr>
<tr>
<td>Play</td>
<td></td>
</tr>
<tr>
<td>Pause</td>
<td>Pause</td>
</tr>
<tr>
<td>Stop</td>
<td>S</td>
</tr>
<tr>
<td>Stop</td>
<td>Shift+S</td>
</tr>
<tr>
<td>Stop</td>
<td>Media Stop</td>
</tr>
<tr>
<td>Skip Back</td>
<td>Browser Back</td>
</tr>
<tr>
<td>Skip Back</td>
<td>Media Previous Track</td>
</tr>
<tr>
<td>Skip Forward</td>
<td>Browser Forward</td>
</tr>
<tr>
<td>Forward Command</td>
<td>Media Next Track</td>
</tr>
<tr>
<td>Small Step Back</td>
<td>Left</td>
</tr>
<tr>
<td>Small Step Forward</td>
<td>Right</td>
</tr>
<tr>
<td>Medium Step Back</td>
<td>Ctrl+Left</td>
</tr>
<tr>
<td>Medium Step Forward</td>
<td>Ctrl+Right</td>
</tr>
<tr>
<td>Large Step Back</td>
<td>PageUp</td>
</tr>
<tr>
<td>Large Step Forward</td>
<td>PageDown</td>
</tr>
<tr>
<td>Playback Rate Normal</td>
<td>Multiply</td>
</tr>
<tr>
<td>Playback Rate Up</td>
<td>Plus (+ key on main keyboard)</td>
</tr>
<tr>
<td>Playback Rate Up</td>
<td>Plus (+ key on numeric keyboard)</td>
</tr>
<tr>
<td>Playback Rate Down</td>
<td>Minus (- key on main keyboard)</td>
</tr>
<tr>
<td>Playback Rate Down</td>
<td>Minus (- key on numeric keyboard)</td>
</tr>
<tr>
<td>Mark Quotation Start</td>
<td>, or &lt;</td>
</tr>
<tr>
<td>Mark Quotation End + Create Quotation</td>
<td>. or &gt;</td>
</tr>
</tbody>
</table>
Zooming the Time Line

A quick way to zoom the time line is by putting the mouse pointer onto the preview images on the right-hand side or the margin area, holding down the Ctrl-key and scrolling the mouse wheel.

You can also zoom the timeline using the two orange sliders to select just the section of the audio or video that you want to see in the margin area:

When you move the mouse pointer over the full preview, two orange sliders appear (see Figure 201).

Move the right and left slider to the desired position.

Multimedia View Options

If a multimedia document is loaded, you find a number of additional options on the View tab of the contextual document ribbon.

The time line can be positioned at the bottom of the screen horizontally, or vertically next to the audio wave form. You can show or hide the audio waveform or the video previews in both the margin or the zoom line.

If you deactivate ‘auto-scroll margin’ the playhead moves from the top to the bottom of the screen. The margin does not move. If you have zoomed the margin, the playhead will be out of view if the audio or video file plays beyond the zoom area. If you are only working within the zoomed area, or display the entire multimedia file on the screen, you may want to deactivate the auto-scroll option as this is a lot smoother on your eye.

If you activate ‘auto-scroll margin’ the playhead remains in the middle of the screen and everything else moves (preview images, audio wave form, margin).
Navigation Using The Arrow Keys

Use the right and left arrow keys to move the position of the playhead by 1/1000th increments of the length of the video that is currently displayed in the margin area.

Use the right and left arrow keys + the Ctrl-key to move the position of the playhead by 1/20th increments of the length of the video that is currently displayed in the margin area.

Creating Multimedia Quotations In the Margin Area

To create an audio or video quotation, move your mouse pointer on top of the audio wave and mark a section by clicking on the left mouse button where you want it to start. Then drag the cursor to the end position. The times of the end and start positions are shown, as well as the total length of the segment.

As soon as you let go of the mouse, a quotation is created and you see the blue quotation boundary in the margin area:

If you want to take it one step slower, you can change the following setting under multimedia preferences that requires an additional step to create a quotation (see also "Multimedia Preferences"):

If you have deactivate auto-create, hover with the mouse over the selection and click the CREATE QUOTATION button as shown in Figure 206.

Creating Multimedia Quotations While Listening / Watching

You can also create audio or video quotation while listening / viewing the file. For this, you can use the Mark and Create Quotation button in the tool bar or the short-cut keys < or , to set the start position and > or . to set the end position and to create a quotation.

Play the video. If you find something interesting that you want to mark as a quotation, click on the , or the < key. Which one to use depends on your keyboard.

Click . or > to mark the end position and to create the quotation.

Continue listening / watching and setting quotations.
Reviewing A Multimedia Quotation

If you want to review a quotation click on the “play” button.

You can of course also immediately code multimedia files (see "Coding Multimedia Documents." However, as especially video files contain so much more information as compared to text, it is often easier to first go through and segment the audio or video file, i.e. creating quotations before coding. You have both options, whatever suits better.

Adjusting the Size of Multimedia Quotations

To adjust or change the length of the quotation, drag the start or end position to the desired position.

Display Of Multimedia Quotations

A new quotation will be listed in the Quotation Manager, the Project Explorer or Quotation Browser. The default name for audio and video quotations is the start and end time of the quotation. Each quotation can, however, be renamed.

Depending on the media type, the quotation icon changes:

Renaming A Multimedia Quotation

Select a quotation either in the Quotation Manager, the Project Explorer or the Quotation Browser, right-click and select the Rename option.
Audio and video quotations can be easily recognized by their special icon.

Activating And Playing Multimedia Quotations

In The Margin Area
- To play the quotation, double-click on the quotation bar.
- You can also move the playhead with the mouse to any position within an audio or video file.

From Other Places
- You can double-click on a multimedia quotation in the Project Explorer, the Quotations Browser or the Quotation Manager to play it in context.
- You can preview a multimedia quotation in the preview area of the Quotation Manager. See “Activating and Displaying Quotations.”
- You can preview a multimedia quotation in a network.

Creating Snapshot Images From Video Frames
If you want to analyze particular frames of your video in more detail, you can create a snapshot. The snapshot is automatically added as new image document to your project.
- Move the play head to the desired position in the video.
- Click on the camera icon in ribbon, or right-click on the video area and select the option Capture Video Frame.
See “Creating Graphical Quotations” for further information on how to work with image files.

Coding Multimedia Documents
- Right-click on the blue quotation bar and select Coding / Open Coding. For further information see: “Coding Data”.

Figure 211: Accessing the media controls via the context menu
Describing Multimedia Quotations To Improve Output

The name of an audio or video quotation is its start and end position. If you want to add further information, you have two options: renaming and adding a comment.

In the process of creating video quotations, rename them so they can serve as titles for your video segments. To do so, right click on the quotation name in the Quotation Manager and select the Rename option. See also “Renaming A Multimedia Quotation.” This allows you to create a meaningful text output of coded audio and video segments. Use the comment area to add further information, e.g. describe the segment and offer a first interpretation.

To create a report, select a few video quotations in the Quotation Manager. Select the Report button in the ribbon. Under options, select Comment. The report will show an overview of all the titles you have created for your video (or audio) segments and the comments you have written. Plus, it provides the exact position within the audio or video file (start position [duration]).
Multimedia Preferences

Under **PROJECT PREFERENCES** (File / Options), you can set project specific preferences for multimedia files:

The effect of **Autopreview** is that the audio or video quotation immediately starts to play when you activate or open a function.

When selecting autopreview for documents the multimedia quotation immediately begins to play when selecting a multimedia document in the Document Manager.

When selecting autopreview for quotations the multimedia quotation immediately begins to play when selecting a multimedia document in the Quotation Manager.

When selecting autopreview for hyperlinks the multimedia quotation immediately begins to play when activating a hyperlink.

The default option is that a multimedia quotation is created as soon as you have made a selection on the audio wave form. If you prefer to make a selection first before creating a quotation with an additional mouse click, deactivate this option.
WORKING WITH GEO DOCS

ATLAS.ti 8 uses Open Street Map as its data source for geo documents. Even though there is only one data source, you can also use more than one geo docs in your project, e.g. to create distinct sets of locations, to simulate tours, to simply tell different stories.

Adding A Geo Document To A Project

To add a geo document to the project, in the Home tab click on the drop down arrow of the ADD DOCUMENTS button and select NEW GEO DOCUMENT. A new document is added and if you open it you see the world map. The default name is “New Geo Document”. You may want to rename it, so it better describes your analytic intention.

Finding A Location

The first thing you probably want to do is to query an address:

- In the Document tab, click on the button QUERY ADDRESS. A new tab opens in the navigator on the left. Enter a search term.

The map immediately displays the location that fits the search term and adds a place mark.
Creating Geo Quotations

Creating a Geo quotation is not much different from creating other type of quotations. The only difference is that the quotation is just one location on the map – the place mark, and not a region.

- Right-click on the place mark and select the option **Create Free Quotation** (or click on the Create Free Quotation button in the Document ribbon).
- To create further quotations, either enter a new address and search for a location of interest, or left-click a point of interest on the map to set a place mark. Right-click and select Create Free Quotation from the context menu.

If you move your mouse over a quotation, a text window opens displaying information about the quotation like the name, the author, when it was created, any codes and memos that are attached to it, the longitude and latitude and the address.

Coding Geo Quotations

You can also create a quotation and link a code to it in one step, or code an existing quotation:

- Set a place mark or select an existing one, right-click and select the option **Open Coding** or **List Coding** (or click on the equivalent coding buttons in the Document ribbon).

![Figure 219: Coding a Geo quotation via the context menu](image)

All other drag-and-drop operations described for coding also apply. See "More Drag-And-Drop Options."

Display of Geo Quotations

Geo quotations can be access in the margin area, the Quotation Manager, the Quotation Browser, the Project Explorer and also from within networks. Geo quotations are displayed as follows:

![Figure 220: Display of geo quotations in the Quotation Manager](image)

The quotation icon shows a place mark and the quotation name consists of the Geo coordinates for degree of longitude and degree of latitude written in the decimal system.

In addition the Quotation Manager shows a preview of the Geo location (Figure 221). You may want to consider renaming Geo quotations, e.g. by adding the name of the location to the coordinates. Another option is to add a comment. See also "Describing Multimedia Quotations To Improve Output."
Activating Geo Quotations

Select a Geo quotation in any of the above mentioned browsers or windows and double-click. It will be displayed in context. The place mark is colored in pink. All non-activated place marks are colored in light-blue.

Modifying A Geo quotation

To modify a Geo quotation, activate it (see "Activating Geo Quotations") so it is highlighted in pink.

Move the place mark to a different location. The quotation follows along.

Creating A Snapshot

You can create a snapshot from the geographic region that is currently shown on your screen. This snapshot is automatically added as a new image document. This allows you to select a region to create a quotation or to code it. Further you can browse the Geo location in Google Maps (see "Browsing Geo Locations").

In the Document tab, click on the button **CREATE SNAPSHOT**.

A new document is created. The default name is: ‘Geo Snapshot @ longitude:latitude’ of the last selected location.

As a snapshot results in an image document, you can also handle it like an image document. See for example “Creating Graphical Quotations.”
Browsing Geo Locations

Based on a Geo snapshot, you can look at the location on Google Maps by selecting the button **Browse Geo Location** in the Document tab. This opens Google Maps in your default browser outside of ATLAS.ti.

![Figure 224: Browsing a Geo location in Google Maps](image)

Video tutorial: Working with Geo documents

Working With Survey Data

Overview

These days, a great many surveys are conducted through online tools. A positive side effect is that (a) all data is immediately available in digital format, and (b) respondents are often willing to provide longer answers to open-ended questions. This was rarely the case with paper-and-pencil surveys. Statistical programs like SPSS™ offer some options to analyze open-ended questions, but basically require you to encode each answer with a number. A proper qualitative analysis of the answers is not possible with these tools. ATLAS.ti, however, does permit comprehensive analysis with great ease and in great depth.

A typical work flow for working with survey data looks like this:
Online surveys can be created using a variety of tools. What most of them have in common is that they let you export data as Excel™ file. And this is what you need to prepare for import in ATLAS.ti (see below). Based on specific prefixes that you add to your variable names, ATLAS.ti interprets the column headers and cells of the Excel™ table in various ways and turns them into primary documents, the contents of the primary documents, primary document families, quotations, codes, comments, and code families. Data are imported case-based. This means each row of the Excel™ table that is imported from the online survey tool is transformed into a primary document.

How Survey Data Is Treated In ATLAS.ti

To represent the results of an online survey within the framework of ATLAS.ti in the most accurate and complete manner, a few basic requirements need to be considered.

A survey broadly consists of the name of the survey, the questions, and the answers from each respondent. Questions can be of different types, such as single-choice questions (yes/no, or offering more than two options), multiple-choice questions, or open ended questions. Within the framework of ATLAS.ti these concepts are mapped as follows:

<table>
<thead>
<tr>
<th>Open-ended question: question answer</th>
<th>Code (and code comment) Content of a quotation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single Choice 0/1</td>
<td>Document group</td>
</tr>
<tr>
<td>Single Choice &gt; 2 options</td>
<td>Document group from question plus value</td>
</tr>
<tr>
<td>Multiple Choice</td>
<td>Document group from question plus value</td>
</tr>
</tbody>
</table>

This does not mean that you cannot turn a multiple-choice question into a code. It all depends on how you define the columns in your Excel table. If you turn single or multiple choice questions into codes, you later need to do some automatic coding based on the response choices available in the questionnaire.

Always remember that ATLAS.ti is not a software for analyzing statistical data, although it is possible to add information from traditional quantitative questions. A general recommendation is to include the following variables from the online survey:
- Variables describing the respondents, i.e. the classical demographic variables like age group, gender, profession, educational level, income groups, etc.. Turn those variables into document groups.
- Responses to open-ended questions. Turn those into coded segments.
- Selected other variables like answers to single or multiple choice questions that are important in relation to analyzing the open-ended questions.

Preparing An Excel™ Table For Import

The following table shows the list of all available prefixes that you can to add to the column headers in Excel™ in order for ATLAS.ti to interpret the cells in various ways.

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Defines the column to list the names of the primary documents. This column can be omitted. If you do not want to provide a specific name for each document, ATLAS.ti automatically creates this column. The default name for each document is case 1, case 2, case 3 and so on.</td>
</tr>
</tbody>
</table>
Prefixes and their interpretation

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>^</td>
<td>Defines the column to list the primary document's author</td>
</tr>
<tr>
<td>&amp;</td>
<td>Defines the primary document's date, expects ISO8601 format, see: <a href="http://www.cl.cam.ac.uk/~mgk25/iso-time.html">http://www.cl.cam.ac.uk/~mgk25/iso-time.html</a>. Example: 4th of February 1995 or 1995-02-04 in ISO8601 format = YYYYMMDD = 19950204</td>
</tr>
<tr>
<td>&lt;</td>
<td>Ignore this column, use to exclude stuff inserted by the survey tool</td>
</tr>
<tr>
<td>.</td>
<td>Creates a document group from the field name. Currently the cell needs to contain the number 1, or the words Yes or Ja to be applied. Use for single choice questions where respondents can answer yes or no (or encoded as 1 and 0). Only the responses encoded with yes/ja or 1 become part of the document group.</td>
</tr>
<tr>
<td>;</td>
<td>Creates a document group from the field name plus cell value. Use for single choice question like gender.</td>
</tr>
<tr>
<td>#</td>
<td>Creates a document group from the field name plus the actual cell value. Use for single choice questions with more than two answer options or for multiple choice questions.</td>
</tr>
<tr>
<td>::</td>
<td>Add no prefix to all open ended questions. The text in the column header is used as code. To avoid very long code name, use a short form to indicate the question and add the full question as comment (see next row).</td>
</tr>
<tr>
<td>::</td>
<td>All text entered after two colons is added to the entity's comment field. This can be applied to cells resulting in document groups or codes.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CaseID</th>
<th>&amp;dateTime</th>
<th>^Name</th>
<th>.Academic</th>
<th>.Gender</th>
<th>#Favorites::What bands do you listen to regularly?</th>
<th>Tell us a dream</th>
<th>Open End::How do I create a question that is interpreted as open-ended?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case 1</td>
<td>20100414T1200 00</td>
<td>Michell e</td>
<td>0</td>
<td>female</td>
<td>Beatles, Stones</td>
<td>I was walking on the roof of a 12-story building…</td>
<td>This is a lengthy response to a question that may elicit loooooong answers.</td>
</tr>
<tr>
<td>Case 2</td>
<td>20100415T1710 00</td>
<td>Hans</td>
<td>1</td>
<td>male</td>
<td>Stones, Scorpions</td>
<td>I am sorry, I don't remember any dreams at all</td>
<td>Quite simple: every field name (question) that has no prefix is an open-ended question by default.</td>
</tr>
</tbody>
</table>

By importing the above sample table, we get:

- The name, date, and author of the resulting document.
- One group for .Academic containing all cases with cell value 1.
- Two groups Gender::male and Gender::female
- Four groups Favorites::Beatles, Favorites::Stones, etc. The following comment is added to each document group: What bands do you listen to regularly?
- Two codes Tell us a dream and Open End. The following comment is added to the comment field of the code "Open End": How do I create a question that is interpreted as open-ended? The text in the cell is making up the document content for each case.

How To Import Survey Data

- If you haven't done it yet, download the sample survey data [here](http://www.cl.cam.ac.uk/~mgk25/iso-time.html) (or prepare your own).
- Select the Import & Export tab and then the Survey button. Select the Excel file to be imported and click Open. The import procedure starts. You see a progress report and ATLAS.ti informs you when the import is finished.

Inspecting Imported Survey Data

- Open the Document Manager and take a look at what has been added to the project:
If you do not specify a name for each case, the default is case 1, case 2, case 3 and so on. Here the name/synonym of each respondent was known and entered as author. Based on the information provided in the Excel table, document groups were created. The highlighted respondent ‘case 6’ for example has some college education, is a female, single, and has no children. She answered the question ‘Do children bring happiness’ with yes.

ATLAS.ti automatically creates a group that contains all survey data in case you work with data from multiple sources.

If your data comes in waves, you can add the data to the same data and import it again. ATLAS.ti will only import the new information. This also applies if you add new variables.

Each open-ended question was also automatically coded with the information provided in Excel.

Double-click case 6 to open it and open the Code Manager alongside (Home tab / Codes button or double-click on the main Codes branch in the Project Explorer).

The first code has no a comment and the full length name is used as code label because no syntax was added in the Excel.

**SQ: Reasons for not having children**

For the second open ended questions, the column in Excel was labeled: **SQ1:: Reasons for having children**

Note the syntax that was used ::. The effect is that the text that follows the two colons is entered as code definition in the code comment field. The code label is shorter and the full label also does not appear in the body of the text, which can for instance effect word clouds and word frequency counts in unwanted ways.
Working With Survey Data

Analyzing survey data requires that you know how to code (see "Working With Codes"). You may want to explore the data first by creating Word Clouds or Word Lists, see "Exploring Data" and by using the auto coding feature ("Auto Coding"). After coding, further analysis options that are often used with survey data are the Code-Document Table, the Query Tool in combination with the Scope option and possibly also the Code-Cooccurrence Table. For further information, see "Querying Data."

Working With Reference Manager Data

ATLAS.ti is frequently used for assisting with literature reviews. See for example:

- On Conducting a Literature Review with ATLAS.ti
- Using ATLAS.ti 8 Windows in Literature Reviews
- Managing Literature Reviews Using ATLAS.ti

ATLAS.ti 8 provides even better support for literature review as you can import your articles directly from your favorite Reference Manager. The prerequisite is that you are either using Endnote, or a reference manager that allows you to create an export for Endnote in XML format. This is for instance the case in following programs:

- Reference Manager
- Mendeley
- Zotero

You might collect a great many documents in your reference manager for a first screening, or because you have come across an article that might potentially be of interest at some point. You do not want to import all of these articles into ATLAS.ti, only those that you want to look at more closely and that you have already identified as being useful for your literature review and subsequent theory chapter. Therefore we recommend that you prepare your data in the reference manager of your choice in such a way that the export only contains a pre-selection of documents. How this is done is different in each reference manager.

Mendeley

In Mendeley, for instance, you highlight the documents that you want to export, right-click and select EXPORT. When saving the file, you can select the file format:

- Select ENDNOTE XML as file type, and save the file.

Zotero

In Zotero, you find the export option under the FILE menu: EXPORT LIBRARY.

- Zotero offers about ten different formats to export to. Here, too, select the Endnote XML option.

- In addition, you can export your notes and the full content of the documents. Select both options. The notes will be imported as document comments in ATLAS.ti.
Importing Documents

To start importing the file into ATLAS.ti, select the **Import & Export** tab and the button **Reference Manager**.
WORKING WITH REFERENCE MANAGER DATA

ATLAS.ti can create document groups for you based on the following meta data:

- First authors
- Co-authors
- type of document (journal article, book, book chapter, etc.)
- Language
- Source – If you import documents from more than one reference manager, it is useful to group documents by source, so that you know where they were coming from.
- Periodical
- Year
- Volume
- Issue
- Edition
- Publisher

Document name format

The default name for the document in ATLAS.ti is the name of the document as it used in the Reference Manager. For easier sorting and organization, you can chose to add the name of the first author and the publishing year to the document name.

If the full document is not available

If only the document abstract is available and not the full document, you can select to import the abstract as a document.

If you have written a note about the document in your Reference Manager, this note will be imported as document comment.

Make your selections and click the Import button.

Inspecting Imported Documents

Open the Document Manager (Home tab / Documents button):
The imported documents are sorted by author and year in alphabetical order. Further, document groups were created based on the available information. Document 4 for instance was published in Nurse Researcher in 2002 and the source is Zotero. The text entered as note in Zotero was imported as comment. If there are no notes for the document, the URL of the document is added into the comment field (if available).

Working With Twitter Data

Importing Twitter Data

This section shows you how to import Twitter data.

A sample project showing how to work with Twitter data will follow later.

To import Twitter data, select the **Import & Export** tab and then the **Twitter** button.

- Enter a query. You can also look for multiple hashtags or authors by using OR. For example: #WorldAidsDay/#HIV/#Aids.
Next, select whether you want to import the most recent or the most popular tweets and whether to include re-tweets, images and profile images. Note that you only will be able to import tweets from the last week. Further, as the final selection is done by Twitter and not within our control, queries at different times, or on different computers may result in different tweets.

The imported data is automatically coded based on the selection you make:

- Tweets often contain many more hashtags than the original one that you searched for. Coding all hashtags often results in great many codes. Therefore you have an option to only code the queried hashtags. Further options are to code all authors and all mentioned Twitter users, the location, and the language.
- Lastly you can decide whether a link should be created between authors and locations and between the authors and mentioned Twitter users.

Inspecting Imported Twitter Data

Load the imported and automatically coded document, e.g. from the project explorer on the left-hand side. On the top of the document, you can read how many tweets and retweets were imported and how many you requested. Each tweet is coded with the selection you have made.
Open the Code Manager to inspect the code and code groups that have been created (Home tab / Codes button):

- Search Code Groups
  - Code Groups
    - TwitterAuthors (99)
    - TwitterHashtags (13)
    - TwitterImported (771)
    - TwitterLanguages (5)
    - TwitterLast (171)
    - TwitterLocations (83)
    - TwitterMentions (59)
    - TwitterSystemCodes (6)

  - Show codes in group TwitterLanguages
    - Name: TwitterLang:English
      - Grounded: 51
      - Density: 0

- Video Tutorial: ATLAS.ti 8 Windows-Working with Twitter Data

The code groups help you to navigate through your codes. By clicking on the code group Twitter: Languages, for instance, you can immediately see how many and which languages are used in the tweets you imported.
Representing the Rhetoric of Data

A network with text (or other media) as nodes is often referred to as a hypertext. The original sequential text is de-linearized, broken down into pieces that are then reconnected, making it possible to traverse from one piece of data to another piece of data regardless of their original positions.

While a code offers fast access to sets of data segments, it defines only a simple relation between them, namely equivalence. Hyperlinks, which directly relate data segments, express more differentiated relationships between quotations: contradiction, support, illustration, etc.

No code is needed to connect quotation Q1 with one that it contradicts (Q2). Cross-references between text passages are very common even in conventional media like books - just think of religious and juridical texts, literature, journals etc. Footnotes and end notes are another common deviation from the pure linearity of sequential text. However, in conventional media, not much navigational support is provided for “traversing” between the pieces of data that reference each other.

Computer-related hypertext applications include, for example, online help systems that display operational information in suitable small chunks (compared to lengthy printed information), but with a considerable amount of linkage to other pieces of information. A well-known hypermedia structure is the World Wide Web with its textual, graphical and other multimedia information distributed world-wide.

Benefits of Hypertext

What are the advantages of direct connections between text segments, compared to the traditional procedures of qualitative text analysis?

What Codes Cannot Do

Maybe we should ask a different question first: How can you express that statement X in text A contradicts statement Y in text B, or how can you retrieve all contradictory statements of a specific utterance if all you have is codes and their associations with the data?

The "code & retrieve" paradigm, which is so prevalent for many systems supporting the qualitative researcher, is not adequate for certain types of analysis. In formal terms, attaching codes to chunks of data creates named sets of segments with almost no internal structure. This is not to say that partitioning lots of text segments into sets is not useful. On the contrary, classification leads to manageable amounts of segments that later can be retrieved with the help of the attached code words. But this may not be the only way you want to look at your data.

The concept of hypertext introduces explicit relations between passages. These links have to be built manually and result from an intellectual effort. The system cannot decide for you that segment x is in contradiction to segment y. But after the work of establishing the links, you can make semantically richer retrievals: "Show statements contrary to statement x."

Hypertext allows you to create different paths through the data you are analyzing. For example, you may create a timeline different from the strict sequence of the original text.

Graphical Hyperlink Maps

ATLAS.ti incorporates procedures for creating and browsing hypertext structures. It allows for two or more quotations being connected using named relations. Further, you can create graphical maps - using Networks - to make parts of your hyperspace accessible in a comfortable way. Hyperlinks may connect quotations (textual, graphical, multimedia) across documents (inter-textual links) or may link segments within the same primary document (intra-textual links). The natural boundary for hyperlinks, like all structures in ATLAS.ti, is the project.

The hypertext network below displays quotations showing the full content in the preview. Other node types can also be included in the Network, like memos and codes.
Creating Hyperlinks

A hyperlink is a named link between two quotations. If, for instance, you notice that one statement in a report or interview is explaining a previous statement in a bit more detail, you can link the two using the relation "explains." Or you may find a contradictory or supporting statement. These are just a few of the default relations that come with the software. If they do not fit what you want to express, you can create user-defined relations in the Relation Manager. See "Defining New Hyperlink Relations."

ATLAS.ti offers a variety of options for creating and traversing hypertext links. Similar to the linking of codes, you may create hyperlinks in a the network editor (see "Linking Nodes"). In addition, hypertext links can be created "in context," or via Drag & Drop in the Quotation Manager and in the margin area.

Creating Hyperlinks In Context

1. Select a data segment as source, or an already existing quotation.
2. Right click on the selection select the option CREATE SOURCE from the context menu.

If you select a data segment as source or target that was not yet a quotation, ATLAS.ti automatically creates a quotation from it.

Figure 239: Creating a hyperlink using the context menu
Select a target segment or an existing quotation as target, right click and select the option **CREATE LINK TARGET**. The list of available relations opens up. Select a relation with a left-click.

If none of the existing relations fit, create a new relation in the Relation Manager. See “Defining New Hyperlink Relations.”

**CREATING A STAR**

You can continue linking by highlighting another segment and selecting the **CREATE LINK TARGET** option again. This eventually will result in a star like formation. A hyperlink star connects many quotations from one source quotation. In the example shown in Figure 242, the source quotation is 3:160, which is linked to seven target quotations via a number of different relations.

**CREATING A CHAIN**

If you want to create a chain linkage, you need to select the target quotation again and set it as source and select a third quotation as target, and so on, as shown in Figure 242:

Quotation 3:26 served as a source quotation and was linked to the target quotation 3:160. In order to continue the chain, the target quotation 3:160 became the source quotation and was linked to the new target quotation 3:209.
Display Of Hyperlinks In The Margin Area

Hyperlinks show the quotation icon, the relation and if space allows also the ID and name of the target quotation.

Display Of Hyperlinks In The Quotation Manager

All hyper-linked quotations can easily be recognized in the Quotation Manager. All source quotations are marked with an opening angle bracket <, all target quotations with a closing bracket >. If a quotation is both, source and target (as the case when creating chains), then both brackets are used as prefix <>. Symbols added to the Quotation Id:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>~</td>
<td>Quotation has a comment</td>
</tr>
<tr>
<td>&lt;</td>
<td>Quotation is source of a hyperlink</td>
</tr>
<tr>
<td>&gt;</td>
<td>Quotation is target of a hyperlink</td>
</tr>
<tr>
<td>&lt;&gt;</td>
<td>Quotation is both start and target, thus at least two other quotations are linked</td>
</tr>
</tbody>
</table>

Hyperlinked quotations in the Quotation Manager:

<table>
<thead>
<tr>
<th>ID</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;</td>
<td>hook for article</td>
</tr>
<tr>
<td>&lt;</td>
<td>consistent efficiency of reg. correlation between having children and happiness</td>
</tr>
<tr>
<td>&gt;</td>
<td>worse than expectations - less rather than more happiness</td>
</tr>
<tr>
<td>&lt;&gt;</td>
<td>guiding questions</td>
</tr>
</tbody>
</table>

Creating Hyperlinks In the Quotation Manager

This method can be applied to connect one or more existing quotations to one target quotation.

- Select one or more source quotations in the Quotation Manager (multiple selections can be done in the standard way).
- Hold down the left mouse button and drag the quotation(s) to a target quotation in the Quotation Manager.
- Release the left mouse button. The Relation menu opens and you can specify the relation to be used for the hyperlinks.
Creating Hyperlinks In The Margin Area

Like the method described above, creating hyperlinks in the margin area is best suitable for connecting two quotations that are in close proximity to each other.

- Select a quotation bar in the margin area.
- Hold down the left mouse button and drag the bar onto another quotation bar.
- Release the left mouse button. The Relation menu opens. Select a relation. The linking procedure ends here.

Creating Hyperlinks By Viewing Documents Side-By-Side

- Load two documents side-by-side, which means to load two documents and to move one into a second tab group. See "Working With Tabs And Tab Groups."
- Left click a quotation bar in the active region, drag the mouse to a quotation bar on a document in a different tab group, release the left mouse button and select a relation. See Figure 248.

Traversing Hyperlinks

To preview a hyperlinked content or to jump back and forth between hyperlinks, double-click on a hyperlink, a window pops up providing information on the linked quotation and you can click inside to visit this quotation.
Modifying Hyperlinks

You can modify existing hyperlinks, i.e. cutting a link, flipping (reversing) a link, or changing the relation at various places.

**CUTTING OR REVERSING A LINK IN THE MARGIN AREA**

Right-click on a hyperlink in the margin area and select either the **CUT HYPERLINK** or the **REVERSE HYPERLINK** option from the context menu.

![Cut Hyperlink](image1.png)

**Figure 247: Cutting or reversing a hyperlink in the margin area**

**MODIFYING HYPERLINKS IN THE HYPERLINK MANAGER**

To open the Hyperlink Manager, click on the drop down arrow of the Links button in the Home tab. See also “Links Manager Columns (Hyperlinks)”

Select the **HYPERLINKS** button in the Link Manager:

![Hyperlink Manager](image2.png)

**Figure 248: Open Hyperlink Manager**

**Figure 249: Modifying a hyperlink in the Hyperlink Manager**
To modify a hyperlink, select it, right-click and select the desired option (Cut Link, Flip Link or Change Relation) from the context menu.

**Modifying Hyperlinks In The network editor**

Open a network on a hyperlink, e.g. by right clicking and selecting the option Open Network from the context menu, or click on the Open Network button in the ribbon.

In the network editor, right click on a link label and select the desired option (Flip Link, Cut Link or Change Relation) from the context menu.

At this point, here is a very useful application of renaming quotations: As the names are displayed in a network, it allows you to create meaningful and easy to understand models of your data. ‘The hook for the article’ <expands> ‘guiding questions’ <continued by> ‘worse than expectations....’ and this is discussed by quotation [1:2] ‘consistent evidence of negative correlation...’

**Useful Options For Hyperlinks And Quotations In The network editor**

To either see the full content of a quotation, or to move to the content of a quotation that appears in a network, double-click a quotation node and choose Show in document. You are moved to the section of the Document where the quotation resides.

To expand the hyperlinks you see in a network, or to see which other entities are linked to a hyperlinked quotation, you can import neighbors.

If you want to see how many entities are linked to a quotation, select the View tab and activate the option Show Frequencies. See Figure 252.
Quotation 2:20 is linked to three other entities and quotation 2:14 to two other entities, which could be other quotations, codes or memos.

Directly linked entities are 'neighbors' and you can import them by right-clicking and selecting the appropriate option from the context menu. You can import all neighbors, or select a specific entity type that you are interested in:

For more information on how to work with networks see the chapter "Working With Networks."

**Defining New Hyperlink Relations**

New relations can be defined in the "Relation Manager." The procedure for defining or editing hyperlink relations is equivalent to defining or editing code-code relations. It requires a basic understanding of "Nodes And Links," "Link vs. Relation," and relation properties (see "Relations"). Therefore, we recommend to first read these sections.

Code-code and quote-quote links are the only types of network connections that allow you to assign a name to the connection that appears on the line or arrow that runs between nodes.

**Editing Hyperlink Comments**

The links between quotations use fully qualified relations, like the links between codes and unlike the simple association between a code and a quotation. As "first-class" objects, these links can be assigned a dedicated comment.

Such a comment could explain why quotation A has been linked to quotation B. Link comments can be accessed, displayed and edited from three locations: the margin area, the Hyperlink Manager and the network editor.

The margin area has the advantage that it is readily available during scrolling through the documents. The network editor method offers a visual approach to accomplishing this goal.

**To Edit A Hyperlink Comment In The Margin Area**

- Pop-up the context menu for a hyperlink displayed in the margin. The quotation inside the primary document pane is highlighted at the same time.
- Choose **Edit Hyperlink Comment** (see Figure 247).
WORKING WITH HYPERLINKS

TO EDIT A HYPERLINK COMMENT IN THE HYPERLINK MANAGER

- Open the Hyperlink Manager (Links button in the Home tab).
- Select a hyperlink.
- Edit the comment in text pane below the link list, or open a text editor by clicking the Editor comment button in the ribbon, or the Edit Comment option in the context menu.

![Hyperlink Manager](image1)

**Figure 254: Writing a comment for a hyperlink**

TO EDIT A HYPERLINK COMMENT IN A NETWORK

- Open a network editor on a hyperlink (see "Modifying Hyperlinks In The network editor.'
- Move the mouse pointer to the link between two quotations and right-click.
- Choose Edit Comment.

![Network Editor](image2)

**Figure 255: Editing a hyperlink comment in a network**

### Working With Comments And Memos

Writing memos is an important task in every phase of the qualitative analysis process. The ideas captured in memos are often the "pieces of a puzzle" that are later put together in the phase of report writing. Theory-building, often associated with building networks, also can involve the use of memos.

Memos are explanatory and descriptive texts that may be associated with other entities like quotations, codes, or other memos. Memos can also be just a text on its own, without being linked to anything. They can contain methodological notes: they can be used as a bulletin board to exchange information between team members; you can use them to write...
notes about the analytical process, keeping a journal of to-dos, and to write up your analysis, formulating answers to your research questions.

Memos can also be assigned as documents, if you want to code them (see "Using Memos as Document").

**Difference Between Memos And Codes**

Code names are (or should be) succinct, dense descriptors for concepts emerging during the stage of closely studying the data. They often reduce complex findings to crisp placeholders and/or theoretically relevant concepts.

Beginners often stuff lengthy treatises into a code name, blurring the distinction between codes, comments, and memos and thereby mistaking codes for their more appropriate siblings.

If you find yourself using more than a few words as code word, consider using quotations or the code comment instead.

Like codes, memos have names. These names, or titles, are used for displaying memos in browsers, and help to find specific memos. Just like code names, a memo's title should be short and concise. Don't confuse the name with its content! The purpose is to fill the memo with content, which is a longer text that goes beyond just describing the memo title.

**How Memos And Comments Differ**

Comments exclusively belong to one entity. For example, the document comment is part of the document; a code comment belongs to a particular code and is usually a definition for this code. Memos can also have comments, which could f.ex. be a short note to use this memo for chapter 4 in the thesis, etc.

Comments are not displayed in browsers separately from the entity to which they are attached.

Memos can be linked to other entities and have an additional type attribute, e.g., theoretical, methodological, commentary, etc. They can also be free-standing, unlike comments.

**Typical Usage**

The following two tables provides and an overview of most common usages of the various comments and memos.

<table>
<thead>
<tr>
<th>Comments for...</th>
<th>Typical Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project</td>
<td>... contain a project description. Take for instance a look at the comment written for this Children &amp; Happiness sample project by clicking on the Edit Comment button in the Home tab.</td>
</tr>
<tr>
<td>Documents</td>
<td>... provide meta information about the document, e.g., a source reference, comments on an interview situation, etc. When you use ATLAS.ti for your literature review, they may contain short summaries of the article or an evaluation whether and how you want to continue to use this article.</td>
</tr>
<tr>
<td>Quotations</td>
<td>... may contain an in interpretation of the data segment / may contain a transcript of a video segment / may contain a summary of the data segment / may contain a translation into another language, etc.</td>
</tr>
<tr>
<td>Codes</td>
<td>... describe the code / provide coding rules / contain a sample quote / summaries or interpretations of the coded content</td>
</tr>
<tr>
<td>Memos</td>
<td>... may contain a note of another researcher on the team / supervisor reading the memo / an evaluation where to use the memo in the ongoing analysis / ideas for linking and building networks as comment on an analytical memo</td>
</tr>
<tr>
<td>Groups</td>
<td>... describe the group / how you intend to use it / why you have grouped the entities the way you did</td>
</tr>
<tr>
<td>Networks</td>
<td>... describe the content of the network</td>
</tr>
<tr>
<td>Links</td>
<td>... describe why the two entities (code-code relation or quotation-quotation relation) are linked and why this relation has been used</td>
</tr>
<tr>
<td>Relations</td>
<td>... to describe the relation and how you want to apply it</td>
</tr>
</tbody>
</table>

Below there are only some ideas on how memos can be used. These are probably sufficient to get your started. But do not feel restricted by the suggestions. In gaining more experience in working with the software, you may come up with more ideas on how to use memos.

<table>
<thead>
<tr>
<th>Memos</th>
<th>Description</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Research diary</td>
<td>Summary of activities in a work session. Usually there is only one research diary per project. However, if your research diary gets very long you may consider to split it up in multiple memos, e.g. one per month</td>
<td>method</td>
</tr>
<tr>
<td>Research questions</td>
<td>List and descriptions of your research questions</td>
<td>memo</td>
</tr>
</tbody>
</table>
## Working with Comments and Memos

<table>
<thead>
<tr>
<th>Notes for team members</th>
<th>Things you notice during the analysis and that you want to discuss with your team for team</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ideas</td>
<td>As a place to collect ideas that arise during analysis for memo</td>
</tr>
<tr>
<td>On the code system</td>
<td>Notes on the code system like ideas on code refinement; ideas for potential categories / higher order codes / sub codes; notes to yourself where you still see areas of improvement for memo</td>
</tr>
<tr>
<td>To-do-memo</td>
<td>A general memo on things that are still on the to-do-list for memo</td>
</tr>
<tr>
<td>Interpretations / answers to research questions</td>
<td>Memos can be used as a place for writing-up analysis. Use a quotation comment for interpretations on single data segments and memos for interpretations across a larger range of quotations, e.g. a retrieval by code or the results of more complex retrievals in the query tool, the results of a code-cooccurrence or code-document table, etc. for analysis</td>
</tr>
</tbody>
</table>

### Writing Comments

As detailed in the table above, you can write comments for:

- projects
- documents
- quotations
- codes
- memos
- groups
- networks
- links
- relations

In the Entity Managers, the comment for a selected entity is displayed in the text pane below the list pane. You may edit the text right there or you might prefer to open a full-fledged text editor (see Figure 256). For minor changes, or if you do not need any formatting options, working in the text pane in the Entity Manager is quite comfortable.

![Figure 256: Writing comments for quotations](image)

### Saving A Comment

A comment is saved automatically whenever you select another entity in the list or when you close the window. Changes can be explicitly saved at any time by clicking on the **Save** icon at the top right of the text pane (see Figure 257).
All text editors offer full rich text support.

Creating Memos

Memos can be created from the **Home Tab**, or in the Memo Manager (see Figure 259).

- To create a memo from the Home tab, open the drop-down menu of **New Entities** and select **Free Memo**.
- Enter a name for the new memo and click **Create**.

![Create Memo](image)

Depending on your last settings, the memo editor may open as floating or docked window. Figure 261 shows a floating editor. If you want to change between floated and docked windows, see “Working With Docked And Floated Windows.”

**ATLAS.ti** will remember your last used settings.

- Begin to write your memo. When you are done, click the Save button and close the window.

All memos are listed in the Memo Manager.

The Memo Manager

![Memo Manager Options](image)

- Open the Memo Manager by clicking on **Memos** in the **Home Tab**. The Memo Manager offers the following options:
Changing The Memo Type

Memos can be organized, sorted and filtered by the type attribute. Several standard memo types are offered by ATLAS.ti: commentary, memo and theory. You can add new types or modify existing ones. The default type is 'memo'.

To change the memo type or create a new one:

1. Select a memo and click on the **Set Type** button.
2. Select one of the existing types to change the current one, or enter a new one in the field: Memo type.

Opening An Existing Memo

If you want to review or continue to work on a memo, double-click the memo either in the Project Explorer, the Memo Manager or in the margin area if you have linked a memo to a quotation.

Linking Memos

Memos can be linked to other memos, quotations and codes. When writing up your analysis, you probably come across segments in your data (quotations) that nicely illustrate the points you are making in the memo. In order not to lose these quotations, you can link the memo to them.
Different from hyperlinks (quotation-quotation links), memo-entity links cannot be named. See “First and Second-Class Links” for further detail.

**Linking Memos To Quotations**

Drag and drop a memo from the Memo Manager or from the navigator onto a quotation (the highlighted area), or the quotation bar in the margin area.

If you drop a memo onto a code in the margin area, the code will be replaced.

Figure 263 illustrates the various options. In the margin area, the memo link shows the magenta colored memo icon. In the Memo Manager you see the Groundedness count going up. If you successfully linked a memo to a quotation. See “Groundedness And Density Counts For Memos” for more information.

You can also link a quotation from the Project Explorer or the Quotation Browser to a memo via drag & drop.

Another option is to drag a quotation from the Quotation Manager to a memo in the Memo Manager to link the two; or vice versa from the Memo Manager to the Quotation Manager.

**Reviewing Linked Quotations**

To review linked quotations, hold down the `Ctrl` key + double-click. Then the list of linked quotation opens.

**Linking Memos To Memos**

You can link two memos to each other via drag and drop in the memo manager, or by linking them in a network editor. See “Linking Nodes” for further information. If you successfully linked a memo to a memo, the density count goes up. See “Groundedness And Density Counts For Memos”
You can also link a memo from the Project Explorer or the Memo Browser to a memo in the Memo Manager or margin area via drag & drop. This also works the other way around.

**LINKING MEMOS TO CODES**

You can link a memo to a code in a network editor (see "Linking Nodes"), or via the various drag-and-drop operations:

You can link a memo from the Project Explorer or the Memo Browser to a code in the Code Manager or a floated Code Browser via drag & drop. This also works the other way around, dragging a code from the Code Manager or floated Code Browser to a memo in the Project Explorer or Memo Browser.

You know that the drag-and-drop operation was successful if you see the pop-up note confirming the operation and if you see the density count for memos going up. See *Groundedness And Density Counts For Memos.*

Please note, if you drag-and-drop a memo on top of a code in the margin area you replace the code with the memo.

**Groundedness And Density Counts For Memos**

- **Groundedness** indicates the number of quotation a memo is linked to.
- **Density** indicates the number of memos and codes a memo is linked to.

Which entities are linked to the memo can be seen in the Project Explorer on the left or in a network.

**Viewing Memo Links in a Network**

You can look at the links you have created between memos and other entities in a network. Networks are explained in detail in the section "Working With Networks." Below we only want to offer a preview of how you may want to integrate the network function when working with memos.

The easiest way to open a network for a memo is to right-click on a memo (no matter where you are - you can select a memo in the margin area, the Memo Manager or the navigator) and select **OPEN NETWORK** from the context menu.

Figure 266 shows the memo 'RQ2: positive and negative effects of parenting' and its links to two quotations and four codes.
Using Memos as Document

Memos can be assigned as documents to a project. You may want to consider this option if you want to code the memo. This is how you do it.

Select a memo in the Memo Manager.
Select the Convert to Document button in the ribbon, or from the context menu.

The memo is now added to your list of documents. You can continue to use the memo as memo (this is different from version 7, where a memo that was converted to a document could not longer be edited).

The memo comment is not transferred. It is treated independently of the comment that you may want to write for the memo document.

Querying Data

All exercises described in this chapter are based on the sample project Children & happiness (stage 2). You can download and import it if you want to follow along.

There are several ways to query data. You already learned the steps for a simple retrieval based on one code, and based on multiple codes using the Boolean operators AND or OR (see “Retrieving Coded Data”). In the following, four further ways of querying data are shown:

- **Code-Document Table:** Looking for code frequencies (and content) across documents or document groups
- **Code-Cooccurrence Explorer and Table:** Looking for code cooccurrences. You might also think of it as a cross-tabulation of codes;
- **Query Tool:** Looking for combinations of codes using Boolean, proximity or semantic operators
- **Global Filtering**

Overview Of Analysis Tools

**Codes-Primary-Documents-Table:** This table is a cross-tabulation of codes or code groups by documents or document groups. It shows how often a code (codes of a code group) has (have) been applied to a document or document group. See "Code Document Table."

**Co-occurrence tools:** Different from the query tool, where the results are quotations, you can use the two co-occurrence tools to find overlapping codes. The tree explorer list all codes on the first level of the tree and if there are more codes that have been applied to the same or overlapping quotations, then you can open the tree branches to see those codes. If you open the tree further, the associated quotations are shown. The second tool, the table explorer, shows a cross-tabulation of codes and within the cells a frequency count of how often each pair of codes co-occurs and a coefficient that indicates the strength of the relation between the two codes. The cells also provide access to the data behind them. See "Code Co-occurrence Tools."
The Query Tool finds quotations based on a combination of codes like: "Show me all quotations where both Code A and Code B have been applied." Such queries can also be combined with variables in form of documents or document groups. This means that you can restrict a query to parts of your data like: "Show me all quotations where both Code A and Code B have been applied, but only for female respondents between the age of 21 and 30." See "The Query Tool."

Smart Codes are stored queries. They can be reused and always reflect the current state of coding, e.g. after more coding has been done or after coding has been modified. They can also be used as part of other query; thus, you can build complex queries step by step. See "Working With Smart Codes."

Smart Groups: Like smart codes, smart groups are stored queries based on groups. The purpose is to create groups on an aggregate level. For instance, if you have groups for: gender, age and location, you can create smart groups that reflect a combination of these like all females from age group 1 living in city X (see "Working With Smart Codes.")

Global Filtering: Global filters allow you to restrict searches across the entire project. If you set a document group as global filter, the results in the Codes-Document or Code-Cooccurrence Table will be calculated based on the data in the filter and not for the entire project. Global filters effect all tools, windows and also networks (see "Applying Global Filters For Data Analysis").

### Available Operators For Querying Data

Knowing about the available operators is important when using the code-cooccurrence tools, the query tool, for creating smart codes and smart groups.

**Set operators** allow combinations of keywords according to set operations. They are the most common operators used in information retrieval systems.

**Semantic operators** exploit the network structures that were built from the codes.

**Proximity operators** are used to analyze the spatial relations (e.g., distance, embeddedness, overlapping, co-occurrence) between coded data segments.

- Before using the Code-Cooccurrence Explorer or Table, you should be familiar with the "Proximity Operators."
- If you want to create smart groups, you need to know about "Set Operators," especially how to use the operators AND and OR.
- If you want to build queries or smart codes, you need to know them all.
- To know about "Semantic Operators" helps to understand relation properties (see "Transitives Relationship") in networks and how they can be queried.

### Set Operators

The following set operators are available: OR, AND, ONE OF and NOT.

- OR, AND and ONE OF are binary operators which need exactly two operands as input. NOT needs only one operand. However, the operands themselves may be of arbitrary complexity. Codes, code groups, or other smart codes can be used as operands: "(A OR B) AND (NOT C AND D)."

#### ONE OF (Exactly one of the following is true)

The ONE OF operator asks that "EXACTLY one of..." the conditions must meet. It translates into everyday "either-or." Example: All quotations coded with EITHER ‘Earth’ OR ‘Fire’ (but not with both).

#### AND (All of the following are true)

The AND operator finds quotations that match ALL the conditions specified in the query. This means you have applied two or more codes to the same quotation. Example: "All quotations coded with "Earth AND Fire". The AND operator is very selective and often produces an empty result set as it requires that the selected codes have all been applied to exactly the same data segment. It produces best results when combined with less restrictive operators or when the overall number of the available text segments is large.

#### OR (Any of the following are true)

The OR operator does not really match the everyday usage of 'OR." Its meaning is "At least one of..." including the case where ALL conditions match. The OR operator retrieves all quotations that are coded with any of the codes used in the expression. Example: "All quotations coded with "Earth OR Fire" will produce a result list that contains all quotations coded with ‘Earth’ and all quotations coded with “Fire’.

#### NOT (None of the following are true)

The NOT operator tests for the absence of a condition. Technically, it subtracts the findings of the non-negated term from all data segments available. Given 120 quotations in the project and 12 quotations assigned to code ‘Fire’, the query "NOT Fire" retrieves 108 quotations - those which are not coded with ‘Fire’. Of course, the operator can be used with an arbitrary expression as in the argument "NOT (Earth OR Fire)" which is the equivalent of "neither Earth nor Fire."

Venn diagrams are descriptive schemes for illustrating the different set operations associated with Set operators.

### Semantic Operators

The operators in this section exploit code-code links that have been previously established by linking codes via drag-and-drop in the Code Manager, or in a network (see "Working With Networks" and "Linking Nodes." While Boolean-based queries are extensional and simply enumerate the elements of combined sets (e.g., Love OR Kindness), semantic operators are intentional, as they already capture some meaning expressed in appropriately linked concepts (e.g., All Children of code (POSITIVE ATTITUDES)).
The **UP** operator looks at all directly linked codes and their quotations at higher levels - all parents of a code. The **DOWN** operator traverses the network from higher to lower concepts, collecting all quotations from any of the subcodes. Only transitive code-code relations are processed; all others are ignored (see "Transitives Relationship").

When building a terminology from your codes, use the ISA relation for sub-term links.

Like the OR operator, the **DOWN** operator may produce large result sets. However, because you make use of purposefully established links, the "precision" is likely better as compared to using OR. The **SIBLING** operator finds all quotations that are connected to the selected code or any other descendants of the same parent code. Example: "All quotations coded with Love or any other Positive Attitude, here: kindness (Figure 270 below).

![Figure 270: A hierarchy of concepts suitable for semantic retrieval](image)

Given such a network, the following queries would be possible:
- All children of code 'Positive Attitude' => {Q1, Q2, Q3, Q4, Q5}
- All children of code 'Negative Attitude' => {Q6, Q7, Q8}
- All children of Code 'Attitude' => {Q1, Q2, Q3, Q4, Q5, Q6, Q7, Q8}
- Siblings of code 'Positive Attitude' => {Q1, Q2, Q3, Q4, Q5, Q6, Q7, Q8}
- Siblings of code 'Negative Attitude' => {Q1, Q2, Q3, Q4, Q5, Q6, Q7, Q8}

**Proximity Operators**

Proximity describes the spatial relation between quotations. Quotations can be embedded in one another, one may follow another, etc. The operators in this section exploit these relationships. They require two operands as their arguments. They differ from the other operators in one important aspect: Proximity operators are non-commutative. This property makes their usage a little more difficult to learn.

Non-commutativity requires a certain input sequence for the operands. While "A OR B" is equal to "B OR A," this does not hold for any of the proximity operators: "A FOLLOWS B" is not equal to "B FOLLOWS A." When building a query, always enter the expressions in the order in which they appear in their natural language manifestation.

Another important characteristic for these operators is the specification of the operand for which you want the quotations retrieved. "A WITHIN B" specifies the constraint, but you must also specify if you want the quotations for the As or the Bs. This is done implicitly by the sequence. The code (or term) that is entered first is the one in which you are interested. If B's quotations are requested, you have to enter "B ENCLOSES A" using the query language described below.

**Embedding Operators**

The embedding operators describe quotations that are contained in one another and that are coded with certain codes. **Quotations enclosing quotations:** A ENCLOSES B retrieves all quotations coded with A that contain quotations coded with B. **Quotations being enclosed by quotations:** A being enclosed by B (WITHIN) retrieves all quotations coded with A that are contained within data segments coded with B.
For example, if you want to retrieve all segments for 'hard work but: fulfillment' related to the code '#fam: have children', you would need to enter the query as follows (Figure 273):

If you were to enter the query the other way around (i.e., the code '#fam: have children' on the left hand side), the query tool would not deliver any results. If you are however interested in reading all quotations coded with '#fam: have children' that contain segments coded with 'hard work but: fulfillment', the query would need to look as follows:

You always need to enter the code whose content you are most interested in on the right-hand side of the query.

**Overlap Operators**

The overlap operators describe quotations that overlap one another:

**Overlaps (quotation overlapping at start):** A OVERLAPS B retrieves all quotations coded with A that overlap quotations coded with B

**Overlapped by (quotations overlapping at end):** A OVERLAPPED BY B retrieves all quotations coded with A that are overlapped by quotations coded with B.

**The Co-occurrence Operator**

Often when interested in the relation between two or more codes, you don’t really care whether something overlaps or is overlapped by, or is within or encloses. It this is the case, you simply use the COOCCUR operator. Co-occur is essentially a short-cut for a combination of the four proximity operators discussed above, plus the operator AND. AND is a set operator, but also finds cooccurrence, namely all coded segments that overlap 100%.
The query shown in Figure 275 retrieves all quotations that are coded with ‘#fam: 2 or more children’ that cooccur with quotations coded with codes in the code group ‘effects of parenting positive’ in whatever way.

The more general cooccurrence operator is quite useful when working with transcripts. In interviews, people often jump back and forth in time or between contexts, and therefore it often does not make much sense to use the very specific embedding or overlap operators. With other types of data they are however quite useful. Think of video data where it might be important whether action A was already going on before action B started or vice versa. Or if you have coded longer sections in your data like biographical time periods in a person’s life and then did some more fine-grained coding within these time periods. The WITHIN operator comes in very handy in such instances. The same applies when working with pre-coded survey data where all questions are automatically coded by ATLAS.ti. Using the WITHIN operator you can ask for instance for all quotations coded with ‘topic x’ WITHIN ‘question 5’.

**Adjacent Operators**

The distance operators describe a sequence of disjointed quotations.

- **Quotations following quotations**: A FOLLOWS B retrieves all quotations coded with A that follow quotations coded with B.
- **Quotations preceding quotations**: A PRECEDES B retrieves all quotations coded with A followed by quotations coded with B. Currently the base unit is 1 (character or second). In future versions you will be able to specify a user-defined distance.

**Code Document Table**

The table contains either a frequency count for each code or code group per document or document group, or a word count of the coded segments.

A useful application is a comparison across different groups of documents for a particular category of codes. Thus, you are likely to create such a table if you have a certain research question in your mind.

**Opening The Tool**

To open the tool, select the **Analyze** tab and click **CODES-DOCUMENT-TABLE**.

**An Example Query**

In the following we present an example query based on the *Children & Happiness - stage 2* sample project. If you want to follow along, the project can be downloaded [here](#).

In the example we compare statements about positive and negative effects of parenting across two documents. The documents represent comments from readers of a parenting blog and from readers of an article that was published in the New York Time Magazine on the topic of children and happiness.

After opening the tool, select codes or code groups and documents or documents groups to populate the cells in the table.
The context menu in each selection list facilitates selection. See Figure 277.

To generate the table in Figure 279, all codes with the prefix ‘effects pos’ were selected. Entering a prefix in the Search field above the selection lists will facilitate finding the items you are interested in.

Further the two documents D3 and D5 were selected. In the ribbon, the option Codes as Rows was set.

The results in the table cells show how often each selected code was applied in each document (= the number codings). If you click on a cell in the table, the quotation content is shown. You can select between list or preview option. In addition, it is possible to export the quotations from there, currently in Excel format.

Next to each code, you see how often the code was applied in total in the entire project. If you select a code group, you see the total number of codings for all codes in the code group. Below the documents, you see the total number of quotations in each document. If you select a document group, the number of quotations plus the number of documents in each group is shown.

This additional information allows you to better evaluate the numbers inside the table cells. If the value in the table cell is 10, but the code overall was applied 100 times, this leads to a different interpretation as if the code was only applied 12 times in the entire project.

When looking across documents, the total number of quotations gives you a hint whether it is better to normalize the data. The same applies when comparing document groups. The number of documents in a group in combination with the total number of quotations gives you an indication whether normalization will give you a better comparison. See “Normalization and Relative Frequencies in the Code-Document Table.”

**Code-Document Table Options**

- **Show Lists:** If you only want to see the table and not the selection lists, deactivate this option.
- **Refresh:** If the table is open and you change some coding, you can click the ‘Refresh’ option to update the results.
- **Row Totals:** Display the row total table
- **Column Totals:** Display the column total in the table
- **Normalize:** If documents are of unequal length, or document groups are of unequal size, you can normalize the data. This means the number of codings per documents that are selected for the table are adjusted. As base the document with the highest number of codings for the selected codes is used. For example, if you compare two documents and the total number
of codings for the first document is 100 and for the second document it is 50, then all codings of the selected codes for the second document are multiplied by $100/50 = 2$. Below an example is shown.

**Binarize:** This option reduces the table to the information whether a code, or codes of a code group, occurs or do not occur in a document or a document group. If they occur a black dot is shown; if not, the cell is empty. When you export the table to Excel, the dots are 1s and the empty cells are 0s.

**Absolute Frequencies:** Display number of quotation occurrence per code or codes of a code group.

**Column Rel.-Frequencies:** Display relative frequencies based on the column codes. The total of each column will add up to 100%. See below for a more detailed description.

**Row Rel.-Frequencies:** Display relative frequencies based on the row codes. The total of each row will add up to 100%. See below for a more detailed description.

**Table Rel.-Frequencies:** Display relative frequencies based on all codes used in the table. The totals of all row and column codes will add up to 100%. See below for a more detailed description.

**Count Codings:** Count the number of times a code has been applied to a quotation. Please note, The number of codings can be higher than the number of quotations as you can apply multiple codes to one quotation.

**Count Words:** Count the words of the quotations coded by code or codes of a code group.

**Compress:** This is a quick way to remove all rows or columns that only show empty cells. This is the same as manually deactivating codes or documents that yield no results. Thus, you cannot “uncompress” a table.

**Codes as Rows:** Display all selected codes / code groups in the rows of the table.

**Codes as Columns:** Display all selected codes / code groups in the columns of the table.

**Details:** You can deactivate the quotation count that is shown after each code/code group, or below each document / document group. Currently it is still included when you export the table to Excel.

**Export:** You can export the table to Excel, as plain text file, and as graphic file (see Figure 278).

**VIEW OPTIONS**

![Code-Documen Table View options](image)

**Show Lists:** If you only want to see the table and not the selection lists, deactivate this option.

**Refresh:** If the table is open and you change some coding, you can click the ‘Refresh’ option to update the results.

**Autosize Columns:** Adjust the size of the columns automatically so that the full label is shown.

**Freeze First Column:** Set if you do not want the auto size option to affect the first column.

**Set Column Size:** You can manually set the column size. 100 means that the column is as wide as the full label.

**Normalization and Relative Frequencies in the Code-Document Table**

Relative frequencies are useful for comparing code distributions across or within groups (cases) as percentages are easier to comprehend. If documents are of unequal length, or if document groups have an unequal number of members, it is recommended to normalize the counts as absolute counts may distort the results.

**Within Group Comparison - Column Relative Frequencies**

In the example below the two document groups gender::female and gender::male are compared. As indicated by the red numbers (not displayed by ATLAS.ti), there are more females than males. Thus, for a comparison across groups we need to normalize the data. For comparing the distribution of codes within a group, this is not necessary. We can use the column relative frequencies for this.

Which relative frequency count you select depends on how you display the table. If the two document groups were listed as rows and the codes as columns, you would need to use row relative frequencies for a within group comparison.
You must read this table from top to bottom along the columns. It shows the distribution of the selected codes within the two document group. The results of the table could be summarized as follows: As reasons for not having children, women have mostly mentioned “self-centered” (58%) and “being there for others” (25%). For men, “self-centered” was also the main reason (60%), followed by “responsibility” (20%) and “not worth the trade-off” and “state of the world” (both 10%). Apart from the fact that these data are completely fictitious, this summary shows that percentages can inflate the results quite a bit. There is only one quote for “not worth the trade-off” and “state of the world”. In terms of percentage, it looks like a lot more. Use this option with care. It is very useful for larger data sets and if you have a higher number of quotations.

**ACROSS GROUP COMPARISONS - ROW RELATIVE FREQUENCIES**

To compare the distribution across the two groups, we get more accurate results if we normalize the data first as there are 13 female respondents and only 11 male respondents. Also the total number of quotations in the female group is higher.

Figure 282 shows the absolute frequencies of the codings after normalization. The codings for the document group gender::male have been multiplied by 12/10 = 1.2 so that the totals for both groups are the same.

For an easier comparison of the two groups, relative row frequencies can be calculated:

This table must be read from left to right. It allows you to compare the application of codes across documents or document groups. If we for example compare males and females with regard to how often they mentioned “self-centered” as reasons for not having children, than males mentioned it slightly more (50.7% as compared to 49.3% for females). The absolute count would let us conclude that they mention is slightly less (6 times as compared to 7 times for women).
Let's consider one more example. Document 3 is about twice as long as document 5 in the Children & Happiness sample project. Thus, the number of codings regarding a specific topic can be expected to be higher as well in document 3. If we compare how often positive and negative effects of parenting were mentioned in both documents, normalizing the data will give a more accurate picture.

Looking at the data without normalization it looks like that the readers of the NYTM article mention much fewer positive and negative effects of parenting. After normalization, this interpretation needs to be adjusted. The reader of the NYTM article mentioned more negative effects of parenting as compared to the readers of parenting blog (55% as compared to 45%) and only slightly less positive effects (47% as compared to 53%).

**Total Relative Frequencies**

If you select total relative frequencies, the calculation is based on the total number of codings all all selected codes in the table. In the example below, these are 178. When comparing how much readers of the parenting blog and the NYTM article have written about reason for having and not having children, then the distribution is as follows: readers of the parenting blog have given 68 / 178 = 60% of the reasons for having children and 32% of the reasons for not having children: readers of the NYTM article have contributed 44% of the reasons for having children and 44% of the reasons for not having children (the data have been normalized). Thus, comparatively, the readers of the NYTM articles have given quite a bit more reasons for not having children, which fits the results reported above that they also wrote more about negative effects of parenting.

You can display all values: absolute frequencies and all relative frequencies in one table by selecting all options. It depends on the purpose for which you want to use the table. For interpreting the data, it is probably easier if you look at each of the relative frequency counts separately. But for a comprehensive report for an appendix, you may want to export the table with all options included.

**Binarize The Results Of A Code-Document Table**

At times, you might only be interested to see whether a code occurs in a document or not. If so, you can activate the option „Binarize”. The table will show black dots if a code or codes from a code group have been applied to a document or document group. If it has not been applied, the cell is empty. If you export the table to Excel, the Excel tabel shows 1s and 0s. The row and column totals count the number of yes / no occurrences. Such a table can for instance be used for discriminant analysis in a statistical program.
The exported table looks as follows:

![Table Image](image_url)

**Code Co-Occurrence Tools**

The Code Cooccurrence tools allows to ask a different type of questions. Using this tool, you can ask ATLAS.ti to show you all codes that cooccur across all of your primary documents. The result is a cross-tabulation of all codes.

As compared to the Query Tool where the user has to determine and select codes or code groups and the appropriate operator, the Co-occurrence Explorer by default looks for all codes that co-occur in the margin area combining the operators WITHIN, ENCLOSES, OVERLAPS, OVERLAPPED BY and AND.

Code Cooccurrences can be displayed in a tree view ("Code Co-Occurrence Explorer," or as a data matrix ("Code Co-Occurrence Table"). The Explorer in addition to code cooccurrences also displays documents and their quotations and codes.

**Code Co-Occurrence Explorer**

To open the tool, select the **ANALYZE** tab and click **COOC EXPLORER**.
The Code-Cooccurrence Explorer can also be loaded from the Home tab into the navigator on the left hand side by clicking on the drop-down arrow of the Navigator button.

After opening the tool, you only see the root objects.

Open the branches by clicking on arrow in front the root for Codes or Documents.

You will see the list of codes on the first level, if you expand the tree further, you see all co-occurring codes, and on the third level the quotations.

When you open the Documents branch, you see all project documents on the first level, followed by codes that have been applied to the document on the second level and the quotations coded with those codes on the third level.

Expand: If you select Codes, you can automatically expand to the code level, the cooccurrence level or the quotation level.

If you select Documents, you can automatically expand to the document level, the cooccurrence level or the quotation level.

Collapse: Collapse all levels back to the root.

Word List: Create a word list of a selected entity. Multiple selections by holding down the Shift-key are possible.

Word Cloud: Create a word cloud of a selected entity. Multiple selections by holding down the Shift-key are possible.

Auto Coding: Thus button is only active if you select a document. Multiple selections are not possible.

In the above example, you can see all codes that cooccur with the code ‘source (of happiness): children’. We can see that it was mentioned by people commenting on the blog or the NYTM article, by those with children (1 or 2 children), by female respondents mentioning some effects of parenting and some reasons for having children, plus as additional source of happiness ‘relationships’.

To see the data that were coded with the co-occurring codes, you can either double-click the code- all quotations coded with that code are opened in a list – or you can expand the tree to the quotation level (see Figure 292):
With a double-click on a quotation, it is displayed in the context of the document. In the section "Number Of Hits And Number Of Involved Quotations" it is explained how to interpret the listed quotations. If you want a count of the number of quotations that co-occur, we recommend to use the Code Co-Occurrence Table.

We recommend to use the Code Co-occurrence Explorer to get a quick overview where there might be interesting overlaps in your data. For accessing the quotations of co-occurring codes, the Code-Cooccurrence Table is better suitable.

**Document Tree**

The document tree shows all codes that have been applied to a document. If you expand the tree further, you see the quotation coded by these codes. The example shown in Figure 293 compares the coding of case 2 and case 3, which are responses to two survey questions.

**Code Co-Occurrence Table**

The Co-occurrence Table in comparison to the Explorer shows the frequencies of co-occurrence in form of a matrix similar to a correlation matrix that you may know from statistical software.

To open the tool, select the **Analyze** tab and click Codes-Document-Table.

Next, as indicated on the screen, you need to select the codes that you want to relate to each other:
As soon as you select at least one row code and one column code, the table fills with content. The results are displayed immediately:

The context menu in each selection list facilitates selection. See Figure 295.

To select an item, you need to click the check-box in front of it. It is also possible to select multiple items via the standard selection techniques using the Ctrl or Shift-key. After highlighting multiple items, push the space bar to activate the check boxes of all selected items, or right click and choose CHECK SELECTED FROM the context menu.
RESULTS OF A CODE CO-OCCURRENCE QUERY

The number in the cell indicates the number of hits, how often the two code co-occur. See "Number Of Hits And Number Of Involved Quotations" for more information.

If you click on a cell, the corresponding row and column codes and their quotations are displayed at the bottom of the window.

You can change between list and preview mode and you have an option to export the quotations. If you double-click on a quotation, you can view it in the context of the document.

CODE CO-OCCURRENCE TABLE OPTIONS

Show Lists: If you only want to see the table and not the selection lists, deactivate this option.
Refresh: If the table is open and you change some coding, you can click the 'Refresh' option to update the results.
Color: You can choose among three colors for the table cells (blue, red and green) and no coloring. If you select a color, the table cells are colored in different shades. The lighter the color, the higher the number in the cell.
Show count: Show the number of co-occurrences (=number of hits, see below).
Show Coefficient: The \( c \)-coefficient can only be meaningfully interpreted with larger data sets, or a large number of quotations per case, e.g. if you code video data very fine-grained. Therefore it can be activated or deactivated. See "C-Coefficient" for more detail.
Cluster quotations: If you want to count embedded quotations as only one count (compare "Embedding Operators"), activate this option.
Compress: This is a quick way to remove all rows or columns that only show empty cells. This is the same as manually deactivating codes that yield no results. Thus, you cannot "uncompress" a table.
Rows => Columns: Select to switch row and column codes.
Auto Size Columns: Adjust the size of the columns automatically so that the full label is shown.
Freeze first column: Set if you do not want the auto size option to affect the first column.
**Set Column Size:** You can manually set the column size. 100 means that the column is as wide as the full label.

**Details:** If activated, you see the total number of times the code has been applied to a quotation. This helps you to better evaluate the numbers in each cell. The interpretation is likely different if two codes co-occur 10 times, if each of the codes have been applied 50 or only 15 times.

**Export:** You can export the table to Excel (see Figure 299). If 'Show Count' is selected, only the number of co-occurrences are exported. If 'Show Coefficient' is selected, only the c-coefficient and not the absolute number of hits are exported. If you have selected both, both are exported:

<table>
<thead>
<tr>
<th>Item</th>
<th>Count</th>
<th>Coefficient</th>
<th>Count</th>
<th>Coefficient</th>
</tr>
</thead>
<tbody>
<tr>
<td>children: &lt;happiness</td>
<td>2</td>
<td>0.65</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>children: level of happiness</td>
<td>6</td>
<td>0.57</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>children: &gt;happiness</td>
<td>6</td>
<td>0.35</td>
<td>4</td>
<td>0.13</td>
</tr>
</tbody>
</table>

Figure 299: Excel export of the code co-occurrence table

**Number of Hits and Number of Involved Quotations**

The co-occurrence frequency does not count single quotations it counts co-occurrence "events." If a single quotation is coded by two codes, this would count as a single co-occurrence. In case of overlap, thus when each of the two quotations is coded by one of the codes, this also counts as a single co-occurrence. Therefore two lists of quotations are displayed when you select a cell: the quotations of the column code and the quotations of the row code.

The second co-occurrence is a 100% overlap, thus an AND occurrence as the two codes code the same quotation: 3:32.

Figure 300: Quotations resulting from two co-occurring codes

The first and third co-occurrence is an overlap as the quotation IDs are different for both codes. In the context of the data, the overlaps for the third co-occurrence is as shown in Figure 301. Quotations 3:317 is embedded in the larger quotation and 3:236:

if you select one of the co-occurring quotations, it is highlighted. If you select the corresponding second one, the boundary of the second one is shown by the two orange dots.

The number of quotations can also be different in each list. This is the case if one code occurs two or more times within another one.

**C-Coefficient**

The c-coefficient indicates the strength of the relation between two codes similar to a correlation coefficient. This option can be activated in the ribbon of the Code Co-occurrence Table. The calculation of the c-coefficient is based on approaches borrowed from quantitative content analysis. The range of the c-coefficient is between 0: codes do not co-occur, and 1: these two codes co-occur wherever they are used. It is calculated as follows:

\[ c = \frac{n_{12}}{n_1 + n_2 - n_{12}} \]
n12 = co-occurrence frequency of two codes c1 and c2, whereby n1 and n2 are their occurrence frequency

Depending on your coding, you may experience the following:

• Distortion due to unequal frequencies: The frequency of the row code is more than 5 x higher than the frequency of the column code or vice versa.

• Out of range: The C-index exceeds the 0 - 1 range it is supposed to stay with.

DISTORTION DUE TO UNEQUAL FREQUENCIES

An inherent issue with the C-index and similar measures is that it is distorted by code frequencies that differ too much. In such cases the coefficient tends to be much smaller than the potential significance of the cooccurrence. For instance, if you had coded 100 quotations with code 'have children' and 10 with 'effects on career' and you had 5 co-occurrences:

\[ c = \frac{5}{100 + 10 - 5} = \frac{5}{105} = 0.048 \]

A c index of only 0.048 may slip your eye easily, although code 'effects on career' appears in 50% of all its applications with code 'have children'. Looking from code 'have children' only 5% cooccur with code 'effects on career'.

If the ratio between the codes frequencies exceeds a threshold of 5, the yellow light goes on in the cell. So whenever a cell shows the yellow marker it should invite you to look into the co-occurrences of this cell despite a low c-index.

OUT OF RANGE

The c-index (structurally resembling the Tanimoto and Jaquard Coefficient, which are similarity measures) assumes separate non-overlapping text entities. Only then can we expect a correct range of values.

However, ATLAS.ti’s quotations may overlap to any degree. Overlaps would only then bear no problem if there wasn’t any coding redundancy. Let’s look at a few scenarios.
Example 1: Two differently coded quotations overlap. We assume no more quotations available. Let P1 be a textual document, q1 and q2 = quotations, and a, b = codes. q1 is coded with a, q2 is coded with b.

Using the formula: \[ c = \frac{n_{ab}}{n_a + n_b - n_{ab}} \]

\[ n_{ab} = 1 \] one co-occurrence of a and b

\[ n_a = 1, n_b = 1 \] a and b each code exactly one quotation.

\[ c = \frac{1}{(1 + 1 - 1)} = 1 \]

Such a scenario results in the maximum co-occurrence of 1!

Example 2: q1 is coded with both codes a and b. The overlapping quotation q2 is coded with b.

\[ n_{ab} = 2 \] q1 alone counts for a co-occurrence event and the overlapping q1*q2 for another.

\[ n_a = 1, n_b = 2 \]

\[ c = \frac{2}{(1 + 2 - 2)} = 2 \]

This results in a value of twice the allowed maximum. Thus, the C index is not appropriate to correctly represent co-occurrence in redundantly overlapping texts. If the c-coefficient exceeds 1, you need to do some cleaning up and eliminate the redundant codes (see "Finding Redundant Codings."). ATLAS.ti currently does not correct such redundancies automatically.

In order not to present a misleading image, all cells displaying an out-of-range number (> 1) show a red dot in the top right corner.

Correcting the redundant overlaps, could for example look like this:

\[ n_{ab} = 2, n_a = 2, n_b = 3 \]

\[ c = \frac{2}{(2 + 3 - 2)} = \frac{2}{3} = 0.67 \]

The result is within the allowed range and it correctly takes into account that of the three possible co-occurrence events only two apply. a.
Summary Of Color Indicators

Yellow dot: Unequal quotation frequencies - the ratio between the frequencies of the code and row code exceeds the threshold of 5.

Red dot: The C-index exceeds the 0 - 1 range.

Orange dot: The orange circle is simply a mixture of the red and yellow conditions.

This video tutorial explains the co-occurrence concept in ATLAS.ti and shows how to examine them qualitatively and quantitatively.

APPLICATION

The two Co-occurrence Tools are very useful for many kinds of analysis. But not all options make sense for all type of data. If you have a smaller data set like a typical interview study with 10 to 20 respondents, then taking a look at the frequency count for exploratory purposes is likely to provide some new ideas and where to pursue the analysis.

The c-coefficient is useful when working with larger amounts of cases and structured data like open-ended questions from surveys. If you use the c-index, pay attention to the additional colored hints. As your data base is qualitative, the c-coefficient is not the same as for instance a Pearson correlation coefficient and therefore also no p-values are provided.

In any case, co-occurrence measures need to be clearly understood, not only for the mechanical but also for semantic issues involved in their meaningful interpretation (e. g., mixed application of codes with different level like broader and sub terms). Furthermore, you need to be aware of the artifacts enforced by a table approach like being reduced to a pairwise comparison. Higher order co-occurrences which would take more than two codes into account need more elaborate methods.

The Query Tool

Video Tutorial: ATLAS.ti 8 Windows: The Query Tool

The Query Tool is used for retrieving quotations using the codes they were associated with during the process of coding. This is different from a text search: To search for occurrences of text that match a specified pattern or string. For this you need to use "Project Search."

The simplest retrieval of this kind - search for quotations with codes- is what you frequently do with the Code Manager: double-clicking on a code retrieves all its quotations (see "Simple Retrieval Using The Code Manager Or Navigator"). This may already be regarded as a query, although it is a simple one. The next level are the "Simple AND And OR Queries In The Quotation Manager." The Query Tool is more complex in that it can be used to create and process queries that include a variety of combinations of codes.

A query is a search expression built from operands (codes and code groups) and operators (e. g. NOT, AND, OR, etc.) that define the conditions that a quotation must meet to be retrieved (e. g., all quotations coded with both codes A and B).

By selecting codes or code code groups and operators, a query can be built incrementally which is instantaneously evaluated and displayed as a list of quotations. This incremental building of complex search queries gives you an exploratory approach toward even the most complex queries.

To open the tool, select the ANALYZE tab and click QUERY TOOL.
The query tool ribbon contains all “Available Operators For Querying Data,” plus a few options that help you build a query like adding a code, changing an operator or saving a smart code. These options are explained below when explaining how to build and edit queries.

At the left-hand side you see the list of codes and code groups that can be used as operands in a query. The main space is reserved for displaying the query and the results. Remember the results of a query in the query tool are always quotations.

At the top right-hand side you find the report button to export the results of a query.

The tool is best understood when actually seeing how queries are build. Therefore in the following a few example queries are shown.

How To Build A Query Using Set Operators

**Question:** Find all quotations where people talk about cultural embedded believes and focusing illusion as reasons for having children.

**First step:** Select the operator OR in the ribbon.

**Second step:** Select the code ‘reason for hc: cultural embedded believes’ in the list of codes and double-click, or click on the button Add Code in the ribbon. Drag-and-drop is currently not supported. Note the change in the query term.

**Third step:** Click on the second place holder to make it the active node. You recognize an active note by its blue frame (see left).

**Fourth step:** Select the code ‘reason for hc: focusing illusion’ in the list of codes and double-click, or click on the button Add Code in the ribbon.
Above the query you see the full query term:

Below you see the list of resulting quotations. The blue status bar shows the total number of quotations this query results in (Figure 314). You can change between list and preview mode. Double-click to view a quotation in the context of the document or export them to Excel.

**Displaying Partial Results**

You can list the quotations of any element in the query. If you click on the code “reasons for hc: focusing illusion” only the quotations of this code will be displayed in the result list. The currently active part of the query has a blue frame and the number of resulting quotations is displayed in the status bar.

**Reading The Results**

You can switch to preview mode. This option works well if your quotations are not long. For longer quotations, double-click a quotation in the result list and read the quotation in context, or you create a report.
VIEWING RESULTS IN CONTEXT

If you have a big screen you may want to work with a floating query tool and place the query tool next to the ATLAS.ti main editor to browse through the results. If your screen is smaller, it may be more convenient to dock the query tool window and to place it into a second tab group. This way you can view the query tool and the documents side-by-side. See "Working WithDocked And Floated Windows" and "Working With Tabs And Tab Groups."

Creating A Report

To export the data to Excel, you can click on the report button on the top right-hand side of the quotation list (see Figure 314).

To create a text report, click on the Report button in the ribbon. The drop-down menu offers the following options:

- **Report:** This is a report that you can customize. It is explained in more detail in the section "Creating Reports." An example is shown below.
- **List:** Use this output for audio and video data that have no text content. Only the reference, the quotation ID and name are included in the report. It can also be a useful option if you have started your analysis utilizing the quotation level, renaming and commenting quotations instead of coding right-away.
- **List With Comments:** Same application as the List output including comments. If you have made extensive use of comments to describe your data segment, this output option is useful.
- **Full Content:** Includes the full content of text and image quotations, plus the full quotation reference, any codes, memos and hyperlinks that apply.
- **Content plus Comments:** Includes the full content of text and image quotations including comments, the full quotation reference, any codes, memos and hyperlinks that apply.

To create a report that contains the quotations shown in the list of results in Figure 316, click the Report button. Select ‘Content’ if you only want to read the quotations in full. Add ‘Codes’ if you want to see which other codes have been applied to the quotations.

Click CREATE REPORT.

Creating Document Groups From Results

When you add documents to a project, it is easy to create document groups based on sample characteristics like gender, age, profession, location, etc. But at times, you first need to code the data to find relevant information like years of working experience, special skills, attitudes about something, relationship to other people, etc. For this you need an option to create document groups based on query results. E.g. you query all documents where people have mentioned that they have more than 10 years of working experience. Based on in which document the quotations occur, ATLAS.ti creates a document group.
You can enter a name for the document group after clicking on the button New Document Group. The document group will then be shown in the Project Explorer and the Document Manager:

![New document group created based on a query result](image)

**How To Build A Query Using Proximity Operators**

**Question:** Find all quotations where people who have more than two children talk about how to define happiness.

**First step:** Select the operator **Co-occurs** in the ribbon

**Second step:** As we want to read only the segments where those with two children talk about how to define happiness, we first need to select the code group ‘definition happiness’. If we were to enter the code ‘fam: 2 or more children’ on the right hand side, we would get the entire response of all respondents with two children and not only the parts where they talk about the definition of happiness. Compare “Proximity Operators.”

![Adding the code to the query whose quotation we want to read](image)
If you got the operands the wrong way around, you can swap them by clicking on the Swap button in the ribbon.

**Third step:** Click on the second placeholder to make it the active node. You recognize an active note by its blue frame (see left). Select the code ‘#fam: 2 or more children’ in the list of codes and double-click, or click on the button **Add Code** in the ribbon.

The query results in six quotations.

---

Next, we want to show how to build a query that contains two operators. The question that should be examined is as follows:

**Question:** Do parents who report negative aspects of parenting also talk about positive aspects?

- **First step:** Select the operator: **Co-occurs**
- **Second step:** As for this query in the first step, we want all segments where parents write about negative effects of parenting, select the ‘#fam: have children’ code via a double-click to be entered in the node on the left hand side.

On the right-hand side, you enter the code group ‘effects of parenting negative’.

---

As we only want to find comments where parents both raise positive and negative issues around parenting, we need to extend the query further:

- **Step 4:** Make sure that the cooccurrence node is the active element in the query. You will see a blue frame around it. Now select the **Co-occurs** operator again.
Select the code group 'effects of parenting positive' to complete the query.

The resulting number of quotations for this query is 7. Thus, seven respondents have written about both positive and negative effects of parenting. You can review the results in context, or create a report if you prefer to read all quotations in an editor.

Another option is to store the query as a smart code for further re-use:

- Click on the **Save Smart Code** button in the **Query Tool** tab.
- Enter a name for the smart code and click **Create**. If the query result is needed to answer a particular research question, this could be reflected in the name, e.g. Research question 3: positive & negative views on parenting.

You can now review all quotations of this query at any time that is convenient, e.g. in the Code or Quotation Manager. Smart codes can be recognized by the gray dot at the bottom left hand side of the code icon. See "Working With Smart Codes" for further information.

**How To Build A Query Using Semantic Operators**

The use of semantic operators requires that you have linked codes to each other using transitive relations. See "Semantic Operators" and "Transitives Relationship" for more detail.

An Example will be added later.

**How To Build A Query Using A Combination of Operators**

With the following query we want to show you how you can exchange terms to modify the original question to examine various aspects of it.
**Question:** Find all blog comments where respondents express the opinion that children bring greater happiness, but at the same time also report negative effects of parenting.

The resulting query should then be modified:

- to find blog comments where respondents express the opinion that children bring greater happiness and also write about positive effects of parenting.
- to find blog comments here respondents express the opinion that children lower happiness and write about negative effects of parenting.
- to find blog comments where respondents express the opinion that children lower happiness, but at the same time report positive effects of parenting.

**First step:** Select the operator **Encloses** in the ribbon. On the left-hand side enter the code ‘#blog entry’ and on the right-hand side the code ‘children: > happiness’

**Second step:** As the blog entry should also contain comments on negative effects of parenting, we need to find matching blog entries. This means we need to select the operator **AND**. The new node we use to enter a new query that finds the matching blog entries that we are looking for.

**Third step:** Click on the new node to make it the active node. Select the **Encloses** operator again.
Fourth Step: On the left-hand side enter the code '#blog entry' and on the right-hand side the code group 'effects of parenting negative', ATLAS.ti finds one quotation.

And this is the blog entry which fit the criteria, we have been looking for:

"You can't expect someone else to "make you happy." I agree with others in that you have to find your own happiness. The love a child has filled and brought joy to my heart more than any other event or accomplishment in my life. I have never felt more needed than when I was a child. Children don't come with a manual. It is very hard and depends on the temperament of the baby and parent. We also have my help-PARENT's or relatives that can help balance work/home school closings. Not having a partner or people you can trust with your child makes situations or circumstances difficult from time to time."

Rotating the Query Layout

You can rotate the layout of a query by clicking on the Rotate Layout button in the ribbon.
MODIFYING EXISTING QUERIES

Next, we want to find all blog entries where respondent believe children make you happier and at the same time also write about positive effects of parenting.

Select the node with the code group ‘Effects of parenting negative’ and click on the DELETE button in the ribbon.

Click on the empty node so it is activated and select the code group “Effects of parenting positive”. ATLAS.ti finds 4 blog entries this time.

The other two modifications look as follows – you exchange the code ‘children: > happiness’ with ‘children: < happiness’, and also match it with blog entries that either contain comments on positive or negative effects of parenting.

Document And Group Comparisons In The Query Tool

You can also use the query tool, if you want to restrict a search to a particular document or document group, e.g. because you are interested in comparing male and female respondents based on what they have said about particular issue. The query can be as simple as querying a single code in combination with a document or group, or you build a query first before you set a scope.

As before, we demonstrate this feature by way of example. In the following exercise, we will only query a single code in relation to either a document or document group.

Question: Find all quotations where respondents define happiness. Subsequently we would like to compare what people wrote on the parenting blog (D3) and what people wrote who commented on the NYTM article (d4).

After starting the query tool, select the code group ‘definition happiness’ with a double-click. This retrieval results in 20 quotations that you see at the bottom right in the blue status line.
To filter the result list by documents or document groups, switch to the Scope Tool ribbon and click on the button **Edit Scope**.

After selecting the Edit Scope option, an additional region opens on the left-hand side.

As scope select document 3 is selected (double-click). This filters the list of quotations in the result pane at the bottom right. Also the information in the blue status bar changes and the scope is added above the query term.

With the scope set to document D3, the number of resulting quotations is 11. In addition, ATLAS.ti provides the total number of quotations of the term that you have set as scope (here: the 320 quotations of document D3). The term can be as simple as just one document or document group. You can however also build a more complex scope using Boolean operators (AND, OR, ONE OF and NOT).

To change the scope, click on the **Delete** button in the Scope Tool! This resets the scope.

If you want to delete a scope, pay attention that you are in the Scope Tool and not the Query tool. If you click the Delete button in the Query Tool, your query is deleted.

### Working With Smart Codes

Smart Codes are a convenient way to store queries. They are very similar in look and feel to normal codes, with one important difference: instead of “hardwired” connections to quotations.
Smart Codes store a query to compute their virtual references whenever needed. They “automatically” change their behavior during the course of the analysis. If you have a Smart Code based on a query like

\[(\text{Code A} \mid \text{Code B}) \ \text{COCCUR} \ \text{Code C}\]

and you add or delete quotations linked to either Code A, B or C, then the smart code will automatically be adjusted. Smart Codes can be selected in code lists like any other code and they will display their quotations in an identical way.

Smart codes are displayed in the Code Manager just like regular codes and can be recognized by a gray dot at the bottom left of the code icon.

The list of quotations associated with the Smart Code can be displayed with a double-click, just as for any other code. Frequencies/density are only shown if the smart code has been activated at least one time during a session, e.g. with a double-click in the Code Manager.

If you start a new session, an asterisk (*) replaces the frequency count. The reason for this is that a Smart Code is dynamic and its density/frequency count changes as soon as you modify any of the codes contained in the query of the Smart Code. For the same reason, Smart Codes are not displayed in the margin area.

Smart Codes can be used in code groups, networks, and, last but not least, as powerful operands in queries, allowing you to incrementally build complex queries.

There is the possibility to create a regular code from a Smart Code. See “Creating Snapshot Codes.”

What You Cannot Do With Smart Codes

As Smart Codes are not directly associated with quotations, certain restrictions apply.

Coding: The most important constraint is that you cannot associate them with quotations directly. Therefore, Smart Codes are not presented when doing “code by list,” and drag & drop onto data selections is prohibited.

Merging: Code Merge operations including Smart Codes are also not possible.

Prevent Cycles: If you created a Smart Code whose query contains a reference to a code group, you cannot assign this Smart Code to the code group later. This would create a cyclic structure and is therefore disallowed.
Creating Smart Codes

To create a Super Code, you must have already constructed a query using the "Query Tool." Note that because Smart Codes are 'intentional,' you can also create a valid and useful Smart Code with an empty results list (which might well change in a later stage of your analysis).

- Create a query in the query tool.
- Click the **Save Smart Code** button in ribbon.
- Enter a name for the new Smart Code or click **Create**.

The newly created Smart Code immediately appears in the list of codes and can be used for new queries (and also for other smart codes) right away.

Creating Smart Codes In The Quotation Manager

You can also create smart codes using an AND or OR combinations in the Quotation Manager. Here is an example:

The aim is to combine all comments written by those who either have no children yet or who do not want children.

- Open the Quotation Manager.
- Select the two codes '#fam: don't want children' and '#fam: don't have children yet' in the side-panel by holding down the Ctrl-key.
- In the yellow filter bar, select the operator ANY.

Creating Ored Smart Codes in the Code Manager

If you only need a simple OR combination or two or more codes a smart code, a quick way of doing it is in the Code Manager.

- Open the Code Manager, select two or more codes, right-click and select the option **Create Smart Code** from the context menu, or click on the **Smart Code** button in the ribbon.
Editing Smart Codes

If you want to see the query behind a smart code, or if you want to modify the query, you can edit a smart code. To do so:

1. Open the Code Manager, select the Smart Code and click on the button **EDIT SMART CODE**.
2. This opens the query tool where you can review and modify the smart code. Figure 342 shows the smart code that is shown to be created in Figure 341.

Creating Snapshot Codes

A Snapshot Code is a normal code that records the current state of a Smart Code by way of “hard-wired” links to the derived quotations. By creating a snapshot from time to time, you can analyze the development of a Smart Code. Unlike the Smart Code, a code created by the snapshot is displayed in the margin area and can be used for further coding.

The default snapshot code names are suffixed with [SN<number>].

1. Open the Code Manager.
2. Select a Smart Code and click on the button **CREATE SNAPSHOT** in the ribbon.

![Figure 341: Creating ORed smart codes in the Code Manager](image)

![Figure 342: Editing a smart code](image)

![Figure 343: A smart code and its snapshot](image)
Working With Smart Groups

Smart entities in ATLAS.ti are a convenient way to store queries. Smart Groups are very similar in look and feel to normal groups, with one important difference: instead of "hardwired" connections to their members, Smart Groups store a query to compute their virtual references whenever needed.

For example, if you have created a smart group "females + urban" and you add more data to your project that you assign to groups like 'female', 'male', 'rural' and 'urban'. When you select the smart group 'female + urban', ATLAS.ti runs the underlying query and displays all members that belong to this group.

You can create smart groups using the Set operators ANY or ALL (see also the section "Set Operators").

ANY: All items of all selected groups are included in the new a smart group. An example would be if you wanted to create a document group that combines the two groups 'work experience 1 to 3 years' and 'work experience 4 to 6 years'. Or if you want to combine the codes of two categories because you want to set them as filter. See "Applying Global Filters For data Analysis."

ALL: All common items of the selected groups are included in the new smart group (= all criteria must apply). An example would be females from urban areas.

To create a new smart group, open an entity manager. See "Launching An Entity Manager."

Select the desired operator first. Click on the operator button, or right-click in the side panel and select CHANGE OPERATOR.

Next select the groups that you want to combine and the desired operator from the down down menu as shown in Figure 70.

Right-click on one of the selected groups and select the option NEW SMART GROUP from the context menu. Accept the suggested name or enter a new one and click CREATE.

Smart entities can be recognized by the little gray circle at the bottom left of the icon. See left.

Creating A Snapshot Of A Smart Group

You can transform a smart group in a regular group by creating a snapshot. You can do this in the group manager.

Select the smart group in the Group Manager. Select the CREATE SNAPSHOT button from the ribbon.

Applying Global Filters For Data Analysis

Global filters are a powerful tool to analyze your data. As compared to local filters that you can invoke in each manager, global filter have an effect on the entire project. If you set a document group as global filter, also the results of the code-document table or the code-cooccurence table will also be effected. For example, if you cross-tabulate a code category ACTION with another code category OUTCOME, you can see which actions are related to which outcomes for all of your respondents. If you set the document group: 'gender: female' as global filter, the results of the table will change only showing which actions are related to which outcome for all female respondents.

In a code document table, it allows you to combine two variables without having to create a smart group. Given the above example, a code-document table including all ACTION codes by document groups “have children”, “do not have children”, the results will show the quotation frequency of all action codes for ‘female respondents with children’ vs. ‘female respondents without children’.

In network, all entities that do not pass the filter criteria will be faded out. Or, if you select the 'import neighbor' or 'import co-occurring' options, you can control the process by only importing entities that pass a given filter criteria.

An additional benefit is that you can focus your analysis on certain aspects of your project. All selection lists become shorter and if you know that you only want to work with 5 out of your 15 categories for the moment, you create a code group that only contains the codes that you want to work with at the moment and set this code group as global filter. Similarly you can create document groups if you want to focus on only a sub set of your documents for a given analytic task.

Currently only groups can be set a global filter. Other entities will be added in the future. If you want to set a single document or code as global filter, you need to create a group for it. This is a current work around until it is possible to also set single entities as global filter.
Creating A Global Filter

Creating a global filter means creating a group:
- Document groups as global filter filter out documents and their quotations.
- Code groups as global filter filter out codes, and memo groups as global filter filter out memos.

Setting Global Filters

Global filters can be set in the Project Explorer on the left and in each manager. Right click on a group and select the option Set Global Filter.

Display Of Global Filters

Similar to the visualization of local filters, global filters are also indicated by a colored bar.

Examples

In Figure 353 the global filter is combined with a local code filter (beige colored bar). This results in the following query: Show me all quotations of the code “reasons for nhc: self-centered” for all female respondents.
Figure 347: Network created with the support of global filters + filtered emphasize one area of interest (ATLAS.ti Mac)

Figure 347 Shows a network that has been created with the help of a global code filter. The question behind the network was: Which positive and negative effects of parenting have been mentioned by those with 1, 2 or 3 children.

These were the steps to create the network:

The data are comprised of 140 comments to a parenting blog and a NYTM article. Thus, there are many comments by different people in one data file. Therefore demographics like gender or number of children was coded.

In order to filter out all other aspects, a code group was created that only contained the three attribute codes (#fam: 1 child, #fam: 2 children, #fam: 3 or more children) + the effects of parenting codes. Subsequently this group was set as global filters:

The next step was to open a network for each attribute code and to import all co-occurring codes. As the global filter was set, only the ‘effects of parenting’ codes were imported.
These were linked with the attribute codes:

Based on these, a network with all three attribute codes was created. This was achieved by adding all attribute codes for number of children into one network and importing all code neighbors:

Figure 166 shows the resulting network using the organic layout and poly-line rerouting option:
Next, the global filter was changed to codes from the code group: ‘Positive effects of parenting’. All other effects are faded out in the background.

Global Filters In The Code Co-occurrence Table

Figure 355 Shows two code co-occurrence tables. The first one shows the various opinions about the relationship between children and happiness of those respondents with and without children that commented on the parenting blog. The second table shows the same for those commenting on the New York Times Magazine article. If you deactivate the filter, you see the results for the entire data set. This applies to the table as a whole and to the quotation list that you get per code at the bottom of the window.
Global Filters In The Code Document Table

Figure 354 shows two Code Document Tables. Here the reasons mentioned for having and for not having children across different educational levels and gender are compared.

Figure 353: Effect of global filtering on code co-occurrence table

Figure 354: Code Document Table with global filter setting
Activating / Deactivating Global Filters

Given the above example, if you want to see all quotations coded with "reasons for nhc: self-centered", you click on the check-box for the global filter.

![Deactivated global filter](image1)

Removing A Global Filter

If you change a global filter, the currently active filter is automatically reset.

If you want to remove a filter completely, click on the X on the right. The Project Explorer in the navigation area offers a convenient way to do so.

![Removing global filters in the Project Explorer](image2)

Working With Networks

Visualization can be a key element in discovering connections between concepts, interpreting your findings, and effectively communicating your results. Networks in ATLAS.ti allow you to accomplish all three of these important objectives. These small segments of your larger web of analysis are modeled using the network editor, an intuitive work space that we also like to think is easy on the eye.
The word “network” is an ubiquitous and powerful metaphor found in many different fields of research and application. Flow charts in project planning, text graphs in hypertext systems, cognitive models of memory and knowledge representation (semantic networks) are all networks that serve to represent complex information by intuitively accessible graphic means. One of the most attractive properties of graphs is their intuitive graphical presentation, mostly in form of two-dimensional layouts of labeled nodes and links.

In contrast with linear, sequential representations (e. g., text), presentations of knowledge in networks resemble more closely the way human memory and thought is structured. Cognitive “load” in handling complex relationships is reduced with the aid of spatial representation techniques. ATLAS.ti uses networks to help represent and explore conceptual structures. Networks add a heuristic “right brain” approach to qualitative analysis.

The user can manipulate and display almost all entities of a project as nodes in a network: quotations, codes, code group, memos, memo groups, other networks, documents, document groups and also all smart entities. The following discussion applies to all nodes regardless of their type. See “Node Types.”

Video Tutorials: ATLAS.ti 8 Windows-Visualizing Linkages in Networks and ATLAS.ti 8 Windows-Creating and Displaying Semantic Linkages

**Nodes And Links**

The term “network” is formally defined within graph theory, a branch of discrete mathematics, as a set of nodes (or “vertices”) and links. A node in a network may be linked to an arbitrary number of other nodes.

The number of links for any one node is called its degree; e. g., a node with a degree of zero is not linked at all. Another simple formal property of a network is its order: the number of its nodes. You may make practical use of the degree of nodes by using it as a sorting criterion in the codes list window. The column ‘Density’ in the Code Manager represents the degree of a code.

**Directed And Non-Directed Links**

Links are usually drawn as lines between the connected nodes in graphical presentations of networks.

Furthermore, a link between two nodes may be directed or not. A directed connection is drawn with an arrow. With directed links, source and target nodes must be distinguished. The source node is where the link starts and the target node is where it ends: the destination to which the arrow points.
Links are created either implicitly (e.g., when coding a quotation, the quotation is "linked" to a code), or explicitly by the user. See "Linking Nodes."

Strictly speaking, code-quotation associations ("codings") also form a network. However, you cannot name these links, the code is simply associated with a quotation through the act of coding. In a network you can visualize these links (Figure 358). In ATLAS.ti all unnamed links are referred to as second class links, all named links are referred to as first-class links.

First and Second-Class Links

First-class links are links based on relations. They are entities by themselves, with names, authors, comments, and other properties. They are available for a code-code links and quotation-quotation links. The latter are also called hyperlinks. See "Working With Hyperlinks."

Second-class links are links that do not have individual properties, e.g., the links between quotations and codes (Figure 359), between codes and memos, between a group and its members.

Relations

ATLAS.ti allows you to establish named links to more clearly express the nature of the relationships between concepts. With named links, you may express a sentence like "a broken leg causes pain" by two nodes (the source node "broken leg" and the target node "pain") connected with a named link ("causes" or "is-cause-of").

The name of a link is displayed in the network editor as a label attached to the link midway between the two connected nodes. Six pre-set relations are available in ATLAS.ti. These standard relations can be substituted, modified, or supplemented by user-defined relations.

ATLAS.ti Default Relations

The default relations that come with the software are listed in the table below. C1 and C2 are source and target nodes, respectively.
Some of these characteristics directly affect the display of links, while others affect processing (e.g., search routines, automatic layout). A link between concepts is displayed in a network editor by a line with the relation's label. You can choose from three different labels (name, short and symbolic).

The "formal attribute" affects both the display and processing capabilities of a relation. All transitive and asymmetric relations are symbolized in the network editor with an arrow pointing toward the target code. Symmetric relations are displayed as a line without arrows.

The following properties are user-definable: the labels, the width and color of the line linking two nodes, the formal property, and the preferred layout direction. The preferred layout direction affects the layout of a network when ATLAS.ti automatically arranges the nodes. See "Layout And Routing."

Formal Properties

Symmetric Relationship

A relation R is symmetric if it holds for all A and B related with R that A is related to B if, and only if, B is related to A.

\[ \forall a, b \in X (aRb \iff bRa) \]

Examples:
- A "are friends" B
- A "is married to" (in most legal systems) B
- A "is a fully biological sibling of" B
- a "is a homophone of" B

Transitive Relationship

If A has a relation R to B, and B has a relation R to C, then A has a relation R to B.

\[ \forall a, b, c \in X : (aRb \land bRc) \implies aRc \]

A typical transitive relation is the is-cause-of relation: if C1 is-cause-of C2 and C2 is-cause-of C3, it follows that C1 is-cause-of C3. Transitive relations enable semantic retrieval. See "Semantic Operators."

Examples:
- equality is a transitive relation: a = b, b = c, hence a = c
- "is descendant of"
- "less than" is a transitive relation: a < b, b < c, hence a < c
- mother(x,y) is not a transitive relation
- sister(x,y) is a transitive relation (if all are females)
- brother (x,y) is a transitive relation (if all are males)

Asymmetric Relations

If x has a relation R to y, but y does not have a relation R to x.

A graph is asymmetric if:
- for every edge, there is not an edge in the other direction, then the relation is asymmetric
- loops are not allowed in an asymmetric digraph
Examples:

- “is a child of”: if Martin is the child of Marilyn, then Marilyn cannot be the child of Martin.
- “is less than,” if $x < y$, then $y$ is not less than $x$

A lot of your directed relations in ATLAS.ti will probably be asymmetric as often if A leads to B, it does not automatically also lead to / result in / is part of C. Thus, it is not transitive. Transitive relations are for instance applicable if you develop a taxonomy.

In Figure 366 a conceptual network is shown, which is more like telling a story how things fit together in your data. Those stories can in most cases not be expressed based on transitive relations.

**Link vs. Relation**

It is important to understand the difference between a relation (or a link type) and the link itself: There is only one “is part of” relation, but potentially many links using it. In the Network below, the relation “is part of” is used four times and the the relation “strategy for” is used five times.

Another way to think of links and relations is to view links as instances of relations. Links are well informed about the characteristics of relations, which define their styles. If a characteristic of a relation is changed (e.g., line width, color, symbol), these changes are propagated to all links using it.
It is useful to understand the role that relations play in the construction of a theory. The concepts (codes) that are linked using relations represent aspects of the problem domain under investigation. On the other hand, the relations used to link these domain concepts are part of the methodology used to analyze the phenomena. As important epistemological tools they constitute the main questions that guide the development of a model or a theory.

If you are interested in learning more about network theory and how it is applied in ATLAS.ti, you can watch the following video: Did you ever wonder what’s behind the ATLAS.ti network function.

The Network Editor

The network editor offers an intuitive and powerful method to create and manipulate network structures. It favors a direct manipulation technique: You can literally “grab” codes, quotations, memos, or other entities using your cursor and move them around the screen as well as draw and cut links between them.

The following describes various methods available for creating and editing networks.

Network Characteristics

Networks have certain important characteristics:

- Networks can be given names under which they are stored and accessed inside the project.
- Networks can be commented.
- Networks are displayed and edited in the network editor.
- Networks allow individual layout of the nodes.
- As a node, a single entity can be a member of any number of networks, just like a code can be an element of more than one code groups.
- An entity, e.g., a specific code, can only appear once in any network.

Networks allow for a flexible but logically consistent display of links and relations, so there are a few constraints to keep in mind:

- If code A is linked to code B using the relation "is associated with," then every network that contains code A and code B will necessarily include the relation "is associated with" between the two.
- Furthermore, as only one link can exist between any two nodes at any given time, no network will display any other relation between those two nodes.

If however, you want to link code A and B in different ways, then you need to work with "dummy or modifier codes." These are empty codes, i.e., you have not used them for coding, but you need them to modify a relation.
Node Types

The following object classes can be displayed and edited as nodes within the network editor.

**Codes As Nodes**

Codes are probably the most prominent objects in ATLAS.ti networks. They provide the main ingredients for models and theories. Figure 369 shows three code nodes, a gray green colored node, and a code node without color. The gray and uncolored code are commented, therefore the node also displays the comment icon.

**Memos As Nodes**

Memos in networks are often an important supplement to code networks. Several theoretical memos can be imported into a network to map out their relationship. The visual layout provides comfortable territory for moving from memo to memo to read and contemplate each individually and the relationship(s) between them.

**Documents As Nodes**

Documents as nodes are useful for case comparisons paired with the option to "Add Node Neighbors." Further, documents as nodes make a nice graphical content table for graphical documents when selecting the preview. Depending on the file format, the document node icon is slightly different. It contains the comment icon, if a comment has been written for the document.

**Quotations As Nodes**

Quotations and codes have one thing in common that is not true for the other entities. They can link to each other (quotations to quotations and code to codes) with fully qualified "first class" links using relations. The inclusion of quotations in a network supports the construction and inspection of hyperlink structures. Like the icons for document nodes, the icons for quotation node also vary by media type:

**Groups As Nodes**

Displaying groups and their members in networks are useful to present all members that are part of the group. The links between a group and its members are depicted by a dotted red line. The line property cannot be changed.
Another application is to import code neighbors of document groups. The following network shows the result of a social network analysis with the two persons serving as bridges between the two groups:

The lines between document groups and their members are colored in blue (source: McKether, Willi L. and Friese, S. (2016). Qualitative Social Network Analysis with ATLAS.ti: Increasing power in a black community.)

Network as nodes

Networks as nodes allow the inclusion of networks in other networks. They cannot be linked to anything, but via the context menu you can open the network in a separate network editor. You can also double-click to open the network (see Figure 376). If it has a comment, the comment is displayed and from there you can click to open it. This is for instance useful if you are running out of space on your screen. Instead of trying to represent everything in one network, you can create several networks that build on each other. Via a network node in a network, you can continue to tell the story you want to tell.
View Options

The display characteristics of the nodes can be altered in a variety of ways.

To change the node or link style, select the **View** tab in a network editor, or in the contextual tab of the Network Tools.

![Network View options](image)

**Overview**: If you select this option, a schematic overview of the network is shown.

![Schematic overview of a network](image)

**Fit to Window**: This option adjusts the network to fit the size of the currently opened network editor.

**Grid**: The grid helps you to position nodes.

![Network with activated grid option](image)

**Snap**: Snapping allows an object to be easily positioned in alignment with grid lines, guide lines or another object, by causing it to automatically jump to an exact position when the user drags it to the proximity of the desired location.

**Layout**

**Routing**: See “Layout And Routing.”

**Layout**: See “Layout And Routing.”
**Link Label:** In Figure 360 the default relations are shown. See also “Relation Manager.” You can define three labels for each relation, a full name, a short name and a symbolic name. Depending on what you want to see in your network, you can switch the label that is shown. If you change to a different label, this applies to all relations in the network.

![Figure 382: Display options for nodes](image)

**Node Styles:** Nodes can be displayed in four different styles. In the View tab open the drop-down menu for Node Styles. The default style is 'flat'.

![Figure 383: Select a node style](image)

**Style**

**Comments:** If activated the comments of all nodes that have comments are displayed.

**Code-Documents Connections:** There are no direct links between documents and codes as you do not directly apply codes to a document. You apply codes to quotations that are part of a document. Nonetheless at times it is interesting to see which codes have been applied to a document or a document group. In order to see those connections, you need to activate this option. Code-Documents Connections are shown as blue lines. See Figure 384 and also Figure 375.

![Figure 384: Network with code-document connections](image)

**Preview:** The preview can be activated for all nodes where it applies if you activate the option in the ribbon. If you only want to see the preview of selected entities, right-click the entity and select the Preview option from the context menu.

---

ATLAS.ti 8 Windows - User Manual
**Frequencies:** If activated it displays the groundedness and density of code and memo nodes in the network. See “Code Manager Columns” and “Memo Manager Columns.”

**Show Node Icons:** The node type icon can be switched on and off for all nodes. The small image used as a node icon increases the distinctiveness of the nodes, especially when a mixture of node types exists in a network. Nonetheless, when space runs low, you may prefer to switch off the icons.

**Basic Network Procedures**

Two methods for creating networks are available. The first one creates an empty network and you begin to add entities as sequential steps. The other method creates a network from a selected entity and its neighbors.

**Creating A New Network**

1. In the Home tab open the drop-down menu for New Entities and select **NEW NETWORKS**, Enter a name for the network and click **CREATE**.

   Another option is to open the Network Manager with a click on the Networks button and select New Network in the ribbon of the Network Manager.

2. Enter a name for the new network. A network editor opens.

3. Import nodes with any of the methods described in the section “Adding Nodes To A Network” below.

**Adding Nodes To A Network**

You can add nodes via the Add Nodes option or via drag and drop.

**ADDING NODES USING THE SELECTION LIST**

1. Select the **NODES** tab in the ribbon and from there the **ADD NODES** button.

   This opens a selection list that is docked to the left-hand side of the network (see Figure 386). At the bottom of the selection list you see the comments of an entity. The search fields helps you to find faster what you are looking for.

2. Select the entity type and then the entities that you want to add to the network.

3. Click **Add** to complete the process.

   If you do not need to add anything further to your network, you can close the selection list.
ADDING NODES VIA DRAG & DROP
You can add nodes by dragging entities from Entity Managers, group manager, the margin, or the project explorer, or any of the browsers into the network editor.

- Open a network and position it next to the Project Explorer.
- Select the node(s) you want to import into the network and drag-and-drop them into the editor. If you want to make multiple selections, you need to open an entity browser or a manager and drag-and-drop from there.
- Drag the selected objects into the network editor, and drop them there.

Selecting Nodes And Links
Selecting nodes is an important first step for all subsequent operations targeted at individual entities within a network.

SELECTING A SINGLE NODE
- Move the mouse pointer over the node and left click.
  All previously selected nodes are deselected.

SELECTING MULTIPLE NODES

METHOD 1
- Hold down the Ctrl key on your keyboard, move the mouse pointer over the node and left click.
- Repeat for every node to be selected.

METHOD 2 (“MARQUEE SELECTION”)
This method is very efficient if the nodes to be selected fit into an imaginary rectangle.
- Move the mouse pointer above and left to one of the nodes to be selected.
Hold down the left mouse button and drag the mouse pointer down and right to cover all nodes to be selected with the selection marquee.

Release the mouse button.

**Linking Nodes**

The links between nodes in a network are real connections between the entities. Therefore, creating and removing links should not be regarded as solely “cosmetic” operations. Links make permanent changes to the project.

There are several ways to link nodes:

**Linking Via Drag & Drop**

1. Select a node. A red dot appears on the top left corner of the node. Click on the red dot with with the left mouse button and drag the mouse pointer to the node that you want to link.
2. Release the left mouse button on top of the node.
3. If you link codes to codes or quotations to quotations, a list of relation opens.
4. Select one of these relations.

The two nodes are now linked to each other. In case of a first-class link between two codes or between two quotations, the relation name is displayed above the line (rotated).

To set the display options, select **Display / Link Display** from the network editor’s menu.
WORKING WITH NETWORKS

LINKING TWO NODES USING THE RIBBON ICON
- Select a node in a network and click on the **Link** button in the ribbon (see left).
- A black line appears. Move the end on top of another node and left-click.
- If you link two codes to each other or two quotations, then a list of relations pops up. Select one of the offered relations via a left click.

You need to use the method for linking if you want to link more than two nodes at a time.

As a reminder: **Density** counts all direct links to other codes. For instance, if six source codes are linked to one target code, the target code is incremented by 6; each source code is incremented by one.

LINKING CODES OR QUOTATIONS IN THE ENTITY MANAGER
Quotations, codes and memos can also be linked in the Entity Manager via drag & drop.
- Select one or more source items in the Manager’s list pane and drag them to the target item in the same pane.
- Select a relation from the list of relations in case you link codes, or quotations.

Opening A Network On One Or More Entities
You can also open a network on an entity. It will be opened with all its directly linked neighbors.
- Select an entity in the margin area, in a manager, the project explorer or any browser, right-click and select **Open Network** (or Open in Network Editor). Another option is to select the Open Network button in the ribbon. It is available if you select an entity in a manager.

In the managers and browsers you can select multiple entities and select the **Open Network** option. If multiple entities are selected, their neighbors are not automatically included in the network. You can import their neighbors in a subsequent step.

The nodes are initially placed using the semantic layout procedure, but can be rearranged manually or using any of the other layout procedures (see "Layout And Routing"). More nodes can be added to this network using different techniques. See "Adding Nodes To A Network."

Each time a network is opened on a selected entity, a new network is created. There is no need to save it, as you can easily display it at any time following the steps above. If you rearrange the nodes and want to preserve the new layout, or if you add or remove nodes, then you need to save it explicitly. In the main Network ribbon select **Save**. Saved networks can be selected from the Project Explorer, the list or the Network Manager, the Networks Browser and the Network Manager.

SELECTING AND EDITING A LINK
Only “first class” links can be selected. First class links can only exist between quotations or between codes. Selecting links is similar to selecting nodes.
Move the mouse pointer to the line and left-click. The selected link label will be displayed boxed. All previously selected
nodes/links are deselected.

If you want to edit the link, right-click and open the context menu, or select the available options in the ribbon.

Being able to flip a link is relevant for directed links, i.e. relations with the property asymmetric or transitive. See "Formal
Properties."

**Selecting Neighbors**

Neighbors are the nodes linked directly to a node. Using this procedure repeatedly selects a complete "connected graph,"
which is a partial network where every node has a path (either a direct link or via intermediate nodes) to each other node.

- Select the initial nodes.
- In the Nodes tab, select the option **SELECT NEIGHBORS**, or press the short-cut **CTRL-N** on the keyboard.

To mark a complete connected sub-network, repeat the previous step until all nodes within the partial network are
highlighted.

**Selecting All Nodes**

- To select all nodes select the option **SELECT ALL NODES** in the ribbon, or press the short-cut **Ctrl-A** on the keyboard.

**Inverting The Current Selection**

- To invert the current selection, click the option **INVERSE SELECTION** in the ribbon. This will select all not selected nodes and
deselect all previously selected ones.

**Deselecting Nodes And Links**

To deselect a selected node or link: Click somewhere outside the node, or hold down the **Ctrl** key and click on a selected
node or link.

To deselect all nodes and links: Click on an empty space in the network editor.

**Node Actions Per Double-Click**

The table below describes the specific actions launched for the different node types.

<table>
<thead>
<tr>
<th>Node Type</th>
<th>Double-Click Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code</td>
<td>Displays the code comment (definition).</td>
</tr>
<tr>
<td>Memos</td>
<td>Displays the content of the memo.</td>
</tr>
<tr>
<td>Quotation</td>
<td>Displays the full text of the quotation.</td>
</tr>
<tr>
<td>Document</td>
<td>Displays the comment for the PD.</td>
</tr>
<tr>
<td>Group</td>
<td>Displays the description/comment for the family.</td>
</tr>
</tbody>
</table>
**Cutting Links**

Several approaches to disconnecting previously linked nodes are available. The first method is useful when many nodes linked to one other node are to be disconnected, but it also works to cut just one link.

- Select one or more nodes whose connections to another node are to be removed.
- Click the **Cut Links** button in the ribbon. Nothing happens until you move the mouse pointer over the target node. If you do the target node is boxed and the links to be cut are colored in orange.
- Click the left mouse button.

To cut a single link, right-click on the link and select the **Cut Link** option from the context menu (see Figure 390).

**Moving Nodes**

By moving nodes to different positions, you can modify an initial layout created by the automatic layout procedure. For precision placement of nodes, use the **Grid** and **Snap** option under the View tab.

Do not forget to save the network (and the project itself at the end of the session) if you want to make the new layout permanent.

**Resizing Nodes**

Nodes can be individually resized.

- Left-click a node at the bottom right corner and drag the box to make it larger or smaller.

**Clear Node Sizes**

If you have modified the node size, this option will reset the node size of selected node(s) to the default size.

**Bring To Front / Bring To Back**

You can resize a node, so that one node contains one or more other nodes. In order to see the nodes that are contain inside others, you either need to bring the larger node to the back, or the smaller ones to the front. See Figure 393.
WORKING WITH NETWORKS

Setting Code Node Colors
In addition to applying colors to codes in the Code Manager, you can also set or edit the color of code nodes in networks.

- Select one or more code nodes.
- Click on the main Network tab, open the drop down menu of the Color button and select a color.

If you click on the Color button and not on the drop down arrow, you remove any existing color.

Removing Nodes From Networks
Removing nodes from the view simply takes the nodes out of a network. The nodes remain in the project. Removed nodes can be "re-imported" at any time using the node import functions described previously.

- Select the nodes to be excluded from the view.
- Right-click and select REMOVE FROM VIEW, or press the Del key on your keyboard, or select the Remove Nodes option in the Nodes ribbon.

Merging Codes In Networks
In the section "Merging Codes " it has been described how to merge codes in the Code Manager. Below you will learn how to accomplish this using the network editor. If you are more visually oriented, you may find it more comfortable to review, sort and order your codes in the network editor.
Add all codes that you want to review and eventually merge into a network editor.

Select the code nodes that you want to merge, but not the target node. This is the node where you want all codes to be merged into.

Click on the Merge button in the ribbon of the Nodes tab. Move with your mouse over the target code node. A green colored frame will appear.

Click on the target node and all selected code nodes will be merged into it.

**Duplicate Codes**

If you duplicate a code, it will be like a clone. It will inherit all attributes like comment and color and all links. You find the Duplicate option on the Nodes ribbon.

**Creating A New Code**

When building networks, at times the need arises to insert a new code to be able to build the model you want to build, or to tell just the story that fits your data. Therefore you find an option to create a new code in both the Network and the Node ribbon.

**Copy / Paste**

You can copy and paste nodes from one network into another. If you paste a copied node into a text editor like a comment or memo, the name of the node is pasted. You find the option under Nodes ribbon.

**Creating Groups in Networks**

When you select a number of entities of the same kind you can create groups from them. If you select a number of codes, you can create a code group, If you select a number of memos, you can create a memo group, and so on. You find the grouping option on the Network and the Nodes ribbon.
Saving A Network

All links that you create are saved as soon as you save the project file. You only need to save a network, if you want to preserve the layout, i.e. the way you have arranged the nodes within the editor. If you do not save a particular view, you can always open up a network on an entity again and ATLAS.ti will arrange the entities according to the default or user-defined layout directions.

- To save a specific layout you have created, click on the button **Save** in the main Network ribbon.
- Enter a name for the network and click **Create**.

The automatic layouts are not stored when you save a network. See "Layout And Routing ."

Duplicating A Network

- If you want to continue working on a copy of a network, you can create a spin-off by clicking on the button **Create Spin-Off** in the main Network ribbon.

Accessing And Opening Existing Networks

You can access saved networks in the Project Explorer, the Networks browser in the navigator, or the Network Manager.

In the network manager you can enter a comment for each network to describe it.

Creating New Relations

User-defined relations are only available for code-code or quotation-quotation links. All other links use "hard-wired" relations (like the ones between quotations and codes).

New relations are stored together with the project in which they are used in addition to the default relations that come with ATLAS.ti (see "ATLAS.ti Default Relations").

New relations are created in the Relation Manager. You can define how a relation should look like in terms of color, width and line style. Further you can select the layout direction and the formal property. The formal property defines whether a relation is directed (transitive, asymmetric), or non-directed (symmetric).

You can access the Relation Editor via the **Links** button in the **Home** tab. Click on the drop-down arrow and select **Relations**. Another option is to select the **Relation Manager** button in the main ribbon in a network editor.

The ribbon options and column information has been described in detail in the section: "Relation Manager."

Depending on whether you want to create a new code-code relation or a new hyperlink relation, you need to select the appropriate category first. The process of how to create a new relation is the same for both.

- Click on the button **New Relation**.

You can enter three labels for the relation: the name, which will be used as standard; a short name and a symbolic name. These are only suggestions for how to make use of the three labels. You could also use the ‘short name’ field to enter the label in a different language in case you work with data in different languages. If you apply this consistently you just need to switch the link label (see "Editing Existing Relations"), and voila you have a second set of relations in a different language. It is however not required to fill in the second and third field.

- Enter a name for the relation and click **Create**.
Next select the line style (width, color, solid or dashed).

If you wish, you can specify the preferred layout direction that is used to automatically draw the picture when opening a network on an object.

The final attribute to enter is the "formal property" of the relation: transitive, symmetric, or asymmetric. See "Formal Properties" for further information.

Optionally, you can describe the newly created relation in comment field to the right.

Editing Existing Relations

You can change the properties of relations. If these relations are already in use by the currently loaded project, changes will take immediate effect and are stored along with the project when saving it.

Open the Relation Manager.

In the list of relations, select a relation that you want to modify and change any of the values. You can rename the relation, change the line color, line width or style and its property.

Layout And Routing

You can select among twelve automatic layout options. The results of the automatic layout procedure are typically quite usable and provide at a good starting point for subsequent manual refinement of nodes' placement. They can be combined with four routing options that are responsible for an optimal placement of the links.

The following layouts and routing options are available:
You can access them in the Network Editor via the main Network Tab and the View tab.

**Layout**

Orthogonal Layout: Orthogonal layouts allow the edges of the graph to run horizontally or vertically, parallel to the coordinate axes of the layout. It produces compact drawings with no overlaps, few crossings, and few bends.

Orthogonal Tree Layout: Same as the standard orthogonal layout, but larger sub trees are processed using a specialized tree layout algorithm, which is better suited for tree-like structures than the original orthogonal layout style.

Circular Layout: The circular layout places the nodes on a circle, choosing carefully the ordering of the nodes around the circle to reduce crossings and place adjacent nodes close to each other. It emphasizes group and tree structures within a network. It creates node partitions by analyzing the connectivity structure of the network, and arranges the partitions as separate circles. The circles themselves are arranged in a radial tree layout fashion. This algorithm suits social network analysis quite well.

Circular Single Cycle Layout: This is similar to the circular layout, only that sub groups are not created and all nodes are placed on a single circle. Useful for creating an overview and for shallow hierarchies.

**Organic Layout:** The organic layout style is based on the force-directed layout paradigm. When calculating a layout, the nodes are considered to be physical objects with mutually repulsive forces, like, e.g., protons or electrons. The connections between nodes also follow the physical analogy and are considered to be springs attached to the pair of nodes. These springs produce repulsive or attractive forces between their end points if they are too short or too long. The layout algorithm simulates these physical forces and rearranges the positions of the nodes in such a way that the sum of the forces emitted by the nodes and the edges reaches a (local) minimum. Resulting layouts often expose the inherent symmetric and clustered structure of a graph, they show a well-balanced distribution of nodes and have few edge crossings.

**Radial Layout:** When applying the radial layout style, the nodes of a graph are arranged on concentric circles. The layout calculation starts by conceptually reducing the graph to a tree structure whose root node is taken as the center of all circles. Each child node in this tree structure is then placed on the next outer circle within the sector of the circle that was reserved by its parent node. All edges that were initially ignored are re-established and the radii of the circles are calculated taking the sector sizes needed by each whole sub tree into account. This layout style is well suited for the visualization of directed graphs and tree-like structures.

**Hierarchical Layout:** The hierarchical layout style aims to highlight the main direction or flow within a directed graph. The nodes of a graph are placed in hierarchically arranged layers such that the (majority of) edges of the graph show the same overall orientation, for example, top-to-bottom. Additionally, the ordering of the nodes within each layer is chosen in such a way that the number of edge crossings is small.

**Hierarchical Layout (Top-Bottom):** Prefers to place nodes downwards from top to bottom along directed links.

**Hierarchical Layout (Bottom-Top):** Prefers to place nodes upwards from bottom to top along directed links.

**Hierarchical Layout (Left-Right):** Prefers to place nodes from left to right along directed links.

**Hierarchical Layout (Right-Left):** Prefers to place nodes from right to left along directed links.

**Tree Layout:** The tree layout is designed to arrange directed and non-directed trees that have a unique root node. All children are placed below their parent in relation to the main layout direction. A child-parent relation in ATLAS.ti is defined via a transitive or asymmetric link. Before applying the layout all nodes compromising a strict tree are removed and added after the tree layout by connecting them with curved edges. Tree layout algorithms are commonly used for visualizing relational data. The layout algorithm starts from the root and recursively assigns coordinates to all tree nodes. In this manner, leaf nodes will be placed first, while each parent node is placed centered above its children.

**Random Layout:** Randomly places the nodes every time this layout is invoked.

**Routing**

The positions of the nodes in the network are not altered by rerouting the edges.

**Orthogonal Routing:** This is a versatile and powerful layout algorithm for routing a diagram’s edges using vertical and horizontal line segments only. The positions of the diagram’s nodes will remain fixed. Usually, the routed edges will not cut through any nodes or overlap any other edges.

**Poly Line Edge Routing:** Polyline edge routing calculates polyline edge paths for a diagram’s edges. The positions of the nodes in the diagram are not altered by this algorithm. Edges can be routed orthogonally, i.e., each edge path consists of horizontal and vertical segments, or octilinear. Octilinear means that the slope of each segment of an edge path is a multiple of 45 degree.

**Organic Routing:** This algorithm routes edges organically to ensure that they do not overlap nodes and that they keep a specifiable minimal distance to the nodes. It is especially well suited for nonorthogonal, organic or cyclic layout styles.

**Straight Routing:** Draw the links between nodes as straight lines without any consideration of node and edge crossing.

**Please note:** that currently all non-straight edges are not retained when closing and reopening the network.

---

ATLAS.ti 8 Windows - User Manual
Analytic Functions

Add Node Neighbors

This method imports all direct neighbors of the selected nodes into the network. This option is also available from the node's context menu. Importing direct neighbors allows you to construct a connected network step-by-step. In a connected graph, there is always a direct or indirect path between any two nodes.

Select one or more nodes, right-click and select the option **Add Neighbors** and then the type of entity that you want to import.

![Figure 402: Add Neighbors dialog](image)

Below you see the list of neighbors for each entity. The option “all common” imports all neighboring nodes.

<table>
<thead>
<tr>
<th>Entity</th>
<th>Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>Documents</td>
<td>Codes, Quotations, Groups</td>
</tr>
<tr>
<td>Quotations</td>
<td>Codes, Memos, Quotations, Documents</td>
</tr>
<tr>
<td>Codes</td>
<td>Codes, Memos, Quotations, Groups</td>
</tr>
<tr>
<td>Memos</td>
<td>Codes, Memos, Quotations, Groups</td>
</tr>
<tr>
<td>Document Groups</td>
<td>Codes, group members</td>
</tr>
<tr>
<td>All other Groups</td>
<td>group members</td>
</tr>
<tr>
<td>Networks</td>
<td>Codes, Memos, Quotations, Documents, Groups</td>
</tr>
</tbody>
</table>
Comparing Cases

Adding code neighbors to documents or document groups allows to create case-based network. You can ask questions like: Which of the codes have been applied in which document or document group (and where do they not occur). ATLAS.ti automatically draws light gray lines between codes and the primary documents.

In Figure 403 you see an example. It shows the type of reasons that have been mentioned by respondents of the two document groups “education::highschool” and “education::come college”. In order to focus only on the “reasons for having children codes”, the code group “reasons for having children” was set as global filter.

Depending which neighbors you are adding, it often is useful to set a global filter as otherwise too many items might be imported. See “Applying Global Filters For Data Analysis.”

Ad Co-occurring Codes

For code nodes, there is a special import feature that exploits the spatial relations of different codings. A code co-occurs with another if it has been used to code quotations that are in close proximity: embedded, overlapping, or if two or more codes are applied to the same quotation.

The proximity of coding applied to a text can also be exploited via the Query Tool’s “co-occurrence” proximity operator. However, while the Query Tool yields quotations for explicitly specified codes, the import function brings in only the codes. See “Proximity Operators”.

To import co-occurring codes:

1. Select one or more codes in the Network Editor.
2. Select one or more code nodes, right-click and select **Add Co-occurring Codes** or select **Nodes / Add Co-occurring Codes** from the ribbon.

When importing co-occurring codes it is often useful to set a global filter first. See “Applying Global Filters For Data Analysis.”
Exporting Networks

Networks can be exported as graphic file, exported as XPS or PDF file, or printed.

To save a network as graphic file, select the Export tab in the Network Editor and the Export Bitmap option. When saving the file, you can choose among the following graphic file formats:

![Different export formats for networks](image)

To save a network in the Microsoft XPS format, select the Export XPS option. The XPS format is Microsoft's alternative to PDF.

If you want to create a PDF file, make sure a PDF writer is installed on your computer. If so, you can select the Print option and chose your PDF Writer as printer.

Creating Reports

Overview

ATLAS.ti 8 offers user configurable reports in Word, PDF or Excel format. This means you can decide what should be displayed in the report. You find an export option in each browser at the top right-hand side in the ribbon.

In addition, predefined reports are available in the Query Tool under the Report button. If you hover over an option with your mouse, the screen tip explains what each of the report contains:

![You find these four predefined reports in the query tool](image)

Tables can be exported in Excel format, or text or graphic file. Take for example a look at the Export button of the Code-Document-Table in the Analyze tab. The graphic export option converts the table to .png format.

Creating Word / PDF Reports

Open the Code Manager and select one or more codes. Click on the Report button in the Codes tab.
The first option you may want to select is how the output is sorted. The default sort order is by code. If you select multiple codes from different code groups, you can choose to group the output by code groups. Or if work in a team, you may want to view the quotations by creating or modifying user.

The next step is to select all items that you want to include in the report:

![Hyperlinks sub-tree](image)

Given the selections made in Figure 405, the output will contain the code name and all quotations with full content that are linked to the selected codes.

If you for instance select 'Hyperlinks' under 'Quotations', a further sub-tree opens and you have more options (Figure 417). If you only select Hyperlinks, the IDs and names of hyperlinked quotations are listed. If you are interested in reading the content of the hyperlinks and you want to know which codes have been applied to them, in addition you would need to select 'Content' and 'Codes' in the Hyperlinks sub tree.

![Code Report](image)

Click **CREATE REPORT** to open the report. It is a read-only report.

Click on the **SAVE** button on top of the report to save it either as Word or PDF file.
Creating Excel Reports

In every manager you find a button to create an Excel report. A frequently used report is a quotation report by codes. This is how you can generate such a report:

- Open the Quotation Manager.
- Select one or more codes in the side panel.

![Excel Export](image)

**Figure 408: Options for creating a quotation report by codes**

- Click on the **Excel Export** button and select the following options:

  The resulting Excel table looks as follows:

  ![Excel Report](table)

  **Figure 409: Excel report for quotations by code**

**Video Tutorials:**
- ATLAS.ti 8 Windows - Creating a Report of Coded Quotations
- ATLAS.ti 8 Windows - Creating an Output of Quotations Linked to a Code
Creating A Codebook

To create a Code Book, you may want to select to group the output by code groups, include the descriptions (= comment) of each code group, and the definitions for each code (= code comment):

Another option is to export to Excel:

- Click on the **EXCEL EXPORT** button and select the options: Code / Comment / Code Group.

![Figure 410: Exporting the codebook to Word](image)

![Figure 411: Codebook export to Excel](image)

![Figure 412: Codebook in Excel format](image)

- **Video Tutorial**: [ATLAS.ti 8 Windows - Creating Output of Codes with Definitions](#)
Creating A Report That Shows All Codes By Documents

- Open the Document Manager and select the Excel export option.
- Select the following options:

![Image](image_url)

Figure 413: Codes by documents report

Exporting Documents

You can export all documents that you have added to an ATLAS.ti project.

PDF and multimedia files (audio, video, images) are exported in their original format.

Text documents are exported as Word (docx) files. The formatting of the exported document may differ from the original, as all text documents are converted to html when they are imported.

To export documents:

- Open the Document Manager.
- Select all documents that you want to export.
- Select the Tools tab of the Manage Document ribbon, and from there the Document Export button.
- Select a folder in which to save the documents.

![Image](image_url)

Figure 414: Exporting documents from the Document Manager

Info Sheet for Excel Reports

All Excel reports have an addition sheet that shows meta information like the type of the report, the project name, date of export and name of exporting user.
The info sheets of more varied reports contain more detail like which relative frequencies was selected in a Code-Document Table, whether the c-coeffient was selected in the Code Co-occurence Table, an explanation of abbreviations used, or the coders of an ICA report.

Data Export For Further Statistical Analysis

ATLAS.ti is intended primarily for supporting qualitative reasoning processes. On the other hand, especially with large amounts of data, it is sometimes useful to analyze the data in a quantitative manner using statistical approaches. ATLAS.ti can export your data in form of a syntax file for SPSS®, and a generic Excel format that can be imported to packages like R, SAS, STATA as well as SPSS.

The basic components for statistics are cases and variables. The statistic export function in ATLAS.ti treats codes as variables and data segments (quotations) as “cases.”

In contrast to the dichotomous treatment of codes within ATLAS.ti, you can use codes for further statistical analysis as ordinal or otherwise scaled variables by using a specific code-naming convention.

The notion of a “case” here is rather fine-grained and differs from the common understanding of this term. Usually cases in qualitative research refer to persons, interviews, or documents. We chose to treat the smallest unit as a case for the output to SPSS or other statistical packages, to ensure that no data is lost during export. Broader information, e.g., which document or document group a quotation belongs to, is coded into the various variables (see below).

Scaled vs. Dichotomous Codes

Within ATLAS.ti, a code is always dichotomous, because it either refers to a given quotation (“1”) or it does not (“0”). Each case (= quotation) can, in respect to the codes, be described as a vector of 0’s and 1’s. The concept of scaled codes/variables requires a special syntax.

The dimension or scale along which an evaluation is to take place is partitioned into the number of different values required. Assuming that five degrees of fear are to be distinguished in a given analysis, five codes must be created:

```
evaluation %bad
evaluation %good
evaluation %not so good
```

A special naming convention is necessary to let ATLAS.ti identify variable codes from dichotomous codes.

Naming Convention For Scaled Codes

Variable name%value. As in:

```
Preference%red
Preference%blue
```
This notation allows the system to construct one variable from all codes with the same prefix. The variable name will be “Preference”, and the values for this variable are: red, blue and green. You can use string or numerical values; anything that follows the special symbol is interpreted as a value. Keep in mind that ordinal codes only have meaning in the context of the statistic program you are using. Within ATLAS.ti, the differently valued codes are treated like every other code: in a dichotomous way.

For the SPSS syntax export, you may choose an alternative character separating variable and value. If so, you can enter the special character you used in the process of creating the SPSS syntax file.

Do not assign multiple values to the same quotation. Scaled codes need to be applied in a mutually exclusive way.

Do not assign more than one scaled variable value (e.g., ‘evaluation %good’ and ‘evaluation %2bad’ to the same quotation. Although ATLAS.ti permits an arbitrary number of codes to be attached to a quotation, this would not make much sense with mutually exclusive values of scaled variables. If you do so, the SPSS generator will simply ignore additional values after processing the first one it finds for a given quotation. Since it cannot be guaranteed which value will be detected first, this will most likely produce unpredictable results.

SPSS Syntax Export

The output of the SPSS generator is a complete SPSS syntax file containing variable definitions, optionally the data matrix and some default jobs statements:

VAR LABELS are taken from code and code family names.
VALUE LABELS for variables created from codes are:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>YES (1)</td>
</tr>
<tr>
<td>0</td>
<td>NO (0)</td>
</tr>
</tbody>
</table>

Every “case” is not only described by the codes, but also by information about position (primary document, start and end position), author, media type and date of creation.

There are two variables for the start position (SY and SX) and two variables for the end position (EY and EX) for a quotation. Depending on the media type, they are used for different start and end coordinates.

<table>
<thead>
<tr>
<th>Media Type</th>
<th>SY (start)</th>
<th>SX (start)</th>
<th>EY (end)</th>
<th>EX (end)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text (rich text)</td>
<td>paragraph</td>
<td>Column character, quotation based</td>
<td>paragraph</td>
<td>Column character, quotation based</td>
</tr>
<tr>
<td>PDF</td>
<td>page</td>
<td>Character count, page based</td>
<td>page</td>
<td>Character count, page based</td>
</tr>
<tr>
<td>Audio</td>
<td>---</td>
<td>milliseconds</td>
<td>---</td>
<td>milliseconds</td>
</tr>
<tr>
<td>Video</td>
<td>---</td>
<td>milliseconds</td>
<td>---</td>
<td>milliseconds</td>
</tr>
<tr>
<td>Image</td>
<td>SX and SY indicate the position of the upper left hand corner of the image</td>
<td>EX and EY indicate the position of the lower right hand corner of the image</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>Geo</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
</tbody>
</table>

Code and primary document families are handled using COMPUTE statements.

If applicable super codes can turn into non-dichotomous variables.

The SPSS syntax output created with ATLAS.ti is plain ASCII and can be edited before storing it as a file for further processing with SPSS. Below you see an example syntax file:

```
TITLE 'Mixed Data for SPSS'.
* SPSS Syntax file generated by ATLAS.ti 8.2.0.
* SPSS Generator Version 1.0
* Date: 2018-04-12T14:48:05.
DATA LIST RECORDS=2
   /1 CASENO (F6.0) D (F6.0) QU (F6.0) AUTHOR (A16) SY (F8.0) SX (F8.0)
   EY (F8.0) EX (F8.0) TI (F10.0)
   /2 C1 to C8 1-8
.
VARIABLE LABELS D 'Document'.
```
DATA EXPORT FOR FURTHER STATISTICAL ANALYSIS

VARIABLE LABELS QU 'Q-Index'.
VARIABLE LABELS SY 'Start y-Pos'.
VARIABLE LABELS SX 'Start x-Pos'.
VARIABLE LABELS EY 'End y-Pos'.
VARIABLE LABELS EX 'End x-Pos'.
VARIABLE LABELS TI 'Creation Date'.
VARIABLE LABELS C1 'Audio'.
VARIABLE LABELS C2 'just a name'.
VARIABLE LABELS C3 'Evaluation'.
VARIABLE LABELS C4 'Buddha'.
VARIABLE LABELS C5 'Code name with more than 40 characters'.
VARIABLE LABELS C6 'Fish'.
VARIABLE LABELS C7 'Geo Code'.
VARIABLE LABELS C8 'Octopus'.

VALUE LABELS C1 to C2 1 'YES' 0 'NO'.
VALUE LABELS C3 0 'NO' 1 'bad' 2 'good' 3 'not so good'.
VALUE LABELS C4 to C8 1 'YES' 0 'NO'.

VARIABLE LEVEL C3 (ORDINAL).

* Represent code groups as computed variables.

COMPUTE CG1 = C7 + C6.
FORMATS CG1 (F1) .
VARIABLE LABELS CG1 'CG_Code family name with more than 40 characters'.

* Represent document groups as IF variables.

* Using ALL document groups.

* DG1 Document group name.
COMPUTE DG1 = 0.
IF (D = 5 or D = 4) DG1 = 1.
FORMAT DG1 (F1).
VARIABLE LABELS DG1 'DG_Document group name'.

* Document type declaration.
IF (D = 5) MediaType = 1.
IF (D = 4) MediaType = 2.
IF (D = 6) MediaType = 3.
IF (D = 3) MediaType = 4.
IF (D = 2) MediaType = 6.
STRING Media (A8).
RECODE MediaType (4="audio") (6="geo") (5="video") (2="pdf") (1="text") (3="graphic") into Media.
VARIABLE LABELS MediaType 'Media Type (Numeric)'.
VALUE LABELS MediaType 1 'text' 2 'PDF' 3 'graphic' 4 'audio' 5 'video' 6 'geo'.
VARIABLE LABELS Media 'Media Type (String)'.

BEGIN DATA.
000001000002000001          username000000000000000000000000000000003668487978
00000010
000002000004000001          username000000000000000000000000000000283668488199
01101000
000003000005000001          name with more0000000000000000000000000000000283668488282
00010000
000027000004000014          username000000010001399000000100010014123668488199
01000000
END DATA.

Treatment Of Code Groups

Code groups in SPSS jobs simply count the occurrences of assignments of any of its contained codes for the current case (=quotation) using COMPUTE statements. Below an example for computing a code family variable is provided:

COMPUTE CG1 = C10 + C11 + C12 + C13 + C14 + C15.
VARIABLE LABELS CG1 'CG_Investigation'.

Scaled codes are ignored in the computation of code groups variables.
Treatment Of Document Groups

Each case (= quotation) has its primary document index automatically generated by the SPSS export function. The value of a quotation that is part of a primary document that is a member of a primary document family will be computed as a "1" or "0." In the SPSS syntax file the PD family variable is computed as follows:

* DG1 Description of Victims.
COMPUTE DG1 = 0.
IF (D = 5 or D = 6 or D = 8 or D = 9 or D = 10) DG1 = 1.
VARIABLE LABELS DG1 'DG_Description of Victims'.

Creating SPSS Output

From the Import & Export tab select SPSS Job.

The SPSS Job Generation Window opens:

- Use separate file: When checked, the data matrix is written to a separate file. This is mandatory if the size of the matrix exceeds a certain size. SPSS cannot handle large data sets within a syntax file. For regular size projects, leave this option unchecked.

- Specify the name of the data set. This name is used as the file name and as the FILE reference from the DATA LIST section. You only need to enter a name here if you generate separate data files.

- Create a fresh data file during next run can be unchecked if the data has not changed since it was last created. This may save some processing time.

- Include quotation's author. Check if you want to export an additional variable that indicates the author for each quotation. This is for example useful if you want to use SPSS to calculate inter-coder reliability.

- The value separator is % by default, but can be changed to something else. See "Naming Convention For Scaled Codes."

- Create task section. Enable this option if you want templates for procedures included at the end of the syntax file.

- Create SAVE OUTFILE Instruction. Enable this option if you want SPSS to save the data as *.sav file after running the syntax file.

- Specify all desired properties and click Create.

You can now run the file in SPSS, or make some changes to the syntax file before you run it.

Generic Export For Further Statistical Analysis

If you are using other statistical software or do not want to run a syntax file in SPSS, you can create a generic export that can be read by other statistical packages like R, STAT, SAS as well as SPSS. The generic format needs to be imported using the Excel import option of the software you are using.

To prepare a generic export, select the Import & Export tab and from there Statistical Data.
The exported file contains the following data:

**CASENO:** each quotation is a case

**D:** document number

**Document name:** name of the document

**Media type:** type of document

**quote_start:** start position of a text quotation

**quote_end:** end position of a text quotation

**start_time:** start position of

**end_time:** end position of an audio- or video quotation

**SY / SX / EY / EX:** coordinates of an image quotation

**DG_name:** quotation occurring in a document of the document group

**code:** assigned / not assigned to the code

**CG_name:** assigned / not assigned to a code of the code group

Below you see an example how the exported data are shown in Excel:

To import the data for instance to Rstudio, select **File / Import Dataset.**
QDPX – Universal Data Exchange

The QDPX data format allows for full project exchange with other CAQDAS packages. This is a major step toward a new degree of freedom in research and opens new dimensions for all practitioners of qualitative data analysis.

“We are very excited to see that—after fifteen years of ATLAS.ti being the only manufacturer to steadfastly champion universal data exchange—other software makers are now coming around to seeing the benefit of not holding users’ data hostage any longer.

ATLAS.ti responded to the wishes of researchers early on by offering an open, application-independent export format for universal use. This long-standing commitment to academic openness and the free flow of ideas is now being recognized as an important value in itself.

I am convinced that being able to move projects seamlessly between different applications will be of great benefit to the research community. We are extremely proud to have been pioneers of this movement, and we are looking forward to the many advancements it will bring!” (Thomas Muhr, March 18th 2019).

More information on the ATLAS.ti web site

What is QDPX

ATLAS.ti is a founding member of the Rotterdam Exchange Format Initiative (REFI), the consortium that designs and governs the interoperability standard QDPX. At the heart of the matter, QDPX is an XML-based structured data format that permits not only long-term product storage and product-independent archival of qualitative research projects, but also aims at the exchange of projects between different software products.

ATLAS.ti has long championed the idea of universal exchangeability of qualitative research data between different applications and was the first manufacturer to introduce a full XML project export in their software as early as 2004. The idea of a universal data export was always a very obvious feature for us, considering the immense value that is added to data that have been processed, analyzed, and structured in the qualitative analysis process.

In the past fifteen years, we have demonstrated through many exemplary applications (many embedded in older versions of ATLAS.ti) what kinds of additional value lies in this data and in how many different and powerful ways it be used and re-purposed—from direct transformation into visually oriented presentations formats (web pages, printable reports, ebooks) to...
transformation into a huge variety of data formats (e.g., .rtf, csv, sql). And despite the wide spectrum of these sample applications, they barely scratch the surface of what further powerful uses will still be possible in the future.

The most immediate benefit of QDPX quite obviously lies in the fact that it enables users of various QDA software products to migrate their research projects between different packages. As more manufacturer join the initiative and implement the new standard, its usefulness to researchers will doubtlessly grow exponentially.

Why is QDPX Great for You?

Find below some general arguments for QDPX and descriptions of some of its practical benefits:

- Because I don’t like to be locked in a specific QDAS solution, particularly if there are problems with it; I don’t want my data to be held hostage. Interoperability nudges me through the point of sale because I’m less worried that I’ll be stuck in something I don’t like.
- Now I can move to another software for reasons beyond my control (e.g., funding, new employer, new mandates).
- The data and coding may be the same, but I want to use different types of output/representation/visualisation that are available in one program but not another.
- I’m working on my dissertation and I want to use program X but my committee members are more familiar with program Y. No problem. I’ll just transfer my data over at a few key phases so they can understand and comment on the database or the output/reports. I might even be able to convince them why I want to use program X.
- As a researcher who has become familiar with a particular CAQDAS package as a result of the product that is available to me through a site license at my institution, I need to be able to continue working with my research data in a different product if I move to an institution that has a different site license.
- Funding bodies increasingly look favorably on proposals that involve multiple research partners. This poses issues for users working in different institutions, who are familiar with or have access to different products. As a researcher I therefore need to be able to exchange my analysis between my product and those of my co-researchers. This will significantly facilitate collaborative research. For example I want to collaborate with teams in three different countries but they are all experts in a different program. In my grant proposal I want to be able to say that this is no problem and part of the reason I should be funded.
- Each QDAS package has its own particular strengths. Users often need to be able to undertake an analytic task which is not supported by their chosen product, or is enabled in a more appropriate way for their needs in another product. As a researcher being able to move to an alternative product in order to undertake a specific task would facilitate higher quality research

Find further information on the standard [here](#).

Exporting A Project In QDPX Format

Select `FILE / EXPORT` and select the QDPX option.

![Figure 421: Exporting a project in QDPX format](#)
Miscellaneous Goodies

You can copy the content of every entity, be it a document name, a group name, a code, memo or quotation name, or a node in a network and paste it into an editor or a network.

If you copy an entity name from a list into an editor, the name is pasted.

If you copy a node and paste it into an editor, the name of the node is pasted.

If you copy the name of an entity and paste it into a network, it is pasted as node. If links already exist, they will be shown immediately.

Appendix

Language Settings

In ATLAS.ti 8, explicit language settings are no longer required. It offers full Unicode support.

Unicode is a computing industry standard for the consistent encoding, representation, and handling of text expressed in most of the world’s writing systems. The latest version of Unicode contains a repertoire of 128,237 characters covering 135 modern and historic scripts, as well as multiple symbol sets.

Useful Resources

The ATLAS.ti Website

https://atlasti.com/

The ATLAS.ti website should be a regular place to visit. Here you will find important information such as video tutorials, additional documentation of various software features, workshop announcements, special service providers, and announcements of recent service packs and patches.

Quick Tour

https://quicktour.atlasti.com

To get started, we recommend to work your way through the Quick Tour. In about two hours you get an overview of the main functions and an idea on how to conduct an analysis with ATLAS.ti. When you are ready to start your own project, use the “Short Manual” (see below) as your continuing guide.

ATLAS.ti 8 - What’s New

What’s New in ATLAS.ti 8

This document is intended specifically for users who already have experience using the previous version, ATLAS.ti 6, and who are making the switch to the latest generation, in this case v. 8.

Manuals and Documents

https://manual.atlasti.com

Find the Quick Tour, How To Documents like installation instruction, information on project exchange, and team work, the sample projects, our research blog and the library on this page.
Video Tutorials

https://tutorials.atlasti.com

If you like to learn via video tutorials, we offer a range of short videos on the following topics: Features and Interface, Getting started on a project, Coding, Visualizing – Working with networks and Hyperlinks. Under the following link you find a playlist that contain video tutorials about how to work with ATLAS.ti 8 Windows including how to create a project, how to add documents, how to add codes, how to create groups, etc.: Quick Tour ATLAS.ti 8 Windows - English

Research Blog

https://blog.atlasti.com/

The ATLAS.ti Research Blog plays a very important role in the development and consolidation of the international community of users. Consultants, academics, and researchers publish short and practical articles highlighting functions and procedures with the software, and recommending strategies to successfully incorporate ATLAS.ti into a qualitative data analysis process. We invite you to submit short articles explaining interesting ways of making the best use of ATLAS.ti, as well as describing how you are using it in your own research. To do so, please contact us.

Social Media

YouTube

https://youtube.atlasti.com

You find a growing number of video tutorials on the ATLAS.ti YouTube channel. So far videos are available in English and Spanish.

Facebook

https://facebook.atlasti.com

Stay updated with the latest news on product updates, special offers, new training materials, etc. by joining us on Facebook. We are also happy to hear from users via facebook. Stop by and let us know about your projects and experience with ATLAS.ti!

Twitter

https://twitter.atlasti.com

Follow us on Twitter for the most essential bits of information and announcements (version and service pack releases, special offers, training opportunities, etc.).

Newsroom

https://newsroom.atlasti.com

The newsroom aggregates all pertinent company news conveniently on a single platform. Press releases, articles and comments from the various ATLAS.ti profiles on social networking sites are agglomerated in real time. In addition, the newsroom lets you subscribe to available content via RSS so you're always up-to-date on what's going on with ATLAS.ti.

User Conference

https://conference.atlasti.com

The biannual international ATLAS.ti User Conference is a fantastic opportunity for users to meet developers, trainers, experts, and other users from all over the world to learn from one another.

Publications

Getting Support

[https://support.atlasti.com](https://support.atlasti.com)

The easiest way to contact the Support Center is via the main menu option **HELP / MORE RESOURCES / CONTACT SUPPORT**. Or access the Support Center directly via the above URL.

Frequently Asked Questions

[https://kb.atlasti.com](https://kb.atlasti.com)

Frequently asked questions are collected in our knowledge base on our website.

To access the site directly from ATLAS.ti, select **HELP / MORE RESOURCES / VISIT FAQ** from the HU editor's main menu. An active Internet connection is required to access this web page.

Get In Touch

Under the **Tools & Support tab** you find an option to report a problem and to send suggestions. We invite you to make use of these options.

**Reporting A Problem**

The problem report goes straight to our technical team. Please use this option to report technical issues.

Be sure to include a **description of the problem** that allows our technicians to reproduce the issue, and do not forget to enter a **valid email address**.

**Sending Suggestions**

We are interested in reading about your ideas and suggestions you may have. Please feel free to use this as a wish list. While we cannot grant all wishes, knowing about what you need will help us to continuously improve the program to fit your needs.
Service Packs & Patches – Live Update

Program updates (patches and service packs) are regularly available to update your installation. The program downloads and installs these service packs automatically.

Provided you have administrative rights to your computer (note: under VISTA and Windows 7, you need to explicitly run ATLAS.ti as administrator in addition to being logged in with full administrator rights in Windows), ATLAS.ti checks for new service packs upon start up (this requires an Internet connection). If a new service pack is found, you will be informed and asked to install it.

To update ATLAS.ti manually, go to File > Options > ATLAS.ti > Check for Updates.
– Alternatively, can also update via "Windows Start" > Scientific Software > Check for ATLAS.ti 8 Updates.